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Install Profile Optimizer Speech Node:

Run the Profile Optimizer Installer wizard.

Select only Profile Optimizer Speech Node check box on Custom Settings

___page.

Enter information about the user account that will run all DM360 Network Edition

servers.

Set paths to log.

Enter the name of the physical server where the Profile Optimizer Server

___associated with this Speech Node resides.

Refer to Installing Profile Optimizer Speech Nodes on independent machine(s) or virtual

machine(s) on page 1.

Open required ports on Profile Optimizer Server and hardware fire-
walls:

Profile Optimizer Server: 8001, 905.

Speech Node: 8000

xiii





Introduction to installing Dragon
Medical 360 | Network Edition

For information about installing or upgrading to Dragon Medical 360 | Network Edition, 2.1, please

see chapter 1.

Dragon Medical 360 | Network Edition provides a central server (the Nuance Management Server) along

with multiple local or remote speech recognition client machines where healthcare providers dictate.

DM360 Network Edition takes advantage of distributed processing across servers and workstations

for greater efficiency.

The Installation Guide takes you through the process of installing the various server and client com-

ponents of DM360 Network Edition, connecting them to a database that stores your organization's

data, and installing/setting up Dragon Medical Clients that work with both the NMS Server and the

other servers and components of the network.

Before you use this manual to install Dragon Medical Client 2.1, you should determine your network

needs and be sure you have the required software by reading the Planning and Deployment Guide. That

guide takes you through the process of planning deployment of a Dragon Medical 360 | Network

Edition network, showing you how to determine the number of servers and other equipment you

will need and how to prepare that equipment for installation of Dragon Medical Enterprise.

Note:

Some product features might have changed since this manual was printed. A current version of this

book is always available on Nuance's documentation portal, in PDF format. Contact your Nuance rep-

resentative about accessing that portal to retrieve the latest copy.
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What's new in Dragon Medical 360 |
Network Edition

What's new in Dragon Medical 360 | Network Edition,
2.1
Dragon Medical 360 | Network Edition, 2.1 includes the features, enhancements, and bug fixes from

all previous service packs and hot fixes, plus new features.

For details about what's new in Dragon Medical 360 | Network Edition,2.1 for administrators, see the

following topics in the Nuance Management Server Administrator guide:

n What's new in Nuance Management Server - All products

n What's new in Nuance Management Server - DM360 Network Edition

Data objects are stored in (Nuance Management Server) NMS in the cloud (in the Nuance data center)

instead of an on-premise NMS. These objects include:

n User accounts

n Text and Graphics/auto-texts

n Custom words

n Custom command sets

To learn more about NMS in the cloud, see the 'Introducing NMS in the cloud' section in the Nuance

Management Server Administrator guide or the Dragon Medical 360 | Network Edition, 2.1 release

notes.
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Installing or Upgrading an On-Premise
Installation vs a Cloud Based
Installation

Installing an On-Premise System
Use the instructions in the Dragon Medical 360 | Network Edition Installation Guide, starting with

Preparing to install Dragon Medical 360 | Network Edition on page 5 and continuing to the end of the

guide. Skip any sections or chapters about installing or upgrading the cloud based system.

Upgrading an On-Premise System
Use the instructions in Upgrading an On-Premise Installation on page 198. Skip any sections or chapters

about installing or upgrading the cloud based system

Installing a Cloud Based System
Use the instructions in the Dragon Medical 360 | Network Edition Installation Guide, starting with

Overview of NMS in the cloud on page 237 of Dragon Medical 360 | Network Edition and continuing to

Installing and Configuring NMS in the Cloud on page 243. Skip any sections or chapters that do not men-

tion the cloud based system.

Upgrading a Cloud Based System
Use the instructions in the Dragon Medical 360 | Network Edition Installation Guide, Upgrade to

NMS in the cloud on page 248 and continuing to the end of the cloud upgrade section. Skip any sec-

tions or chapters that do not mention the cloud based system.

.
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System Requirements for Dragon
Medical 360 | Network Edition

Bluetooth (Optional): For Bluetooth wireless microphone support,

visit http://support.nuance.com/compatibility.

CPU: 2.4 GHz Intel Dual Core or equivalent AMD processor. (IMPORTANT: SSE2 instruction

set required)

DVD-ROM: drive required for installation

Free hard disk space: 5 GB

Internet Browser: Microsoft Internet Explorer 8, 9, 10, and 11 (free download at www.m-

icrosoft.com)

Microphone: Nuance-approved microphone (included in purchase)

For details on Bluetooth microphones, recorders, Tablet PCs, and other hardware, please go to

support.nuance.com/compatibility/.

n Standard Headsets

n USB microphones

n PowerMic 2 non-scanner

n PowerMic 2 scanner

n Plantronics Calisto Bluetooth microphones

n Digital recorders

n Enhanced Bluetooth (Calisto II) microphones

n Special enrollment for array microphones

n an iOS or Android device as a microphone using the Dragon Remote Microphone app

n Other Microphones listed in support.nuance.com/compatibility/

Operating system:

n Microsoft® Windows® 8.1 32 bit and 64 bit

n Microsoft® Windows® 8 (including Professional and Enterprise), 32 bit and 64 bit

n Microsoft® Windows® 7, 32-bit and 64-bit

n Microsoft® Windows Vista® Service Pack 2, 32-bit and 64-bit

n Microsoft® Windows XP® Service Pack 3, 32-bit only*

n Microsoft® Windows Server 2008, Service Pack 1, Service Pack 2, and R2, 32-bit and 64-bit

n Microsoft® Windows Server 2008 R2 64 bit Service Pack 2

n Microsoft® Windows Server 2012

n Microsoft® Windows Server 2012 R2

Processor Cache: 2 MB

RAM:

7
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n 2 GB RAM for Microsoft® Windows XP®* and Microsoft® Windows Vista®.

n 4 GB for Microsoft® Windows® 7, 32-bit and 64-bit, Microsoft® Windows® 8, 32-bit and 64-

bit, Windows Server 2008 64-bit, Windows Server 2012 64-bit, and Windows Server 2012 64-

bit R2.

Sound Card: Creative® Labs Sound Blaster® 16 or equivalent sound card supporting 16-bit

recording.

Supported non-EHR Applications:

n DragonPad

n WordPad

n NotePad

n Microsoft® Word 2007, 2010 (32 & 64 bit), 2013 (32 & 64 bit)

n Microsoft® Outlook® 2007, 2010, 2013

n Microsoft® Excel® 2007, 2010, 2013

n WordPerfect® x5, x6

n Apache OpenOffice Writer 3.4

n Open Office Writer v3.1, 3.2

n Internet Explorer 8, 9, 10

n Rich Internet Application IE9

n Mozilla® Firefox® 8+

n Rich Internet Application Firefox® 12+

n Rich Internet Application Google Chrome 16+

n Windows Live Mail v15 & v16

n Mozilla® Thunderbird™ x3 and up

n Lotus Notes 8.5

The 2.x versions of DM360 Network Edition will be the last versions of the product to support

Windows XP. DM360 Network Edition 2.1 continues to support Windows XP.

8
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Accessing the Nuance Management
Console

The Management Console (NMC)is a web-browser based application that is part of the overall

Nuance Management Server (NMS) system. The NMC supports many functions for Nuance

Healthcare applications, including reporting for iChart/DESS, and eScription.

When you install the NMS, a default user account, called the admin account, is created auto-

matically . The admin account has a license type of 'NMC Administrator'. The admin account

includes elevated access to NMS features and services, including DM360 Mobile Recorder con-

figuration.

Pre-requisites for accessing the Management
Console
On the computer that will access the Management Console, make sure the following items are

installed:

n Microsoft .NET framework 4 Client or the Microsoft .NET Framework 4 full install

n Full trust privileges

n Intranet or Trusted Web Site

n Internet Explorer version 7 or greater

n Nuance Software Certificate Installation

To allow the computer to communicate with the Nuance Management Server, open the following

ports:

n 8731

n 8051

n 80

n 443

Steps for accessing the Management Console
1. Open Internet Explorer and type in the following address in the address bar

http://nms.nuancehdp.com/NMC/Client.xbap The following screen appears: "Downloading

application information" as required files are downloaded to the local computer.

9
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2. While files are downloading, if you see the message "Trust Not Granted", you must to either

add the NMC URL as a ‘Trusted site’ or you need to install a digital certificate.

Adding the Management Console URL as a trusted
site
1. In Internet explorer, Select Tools -> Internet options -> Security Tab -> Click on Trusted

sites icon -> Sites.

2. Enter the Management Console URL

3. Click Add.

4. Uncheck the checkbox Require Server verification (https:) for all sites in this zone.

10
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5. If you see the following security warning, click Run.

6. When the file downloads are complete, you will see the login screen. Enter your User Login

and Password and click Log in.

11
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Windows Presentation Framework
controls

You can use Full Text Control in Windows Presentation Framework (WPF) edit controls in appli-

cations on the local client and in applications published from a Citrix server (and accessed through

a vSync connection).

You can also use Full Text Control in WPF edit controls when both Dragon and an application

run on the Citrix server.

Note: To enable support for WPF controls, you must first enable Windows advanced text serv-

ices. By default, Windows advanced text services is enabled on Windows Vista and Windows 7.

If you are running Dragon on Windows XP or Windows Server (see System Requirements for Dragon

Medical 360 | Network Edition on page 7 for supported versions of Windows and Windows Server),

perform both of the following actions to enable Windows advanced text services:

On Windows XP or Windows Server - In the Dragon client
1. In Dragon, select Tools > Options.

2. Click theMiscellaneous tab.

3. Uncheck Disable Windows Advanced Text Services.

4. Press OK.

On Windows XP or Windows Server - In the Control Panel
1. In the Control Panel, navigate to Regional and Language > Languages>

Details>Advanced.

2. Uncheck Turn off advanced text services.

3. Press OK.

After you enable Windows advanced text services, you must enable Full Text Control support for

WPF controls. For details about how to enable Full Text Control support for Windows Pre-

sentation Framework controls, in both local and Citrix published applications, see Configuring sup-

port for Windows Presentation Framework controls. By default, Full Text Control support for

WPF edit controls is not enabled.

12
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Configuring support for Windows
Presentation Framework controls

In Dragon Medical 360 | Network Edition, you can enable Full text Control support for Windows

Presentation Foundation (WPF) based edit controls in either local applications (running on the

same computer as Dragon) or in applications published from a Citrix server (and accessed through

vSync (minidragon)).

By default, the Dragon installer, the Patch Installer, and the vSync (minidragon) installer will

install but will not register Dragon WPF support libraries; disabling support for WPF edit controls

in local and Citrix published applications.

You can enable support for WPF edit controls in local applications, published applications, or

both. When you enable WPF support, the setting applies to all users of a Dragon installation.

On a command prompt, when you run the Dragon installer or the Patch installer on a workstation,

or run the minidragon installer on a Citrix XenApp server, pass the “TEXT_SERVICE_SUP-
PORT=1” flag.

The flag causes the installer to install and register the WPF support libraries. Full Text Control

support for WPF controls is enabled. The installer adds the line “Allow Text Service
Support=1” to the nsdefaults.ini file.

Notes:

n If you manually change the nsdefaults.ini file (on the workstation) to include “Allow Text

Service Support=0”, support for Dragon native WPF support feature is disabled.

n If you enable WPF support in local applications, but disable WPF support in published

applications, WPF support is only available in local applications.

n If you disable WPF support by installing, re-installing, or upgrading Dragon, and enable

WPF support by upgrading vSync on the server, WPF native support is disabled in both local

and published applications. In this case, to enable WPF support only in published applications,

you MUST manually change the nsdefaults.ini file (on the workstation) to include “Allow Text

Service Support=1”.

Disable support for WPF controls in local and
published applications
1. On the workstation where you will install or upgrade Dragon, open a command prompt.

2. Navigate to the location of the Dragon installer or the patch installer exe file.

3. Run the installer exe file, passing the “TEXT_SERVICE_SUPPORT=0” command flag as a
parameter. For example:

C:\Temp\DNS10ServicePack3.exe "TEXT_SERVICE_SUPPORT=0"
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Disable support for WPF controls only in an
application published from a Citrix server
Note: On the workstation, in the nsdefaults.ini file, if the : Allow Text Service Sup-
port.flag is set to 0, you cannot enable WPF support in published applications..

1. On the Citrix server, open a command prompt.

2. Navigate to the location of the mindragon installer exe file.

3. Run the installer exe file, passing the “TEXT_SERVICE_SUPPORT=0” command flag as a
parameter. For example:

C:\Temp\Minidragon.exe "TEXT_SERVICE_SUPPORT=0"

Enable support for WPF controls in local and
published applications
Note: This requires WPF support libraries to be registered on the Citrix server.

1. On the workstation where you will install or upgrade Dragon, open a command prompt.

2. Navigate to the location of the Dragon installer (for Installing/Re-installing Dragon SP3) or the

patch installer exe file (for upgrading Dragon to SP3).

3. Run the installer exe file, and either pass the “TEXT_SERVICE_SUPPORT=1” command
flag as a parameter or do not use the “TEXT_SERVICE_SUPPORT" flag.
For example: C:\Temp\DNS10ServicePack3.exe "TEXT_SERVICE_SUP-
PORT=1"
or

C:\Temp\DNS10ServicePack3.exe

Enable support for WPF controls only in an
application published from a Citrix server
1. On the workstation where you will install or upgrade Dragon, open a command prompt.

2. Navigate to the location of the Dragon installer (for Installing/Re-installing Dragon SP3) or the

patch installer exe file (for upgrading Dragon to SP3).

3. Run the installer exe file, passing the “TEXT_SERVICE_SUPPORT=0” command flag as a
parameter. For example:

C:\Temp\DNS10ServicePack3.exe "TEXT_SERVICE_SUPPORT=0"

4. On the Citrix server, open a command prompt.

5. Navigate to the location of the mindragon installer exe file.

6. Run the installer exe file and either pass the “TEXT_SERVICE_SUPPORT=1” flag as a
parameter or do not use the "TEXT_SERVICE_SUPPORT" flag. For example:
C:\Temp\Minidragon.exe "TEXT_SERVICE_SUPPORT=1"
or

C:\Temp\Minidragon.exe
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7. On the workstation, in Windows Explorer, find and open the nsdefaults.ini file. You can find

nsdefaults.ini in the following locations:

l Windows XP:

C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\

l Newer versions of Windows

C:\ProgramData\Nuance\NaturallySpeaking12\

8. In the Options section of the nsdefaults.ini file, manually set the : Allow Text Service
Support.flag to 1.
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Creating Accounts
Before you begin the installation, you create two user accounts, one for Dragon Medical 360 | Net-

work Edition services to run under (see next immediate Caution) and one to install the software (see

next section).

Caution:

Before you carry out this procedure, you must create a single Windows administrator account

to run all services under (named something like NMSapps) that meets the following require-

ments:

n Is an administrator account in the domain or, for a single server configuration, the workgroup.

n Never expires.

n Has a password that never expires (does not have to be changed at regular intervals).

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

VERY IMPORTANT:

n Has full read/write access rights to all other servers within the network.

n Has full read/write access to the database server (if it is on a separate server).

n Has full read/write/modify permissions to access the directory hosting the master user profiles.

You must set up this account with Log on as Service rights so that it can launch the services

when the installation is complete.

Creating/selecting user account to
install all services

Caution:

Before you carry out this procedure, you must create a single Windows administrator account

to install all DM360 Network Edition services. That account must meet these requirements:

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

n Has full read/write access to the database server.

VERY IMPORTANT:

You must use this account to install the database software and all servers in the product.
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Installing Dragon Medical 360 |
Network Edition

Before you begin the installation, you should evaluate your own system installation skill set. To

select the appropriate hardware and install the Dragon Medical 360 | Network Edition server and

client software, you should have adequate skills and experience to:

n Create a network domain/user account with full read/write access rights across all servers

n Create databases with SQL Server

n Set up backup plans for SQL Server

n Create and securely administer a Windows share 

n Set Windows user rights and directory permissions

n Set up and configure Internet Information Services (IIS)

n Securely administer IIS (if using web server for master user profiles)

n Order, receive, and install SSL certificates in IIS (if using secure web server for master user

profiles)

n Edit XML configuration files

n Manage Windows Services
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Assigning access to servers, clients,
and master user profile locations

Caution:

To ensure that your Dragon Medical 360 | Network Edition network components can com-

municate with each other and that the network can function properly, you must assign per-

missions to all appropriate directories and access rights to administrator and user accounts on

servers and clients as indicated in the tables that follow this note.

Locations Servers Need Access To

Location

Permissions level
or Type of user
access rights Users affected Equipment given access

Directories where server
components are installed.

Full read/write/modify
permissions

On servers:
Windows admin
account that all
server services
run under.

Server Components:
NMS Server
Nuance Management Console
NMS Database
Profile Optimizer
Profile Optimizer Database
Each Profile Optimizer Speech Node
SQL Server

Master User Profiles folder Full read/write/modify
permissions

Windows
admin accounts
that all server
services run
under & user
accounts for all
providers dic-
tating on
Dragon Medical
Clients.

Server Components:
NMS Server
Nuance Management Console
NMS Database
Profile Optimizer
Profile Optimizer Database
Each Profile Optimizer Speech Node
Client Components:
Each dictating healthcare provider

Locations Clients Need Access To

Location
or Registry Key

Permissions level
or Type of access
rights

Users
affected

Equipment
given access

Master User Profiles folder Full read/write/modify
permissions

Windows user
accounts for all providers
dictating on Dragon Med-

Client Components:
Each dictating health-
care provider
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Locations Clients Need Access To

Location
or Registry Key

Permissions level
or Type of access
rights

Users
affected

Equipment
given access

ical Clients.
Locations on all physical servers that house NMS Servers, Profile Optimizer, and Databases for both
<drive letter>: \Users\All
Users\Application Data\
Nuance folder and all sub-
folders

Full read/write/modify
permissions

Windows user
accounts for all providers
dictating on Dragon Med-
ical Clients.

Client Components:
Each dictating health-
care provider

<drive letter>:
\Program Data\
Application Data\
Nuance folder and all sub-
folders

Full read/write/modify
permissions

<drive letter>:
\Program Files\
Nuance folder and all sub-
folders

Read permissions

Locations on the client workstation where the provider dictates with Dragon Medical Client
<drive letter>:
\Program Data\
Nuance folder and all sub-
folders

Full read/write/modify
permissions

Windows user
accounts for all providers
dictating on Dragon Med-
ical Clients.

Client Components:
Each dictating health-
care provider

<drive letter>: \
<Windows User ID>\
AppData\
folder and all sub-folders

Full read/write/modify
permissions

<drive letter>: \Documents
and Settings\All Users\
Application Data\
Nuance folder and all sub-
folders

Full read/write/modify
permissions

Locations in Registry of the client workstation where the provider dictates with Dragon Medical Client
HKEY_LOCAL_
MACHINE\SOFTWARE\Nuance

Rights to update the
registry to read/write
to these keys.

Windows accounts that
workstations running
Dragon Medical Client run
under.

Client Components:
Each dictating health-
care provider

HKEY_CURRENT_
USER\SOFTWARE\Nuance
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Assigning permissions to NMS and Profile Optimizer
component files, clients, and master user profiles
Caution:  Servers:To ensure allNMS and Profile Optimizer processes can interact with one another,

you run all the software under a single administrator account. These components must have com-

plete read/write/modify access to the master user profiles directory. If the servers and Speech

Nodes cannot access the master user profiles, Dragon Medical 360 | Network Edition cannot function

properly.

 Clients: To ensure every dictating healthcare provider has appropriate access to his or her user

profile, you must give full read/write/modify permissions to all files and directories housing the

master user profiles, even to access them through an http or https connection. This level of per-

mission/access ensures that when the provider dictates, Dragon can interact with the master user

profiles effectively.

Each windows user account that logs in to the Dragon Medical Client 2.1 workstation should also

have access to the master user profiles that allows reading/writing/modifying the profiles, actions

that the Dragon Medical Client 2.1 takes frequently to keep profiles current.

 Master User Profiles: Be sure that when you set up the master user profiles directory, you

locate it either on a Windows machine or on a device connected to a Windows machine with

.NET Framework 4.0 installed on it, and that the machine is in the same Windows domain as your

DM360 Network Edition servers.

Privacy of patient data
To protect the privacy of patient data and the integrity of the master user profiles, you should not

give Windows user accounts of Dragon Medical Clients rights to log in to the master user profiles

machine; the Dragon software writes to and modifies the profiles in the background.

Ensuring appropriate ports are open
On the Dragon Medical 360 | Network Edition network, you must open particular ports to ensure the

free flow of data between the various servers and clients. A complete list of all the ports that

should be open is given in the table at the end of this section. You must open all ports listed in

the table on any hardware firewalls to ensure that no firewall blocks transmission of data and

brings the network to a halt.

Ports you must open on the network
n Ports between Dragon Medical Client 2.1 workstations and theirNMS Server

n Ports between Dragon Medical Client 2.1 workstations and the Master User Profiles Server

n Ports between workstations where you expect to run NMC Console and NMS Server

n Ports between NMS Server and its database if that database is on a separate server

n Ports between Profile Optimizer Server and its database if the database is on a separate server
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n Ports between NMS Server and Profile Optimizer Server

n Ports between Profile Optimizer and each Speech Node machine

n Ports between each Speech Node machine and the Master User Profiles Server

n Ports between each NMS Server and the Nuance Update Server

n All ports mentioned above on all hardware firewalls protecting the network

Summary: Ports to be opened on Clients, Servers, and hardware firewalls

In NMS 4.1, the NMS supports NMS server deployments on standard ports (443/80). The NMS examines the standard

ports to see if they are available. If they are not, it defaults back to the normal custom ports (8051 and 8731).

Type of port Ports to open

Hardware Firewalls All ports in this table.

NMS Server n 8731

n 8051

n 443 – if using SSL to connect to the NMS web server

n 80 - to connect with the Nuance Update Server

n 1433 - to connect to the NMS SQL database

n 808 - to connect to the Profile Optimizer Server

Profile Optimizer
Server

n 8001

n 905

Speech Node n 8000

Master User Profiles
Server

n 80 - for user profiles on an HTTP web server

n 443 - for user profiles on an SSL web server

NMS Server SQL Data-
base

n 1433 - if the NMS server and the NMS Server SQL database are

on different physical servers

Turning off Automatic Updates
After you set up each physical server or workstation you plan to use in the network, be sure to

turn off Windows Automatic Updates. You should be qualifying each update Windows sends by

installing it first on a single test machine of the network and updating other machines on the net-

work only after you determine that it clearly will not disrupt the network.

Even if you have determined an update is not going to negatively affect the network, you still

should install the update during off-hours and, if required, reboot each machine during those

hours to ensure that requests to reboot do not disrupt the servers or workstations during peak

hours of dictation.
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Anti-Virus recommendations
Nuance recommends anti-virus software on all DM360 Network Edition servers and clients to

protect the system from potential downtime due to viruses. However, be aware of the rec-

ommended restrictions.

You should exclude from the anti-virus scan any files found in the folders indicated below or with

the extensions listed below.

On NMS Servers, Profile Optimization Server, and SQL Database
Server

n Nuance folder and all sub-folders

n Files with these extensions: 

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV

Dragon Medical Client Workstations (Windows 7, XP, and Vista):

n C:\Program Files\Nuance\ folder and all sub-folders

n C:\Program Data\Nuance\ folder and all sub-folders

n C:\<Windows user_ID>\AppData\ folder and all sub-folders

n C:\Documents and Settings\All Users\Application Data\Nuance
folder and all sub-folders

n C:\Documents and Settings\Windows user_ID\Local Settings\Temp
folder

n Files with these extensions:

BD, BIN, DAT, DVC, ENH, GSB, GRM, GRX, INI, LCK, NWV, SIG, SVC, USR, VER,

VOC, WAV, XML, LOG

Recommended virtual memory
settings

Nuance recommends that you set virtual memory to particular levels on servers and workstations

in the Dragon Medical 360 | Network Edition network.

Server Virtual Memory:

Nuance recommends that the virtual memory for all servers be set to three times the physically

installed RAM.

Dragon Medical Client Workstation Virtual Memory:

Set Virtual Memory to 4092 on Windows Server 2008, or to the maximum possible setting on

workstations that have 4 GB of RAM.
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Allocating disk space for logs
The Profile Optimizer Speech Node generates two log files for each ACO and LMO task it carries out:

n Dragon log file—Dragon Medical SDK Client writes this file.

n Speech Node service log file—Profile Optimizer services write these files.

(You can view both the Dragon log files and the Speech Node service log files through the Nuance

Management Console.)

The NMS Server generates one log file for each user:

n Windows communication foundation service log files

The NMS Server stores up to the last 10 MB of logs generated, a maximum of 50 log files for the

entire server, before purging the oldest files and replacing them with newer ones as it generates

them.

The Dragon log and Speech Node service log files are generally between 3 and 5 KB each. The Pro-

file Optimizer Server stores them for 30 days. Although the log files could be larger, they are stored

in a zipped format and compress very well. If you run an optimization process for every provider

every day and have 500 providers, if every log were as large as 5 KB, all of those logs would still

use only 2.5 MB of storage space and in 30 days that would become 75 MB of storage space. After

30 days, the Profile Optimizer purges old log files, so the storage requirements do not grow sub-

stantially.

Storage space for all of these logs is relatively inconsequential; however, if you expand the number

of providers in your organization, it is always best to take into account storage requirements for all

generated files.

If you call Technical Support, you might be asked to provide any of these logs to help Nuance

engineers work on any issues with your network.

To access your Dragon log files, refer to the Nuance Management Server Administrator Guide.
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Checklists for installing the Nuance
Management Server and other servers

Installing Operating System software
On each physical server where you plan to install NMS components,

Profile Optimizer components, or either of their databases:

Install Windows Server 2008 Standard or R2 or Windows Server 2003 with SP2 or R2.

___Both 32-bit and 64-bit versions are supported.

Install all available Windows Updates and service packs.

Decide to work in Active Directory
Decide if you are going to be using NMS Server in the Active Directory Services interface.

Creating required account
Create single Windows administrator level account to run all Dragon Medical 360 | Network Edi-

tion services

___(call it something like NMSapps) and provide full access across all DM360 Network Edition

servers

___and the master user profiles directory. Use this account to run all services, including

___SQL Server services, so that all servers run under the same account. You can also use this

___account to install all software on the network, but you can also make a separate

___account that meets less stringent requirements.

Refer to Creating Accounts on page 16 and Creating/selecting user account to install all services on the same

page.

Installing database software
Install SQL Server 2008 or 2003 SP2.

If you are using Active Directory Services, be sure to selectMixed Mode authentication.

___Otherwise, Nuance recommends you select Windows authentication.

Refer to Installing SQL Server 2008 on page 48.

Refer to Setting up the Nuance Management Server to run Active Directory Services on page 226.
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Installing NMS Server, Console, and Database
Gather information you need:

Name or IP address of machine for this server: _________________________

Name or IP address of database server: _____________________ 

Name or IP address of machine to host master user profiles or URL to web

___server or SSL web server to host master user profiles: ___________________

Name or IP address Profile Optimizer Server: __________________________

Your customer ID ________________________________

Install prerequisite software:

Install .NET Framework and all available updates. See System Requirements for Dragon Medical

360 | Network Edition on page 7 for the supported versions.

Refer to Installing prerequisite software for the Nuance Management Server on page 44.

Install Internet Information Services Version 7.0 or 7.5 on Windows Server 2008

___or Version 6.0 on Windows Server 2003.

Install the PowerShell feature.

Refer to Installing prerequisite software for the Nuance Management Server on page 44.

Install the NMS Server, Database, and Console:

Run the Nuance Management Server and Console installation wizard to install the

___NMS Server and the Nuance Management Console

Enter your customer ID.

Enter server name or IP address of NMS SQL Database.

Enter SQL Server Login (sa) and password.

Enter information about the user account that will run all DM360 Network

Edition  servers.

Enter server name or IP address of Profile Optimizer Server.

Refer to Installing the Nuance Management Server and Console on page 56.

Open required ports on NMS Server and hardware firewalls:

In NMS 5.0, the NMS supports NMS server deployments on standard ports (443/80). The NMS

examines the standard ports to see if they are available. If they are not, it defaults back to the nor-

mal custom ports (8051 and 8731).

8731
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8051

443 - if using SSL to connect to the NMS web server

80 - to connect with the Nuance Update Server

1433 - to connect to the NMS SQL database

808 - to connect to the Profile Optimizer Server.

Installing Profile Optimizer Server, Speech Nodes,
and Database
Gather information you need:

Name or IP address of machine for this server: _________________________

Name or IP address of database server: ______________________

___or Database connection string for SQL server authentication:

__________________________________

Name or IP address of machine to host master user profiles or URL to web

___server or SSL web server to host master user profiles: __________________

Path to where you want Dragon logs written (if not the default):

____________________________

Path to where you want Profile Optimizer logs written (if not the default):

_____________________________

To install Profile Optimizer Server & Speech Node on same machine:
Install prerequisite software for Profile Optimizer Server:

Install .NET Framework 4.0 and 3.5 SP 1 and all available updates.

Install prerequisite software for Profile Optimizer Speech Nodes:

Install .NET Framework 4.0 and 3.5 SP 1 and all available updates.

Only on machines where Speech Nodes will run in an operating system other than Windows

Server 2008, Install Windows Installer 3.1 or later.

Windows Server 2008 R2: On all machines where Speech Nodes will run on Windows Server

2008 R2 (with or without Service Pack 1), download and apply the following patch:

http://hotfixv4.microsoft.com/Windows%207/Windows%20Server2008%20R2%20SP1/

sp2/Fix392120/7600/free/445413_intl_x64_zip.exe

Please see the following Microsoft Support articles for information about why this hot fix is nec-

essary for reliable operation of a Speech Node on Windows Server 2008 R2:

http://support.microsoft.com/kb/2687753

http://support.microsoft.com/kb/2624677
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http://support.microsoft.com/kb/2584874

On all machines where Speech Nodes will run, install Dragon Medical SDK Client .

Refer to Installing Profile Optimizer Server prerequisite software on page 71 and Installing prerequisite soft-

ware for speech nodes on page 73

Create folder for the Profile Optimizer Database Files:

On machine where database will reside, create folder for the Profile Optimizer database files.

Install the Profile Optimizer Server, Database, and Speech Node:

Run the Profile Optimizer Installer wizard.

Select both check boxes on the Custom Settings page of wizard.

Enter information about the user account that will run all DM360 Network Edi-

tion servers.

Set paths to logs.

EnterNMS Server name and database server name/authentication type.

Enter full path to database files folder.

Refer to Installing the Profile Optimizer Server and speech nodes on page 76.

To install Profile Optimizer Server without Speech Node on machine:

Nuance recommends a configuration where Speech Nodes are on their own machines or virtual

machines for most DM360 Network Edition installations.

Install prerequisite software for Profile Optimizer Server:

Install .NET Framework 4.0 and 3.5 SP 1 and all available updates.

Refer to Installing Profile Optimizer Server prerequisite software on page 71.

Create folder for the Profile Optimizer database files:

On machine where database will reside, create folder for the Profile Optimizer database files.

Install the Profile Optimizer Server and database:

Run the Profile Optimizer Installer wizard.

Select only Profile Optimizer Server check box on Custom Settings page.

Enter information about the user account that will run all DM360 Network Edi-

tion servers.

Set paths to logs.

EnterNMS Server name and database server name/authentication type.
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Enter full path to database files folder.

Refer to Installing the Profile Optimizer Server and speech nodes on page 76.

To install Profile Optimizer Speech Node alone on machine
or virtual machine:
Install prerequisite software for Profile Optimizer Speech Node:

Install .NET Framework 4.0 and 3.5 SP 1 and all available updates.

Install Windows Installer 3.1 or greater on machine.

Install Dragon Medical SDK Client on machine.

Refer to Installing prerequisite software for speech nodes on page 73
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Install Profile Optimizer Speech Node:

Run the Profile Optimizer Installer wizard.

Select only Profile Optimizer Speech Node check box on Custom Settings

___page.

Enter information about the user account that will run all DM360 Network Edi-

tion servers.

Set paths to log.

Enter the name of the physical server where the Profile Optimizer Server

___associated with this Speech Node resides.

Refer to Installing Profile Optimizer Speech Nodes on independent or virtual machines on page

86.

Open required ports on Profile Optimizer Server and hardware fire-
walls:

Profile Optimizer Server: 8001, 905.

Speech Node: 8000

Checklists for Setting up Active
Directory Services

To set up yourNMS Server to run in Active Directory Services you should take particular actions

during each step of the Dragon Medical 360 | Network Edition installation and NMS Server setup

process. The steps that require you take action are named in the headings below.

For details on each step, refer to Setting up the Nuance Management Server to run Active Directory Services

on page 226.

Installing SQL Server 2008
SelectMixed Mode authentication for accessing database.

Creating NMC Administrator Account for Active
Directory Administrator
To create anNMC Administrator user account for the Active Directory Administrator:

If you have not already done so, install the NMS Server.

Install the Nuance Certificates on any workstation where you want to log in through the

___Nuance Management Console. Refer to Installing Nuance software certificates on page 94.
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Log in through the Nuance Management Console using the login and password that Nuance pro-

vides.

Create a user account for the Active Directory administrator (see the

___Nuance Management Server Administrator Guide for details on setting up

___user accounts). You can add this account to the default NMC Administration group

___that comes with the product.

(Optional, as you can create them later) Create all other user accounts, adding some to the

___default NMC Administration group that comes with the product and others to the

___ default DM360 Network Edition group that comes with the product.

Enabling Active Directory and setting connection
string 

Configure NMS Server for Active Directory inNuance.NAS.Server.exe.config file.

Logging Out and logging back in
Log out of the NMS Server.

Stop and restart the Nuance Management Service.

Log back in through the Nuance Management Console as Active Directory administrator.

Revoke the NMC Administrator license of the original admin user account, as it

___does not work in Active Directory.

Creating Active Directory Single Sign-On user
accounts (optional)
You need to create these accounts before you can associate a user account with an already existing

upgraded master user profile.

Create Active Directory user accounts/logins.

Create Single Sign-On user accounts with same login name as their Active Directory accounts.

Continue to Configure NMS Server as Active
Directory Administrator

Follow instructions in Nuance Management Server Administrator Guide.
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Checklists for Starting the
Nuance Management and
other servers

Services should start as soon as the servers are installed. To verify that the NMS Server is running

and ensure it can talk to the Speech Nodes:

Install Nuance Certificates on each machine where you plan to run the Nuance Management Con-

sole. 

Verify that you can log in to the Nuance Management Console using the supplied login and pass-

word.

Ensure that the NMS Server can communicate with Profile Optimizer Speech Nodes.

Refer to:

Installing Nuance software certificates on page 94

Logging in to the Nuance Management Server through the Nuance Management Console on page

97

Logging in to the Nuance Management Server through the Nuance Management Console on page

97

Verifying server services are running
Check for the status of each of the following services in the Services dialog box on cor-

responding physical servers:

Nuance Management Service

Profile Optimizer Server Service

Profile Optimizer Speech Node

If any service is not running, start that service.

Refer to Starting the Nuance Management Server and Profile Optimizer Server on page 99.

If you are planning to use Active Directory Services
Proceed to Checklists for Setting up Active Directory Services on page 29.
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Checklists for Setting up a file server
for master user profiles

Select a machine to host the master user profiles.

Be sure that the machine is a Windows server or workstation with .NET Framework installed

(See System Requirements for Dragon Medical 360 | Network Edition on page 7 for the supported ver-

sion.) and that the machine is in the same Windows domain as your Dragon Medical 360 | Network

Edition servers.

If you are using a RAID array or other storage device, be sure that it is connected to a

___server or workstation running Windows with .NET installed (See System Requirements for Dragon

Medical 360 | Network Edition on page 7 for the supported version.) and

___that the machine is in the same Windows domain as your DM360 Network Edition  servers.

Create top level master user profile directory on the host.

For each site, create a subdirectory under the master user profile directory.

Share the top level master user profiles directory in Windows and

___give Everyone full read/write/modify control over the directory.

On each Dragon Medical Client 2.1 workstation:

If workstations will access the profiles over a mapped network drive,

___map a drive to the master user profiles location.

If workstations will access the profiles through a UNC path,

___ensure the workstations have access to that path.

Refer to Choosing a master user profiles location for a site on page 106 and Setting up a computer to host

master user profiles on page 108.

In the Nuance Management Console, in theMaster User Profiles Directory Settings dialog for

each site:

Set Location to path each workstation later uses to access the master user profiles.

Set NMC UNC Path to path the NMS Server later uses to find the master user profiles.

Refer to Setting up a computer to host master user profiles on page 108.
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Checklists — Setting up web server to
host master user profiles

Be sure that the web server machine is a Windows server or workstation with .NET 

___Framework installed (see System Requirements for Dragon Medical 360 | Network Edition on page 7

for the supported version) and that the machine is in the same Windows domain

___as your DM360 Network Edition servers.

Install the web server or secure web server.

Refer to Installing software for storing master user profiles on a web server on page 110.

Create top level master user profile directory on the web server.

Share the top level master user profiles directory in Windows and

___give Everyone full read/write/modify control over the directory.

On each Dragon Medical Client 2.1 workstation:

If workstations will access the profiles through an https

___connection, install the required certificate on each workstation.

If master user profiles are on an http web server, open port 80.

If master user profiles are on an https web server, open port 443.

Refer to: Choosing a master user profiles location for a site on page 106 and Setting up a computer to host

master user profiles on page 108.

In the Nuance Management Console , in theMaster User Profiles Directory Settings dialog for

each site:

Set Location to path each workstation later uses to access the master user profiles.

Set NMC UNC Path to path the NMS Server later uses to find the master user profiles.

Refer to Setting up a computer to host master user profiles on page 108.

In the Nuance Management Console, in the HTTP Settings or SSL Settings dialog for each site:

Set HTTP Settings for an http web server.

Refer to Setting HTTP connection settings for web server on page 123

Set SSL Settings for an https web server.

Refer to Setting SSL connection settings for secure web server on page 126
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Checklist for upgrading roaming user
profiles

To upgrade each directory of roaming users from Version 8.x or 9.x of Dragon Medical, be sure to

take all steps below in the order presented, starting with Before you upgrade, proceeding to Upgrad-

ing, and then to Associating user accounts with newly upgraded master user profiles. (You do not have to

upgrade roaming users from Version 10 or later of Dragon Medical.)

Be sure that all user profiles for a single site are in their own subdirectory of the

___master user profiles directory.

Schedule the upgrade process during hours when dictation is not occurring.

Before you upgrade
Back up your Version 8.x or 9.x user profiles.

Install Dragon Medical SDK Client on the machine where you are upgrading the profiles.

Create lists of the different source directories of roaming user profiles you are upgrading.

Copy profiles from a single directory to their own folder on the upgrade machine.

On the upgrade machine, create a directory for the newly upgraded profiles to be stored in.

In Nuance Management Console, create user accounts for all providers whose profiles you are

upgrading.

Be sure that providers whose profiles you are upgrading are not dictating with Dragon Medical.

Refer to Creating user accounts for healthcare providers on page 133 and

Before upgrading Dragon roaming user profiles on page 1

Upgrading
For each directory of roaming users being upgraded to master user profiles:

On the upgrade machine, start the upgrade.exe utility.

In the User Upgrade Wizard, add the existing user profiles.

Execute the upgrade and choose the directory to store the newly upgraded profiles.

(Optional) In Advanced Options dialog, modify user information, such as the vocabulary.

Start the actual upgrade process by clicking Begin and click Finish when it completes.

Copy the new master user profiles to the master user profiles host on the network.

Refer to Upgrading Dragon roaming user profiles to master user profiles on page 1.
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Associating user accounts with newly upgraded
master user profiles
Note: Be sure you have already upgraded the profiles or you will not see them in the Profiles

list.

Refer to Associating new user accounts with upgraded user profiles on page 148.

Checklists — Converting local users
Schedule the conversion process during hours when dictation is not occurring.

Before you convert
Back up your Version 10 local user profiles.

Be sure that providers whose profiles you are upgrading are not dictating with Dragon Medical.

(If applicable) Combine multiple Dragon Medical
Client 2.1 profiles for a single provider, keeping
only one

Export custom words from extra profiles.

Export custom commands from extra profiles.

Export vocabularies from extra profiles.

Import the exported custom commands into the profile you are retaining.

Import the exported vocabularies into the profile you are retaining.

Import the exported words into the profile you are retaining.

Exporting local user profiles
In Dragon Medical 360 | Network Edition, 2.1, you use the Dragon client to export and import

user profiles. For details, see the Dragon Help and the Dragon user guide.

Create temporary location for local user profiles that exist.

Create temporary location for roaming user profiles you will create as part of conversion.

In Dragon Medical Practice Edition, export local user profiles to the roaming user profiles

___location you created.

Enabling roaming feature on workstation
In Dragon Medical Practice Edition , enable the Roaming feature in Administrative settings.
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Save the local users to the roaming user location you created.

Associating user accounts with newly converted
master user profiles
Note: Be sure you have already converted the profiles or you will not see them in the Existing

Profiles list.

In Nuance Management Console, create a user account for each provider.

In Nuance Management Console, open the User Profile Association tool.

Select a user account from the list of User Accounts.

Select an upgraded profile for the user account from the list of Existing Profiles.

Click the Associate button.

Repeat the process for each user profile.

Refer to Associating new user accounts with upgraded user profiles on page 148.
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Migrating roaming users to Dragon Medical 360 |
Network Edition

In Nuance Management Console, create user accounts for all providers whose profiles you are con-

verting.

Copy the temporary roaming users you just created to a subdirectory of the master user

___profiles directory on the network.

In Nuance Management Console, associate new user accounts with the newly converted user pro-

files.

On the workstation install the Dragon Medical Client 2.1.

Log in using the new user account login and password.

Refer toMigrating Non-Network Dragon User Profiles to the Nuance Management Server on page 134.

Checklist for installing Dragon
Medical Clients

There are several approaches to installing Dragon Medical Client and this checklist includes first pre-

requisite steps, then steps for each type of installation.

Before removing earlier version of Dragon Medical
Be sure you have converted any local user profiles from an earlier version of Dragon Medical

___to roaming user profiles before you remove the already existing installation of

___Dragon Medical. For instructions on how to convert the users, refer to

___Migrating Non-Network Dragon User Profiles to the Nuance Management Server on page 134.

Before beginning any client installation to a
workstation

Be sure workstations meet the requirements for installing Dragon Medical Client 2.1.

Be sure that the account that each Dragon Medical Client 2.1 workstation runs under has full

___read/write/modify access to the master user profiles directory.

Be sure the Nuance certificates are installed on the client workstations.

Be sure you have the Dragon Medical Client 2.1 serial number on hand.
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Downloading Dragon Medical Client MSI installer
through the Nuance Management Console

On the client workstation, log in as a Windows administrator.

Log in to the Nuance Management Console.

Set the location of the Dragon MSI install file on the NMS Server in the System Settings >

DM360 Network Edition..

Download the MSI installer for the Dragon Medical Client 2.1 from the Nuance Management Con-

sole.

Log in to the client using a user account and enter the name of the NMS Server.

Refer to Associating Dragon with the Nuance Management Server or Call Forwarder on page 163.

Installing Dragon client manually
Insert the Dragon Medical Enterprise client software DVD into the DVD

reader of the workstation.

Browse the DVD and double click the setup.exe file.

Follow the wizard instructions.

Log in to the client using a user account and enter the name of the NMS Server.

Refer to Installing Dragon manually outside of the Nuance Management Console on page 160 and Asso-

ciating Dragon with the Nuance Management Server or Call Forwarder on page 163.

Pushing Dragon MSI installation to multiple
workstations: administrative installation

Copy and modify the admininstall.bat file provided on the

___Dragon Medical Enterprise client software DVD.

Use any of the options or variables in the tables provided:

General options for installing Dragon

MSI options for installing Dragon features/advanced options

Pushing Dragon MSI installation to multiple
workstations: using SCCM

Create MSI installer to use with SCCM to install Dragon Medical Client 2.1 on several

___workstations.

Refer to Pushing the Dragon MSI installation to workstationsfor more information.
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Pushing Dragon MSI installation to multiple
workstations: creating custom installer for Active
Directory

Create the custom installer for Dragon Medical Client 2.1 following the instructions provided.

Refer to Creating a custom installer for the client in Active Directory on page 174

Installing multiple clients with same default
options using MSI

Install Dragon Medical SDK Client on a client workstation where you will set the options.

Open a command window and run: natspeak /SetDefaultOptions

Set the Dragon Medical Client 2.1 options under the tabs in the Options dialog box.

Retrieve the nsdefaults.ini file from the workstation where you set the options and

___copy it to a location accessible to all workstations you are installing.

Create an MSI command line where you pass the nsdefaults.nin file as the value of

___the DEFAULTSINI option.

Be sure to include the NAS_ADDRESS option in your MSI command line.

Note: If the user already entered a value for this option, your value will overwrite that.

Refer toMSI Installation of multiple clients with the same default options on page 181
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and components

To install the NMS Server and its components for the Dragon Medical 360 | Network Edition net-

work, you carry out the procedures in these sections:

Prerequisites for installing the Nuance Management Server and Console 42

Installing prerequisite software for the Nuance Management Server 44

Installing SQL Server 2008 48

Ensuring all required ports are open 55

Installing the Nuance Management Server and Console 56

Anti-virus recommendations and requirements 63

Configuring the network traffic switch to ping NMS Servers for load balancing 65

Verifying all necessary ports are open 66
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Prerequisites for installing the
Nuance Management Server and
Console

Before you actually install the Nuance Management Server and Console, you should gather the infor-

mation indicated below and make modification to your machine's security policy.

Creating an account to run all services
Note:

Before you carry out this procedure, be sure you have a Windows administrator account for run-

ning the server under, the same one you are running the Profile Optimizer Server under (named some-

thing like NMSapps) that meets the following requirements:

n Is an administrator account in the domain or, for a single server configuration, in the

workgroup.

n Never expires.

n Has a password that never expires (does not have to be changed at regular intervals).

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

n Has full read/write access rights to all servers within the same network.

n Has full read/write access to the database server (if it is on a separate server).

n Has full read/write/modify permissions to access the directory housing the master user profiles.

During the installation, the wizard prompts you to enter the name of this user account and the

password to it.

Important: You should run all of the services of the product using this same account.

If you are creating the account for someone else to log in and install the software, the account

only need to be able to run NMS services and does not require Log into workstation rights.
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Information requirements for installing the NMS
server and console
Before you begin, you need to have the following information:

Name or IP Address of NMS Server Machine—You need the name or address of the machine

where you intend to install the Nuance Administration Server (NMS). If your network uses dynamic

addresses, you should use the computer name to identify it, just in case the dynamic address

changes in the future.

To retrieve the name of the machine:

1. Click Start and move the cursor to highlight (but do not click) theMy Computer option; right

click onMy Computer and select Properties at the bottom of the drop-down menu. Or find

theMy Computer icon on your desktop, right click on it, and select Properties.

2. Click the Computer Name tab and look for the name to the right of Full computer name:.

The full computer name must include the Domain name (just below the computer name).

To retrieve the address of the machine:

1. Click Start and select Run...

2. When the Run window opens, type cmd in the Open text box and click OK.

3. When the Windows\system32\cmd.exe window opens, type ipconfig on the command line.

Among the information you should see in the window is the IP Address, made up of four

numbers with periods between them, such as 10.10.10.10. Copy down that number and keep it

for later.

Name or Address of Database Machine—You need the name or address for the server

machine where you either have installed or plan to install the NMS SQL Database. If your network

uses dynamic addresses, you should use the computer name to identify it, just in case the dynamic

address changes in the future.

To retrieve the name of the machine:

1. Click Start and move the cursor to highlight (but do not click) theMy Computer option; right

click onMy Computer and select Properties at the bottom of the drop-down menu. Or find

theMy Computer icon on your desktop, right click on it, and select Properties.

2. Click the Computer Name tab and look for the name to the right of Full computer name:.

The full computer name must include the Domain name (just below the computer name).

To retrieve the address of the machine:

1. Click Start and select Run...

2. When the Run window opens, type cmd in the Open text box and click OK.

3. When the Windows\system32\cmd.exe window opens, type ipconfig on the command line.

Among the information you should see in the window is the IP Address, made up of four

numbers with periods between them, such as 10.10.10.10. Copy down that number and keep it

for later.
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Installing prerequisite software
for the Nuance Management Server

Before you install the Nuance Management Server (NMS), you must install Windows Server and other

prerequisite software delineated below on the same machine:

n Windows Server.

n Any Windows service packs and updates available.

n Other prerequisite software:

l .NET Framework 4.0 and 3.5 SP1. This software is readily available on the web at the link

provided.

l Internet Information Services (IIS). Version 6.0, 7.0, or 7.5.

l PowerShell feature.

Although you do not have to install it on the same machine as the NMS Server, you should also

install the SQL Server 2008 database software before you install the NMS Server. For details, refer

to Installing SQL Server 2008 on page 48.

Installing Windows Server and .NET Framework
Follow these steps:

1. If you have not already done so, install one of these versions of Windows Server: 2003 SP2,

2003 R2, 2008, or 2008 R2 (if it is not already installed on the server machine). 

2. After you install the server software, you should download any Windows updates to be sure you

have all updates available. Then, once you have all updates available, turn off automatic updates.

3. Install .Microsoft .NET Framework 4.0 Client or full version. If you do not have this version of

.NET Framework already installed, visit the link provided and download/install it from there.

Allow approximately

1 hour to install it.http://ww-

w.microsoft.com/downloads/en/confirmation.aspx?FamilyID=9cfb2d51-5ff4-4491-b0e5-

b386f32c0992&displaylang=en

4. Install .NET Framework 4.0 Extended. You must be sure you have the Extended version of

Microsoft .NET Framework 4.0 installed (.NET Framework 4.0 Client Profile version is not

supported). If you do not have this version of .NET Framework already installed, visit the link

below and download/install dotNetFx40_Full_setup.exe from there:

http://www.microsoft.com/downloads/en/confirmation.aspx?FamilyID=9cfb2d51-5ff4-

4491-b0e5-b386f32c0992&displaylang=en

5. Once you have saved the dotNetFx40_Full_setup.exe file, double click on the file to initiate

the .NET Framework installation.

6. When the .NET Framework installation is complete, you should also retrieve any updates avail-

able for the program.
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Installing Internet Information Services (IIS) 
in Windows Server 2008
Note:

Instructions for installing Microsoft products are not guaranteed to be stable. For the latest infor-

mation, consult Microsoft.

To install IIS and any automatic updates in Windows Server 2008:

1. Go to your server desktop and click Start > Programs > Administrative Tools , then click

on Server Manager.

2. To see if it is installed, under Server Manager, expand Roles and look for IIS in the list. If

you do not see IIS, you need to install it.
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3. Click on Add Roles and when the Add Roles Wizard opens, click Next.

4. Check the Web Server (IIS) check box in the Roles list.

5. When the Add features required for Web Server (IIS), click the Add Required Features

button.

6. When the installation wizard displays again, click Next to proceed to the Web Server (IIS)

page of the wizard.
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7. Click Next to proceed to the Select Role Services page of the wizard and accept the services

selected by default (shown in the next illustration).

7. Click Next to proceed to the Confirm Installation Selections page and verify your selections

under Web Server (IIS).

8. Click Install. The Installation Progress page displays during installation.

9. When the Installation Results page appears, it should say Installation succeeded.

10. Click Close to exit the wizard.

11. Return to the Server Manager and click Roles in the Server Manager explorer. Under Role

Services verify that the list of IIS features that you installed is complete.

Installing PowerShell in Windows Server 2008
Before installing SQL Server 2008 on Windows Server 2008, install the PowerShell feature:

1. Click Start > Administrative Tools > Server Manager and then expand Features.

2. If you do not see PowerShell in the list of installed features, click Add Features.

3. When the Select Features page of the Add Features Wizard appears, check the Windows

PowerShell feature in the list and click Next.

47



Dragon Medical 360 | Network Edition Installation Guide

4. Click the Install button and wait for the installation to complete. You might need to restart the

server after installing PowerShell.

5. Click the Close button to close the wizard.

When you have finished installing this required software, you are ready to install first SQL Server

(if it is not already installed), then the NMS Server. 

Installing SQL Server 2008
Before you install the Nuance Management Server (NMS) or the Profile Optimizer Server, even if you do

not plan to install the database on the same machine as either server, you must install the database

server first. You usually install both NMS and Profile Optimizer databases on the same machine, as

shown in the Planning and Deployment Guide.

For Dragon Medical 360 | Network Edition, you must install SQL Server 2008 on a Windows Server

2008 system where you have installed the PowerShell feature in IIS.

Before you begin database software installation
Before you begin installing the database software, have the following information on hand:

n Machine name or IP address of the database's physical server.

n Windows user account name and password you want the database server to run under.

Caution:

Nuance recommends that you run all server DM360 Network Edition services and even all data-

base services under the same Windows user account.

Installing SQL Server
To install SQL Server 2008 from the Nuance Management Server MS SQL 2008 DVD provided in

the DM360 Network Edition software package you received from Nuance:

1. Log on to Windows as an Administrator or as a domain user who has local administrative rights.

If you do not have that type of Windows account, create one first.

2. Using Windows Explorer, find and note which of the non-operating system hard drives has the

most unused space on it.

3. Insert the Nuance Management Server MS SQL 2008 DVD into the slot on your physical server.

4. If the install installation does not start automatically, find the setup.exe file on the DVD and

double click on it to start the installation.

5. When the SQL Server Installation Center dialog box appears, select New SQL Server

stand-alone installation or add features to an existing installation option.
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6. When the Setup Support Rules dialog box displays, click Install.

7. When the Product Key page is displayed, the SQL product key is automatically entered as it is

embedded within the Nuance-provided SQL software DVD. The product key will not have to

be entered manually. Click Next.

8. When the License Terms page of the wizard appears, check the box next to I accept the

license terms and click Next.

9. If you are asked to create a local user with Administrative privileges and you do not have such

an account, create one now and click Next to continue.

10. In the Feature Selection page, under Instance Features, you only need to select Database

Engine Services. Under Shared Features >Management Tools, only Basic and Com-

plete are required. All other features are optional. Click Next to continue.

Note: Analysis Services and Reporting Services are not required by eitherNMS Server or Pro-

file Optimizer Server; however, if any problems occur with your installation or later with your data-

bases, these services can help Nuance technical support troubleshoot the problem, so you

might choose to install them as a proactive measure.
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12. When the Instance Configuration page of the wizard displays, leave the Default instance

option selected and click Next.

13. When the Disk Space Requirements page of the wizard displays, verify that you have

adequate storage space on the server and click Next.

14. When the Server Configuration page of the wizard displays, click the Use the same account

for all SQL Server services button.
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15. When the Use the same account for all SQL Server 2008 services popup appears, enter the

username and password of the Windows user account that the SQL Server services should all

run under and click OK. You should use the same account that the product services will run

under. That account can be in a workgroup instead of a domain and Nuance recommends that

you use an account in a workgroup if you are planning to install all DM360 Network Edition

servers along with the database on a single machine.

Enter the name of the domain where the server resides followed by a backslash and then the

user name for the account. Enter the password other servers and clients on the Dragon Medical

360 | Network Edition network will use to access the database.
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16. When you return to the wizard, click Next.

17. When the Database Engine Configuration page of the wizard appears, you choose the type

of authentication you want to use when allowing access to the SQL Server database.

l Under Authentication Mode, Nuance recommends that you select Windows Authen-

tication Mode (see illustration above). You would selectMixed Mode only if you plan to

later attach to the database using an Active Directory account or an SQL Server account.

Keep in mind that SQL Server accounts have full access to the database.

l If you selectMixed Mode, then under Built-in SQL Server system administrator

account, enter the password in Enter password and type the password a second time in

Confirm password.
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l Regardless of the type of authentication you choose, under Specify SQL Server admin-

istrators, click Add... and add the account you are installing under to make that account an

SQL Server administrator will full access to the database, as you will need that access later

in the installation process.

18. Still on the Database Services Configuration page of the wizard, to add the user account for

the person is carrying out the installation to the list of users who can administer the database,

click Add Current User... The user's name then appears in the list under Specify SQL Server

administrators.

19. Click Add and add the account you created for all services to run under, to ensure it not only

has access to the database, but can also administer the database.

20. Finally, click Add again and add at least one other user to the list to ensure that if either of the

first two accounts is accidentally locked out of the database, you have one more account with

the ability to administer the database.

When you have added all these users to the database administrator list, click Next.

21. When the Analysis Services Configuration page of the wizard displays, under the Account

Provisioning tab, click the Add Current User button to add the installer's user account to the

list of users who can have access to the Analysis Services.

22. Click the Add button and add the NMSapps user account to give that account access to the

Analysis Services.

23. Click the Add button again and add the database administrator account to give that account

access to the Analysis Services; then click Next.

24. When the Reporting Services Configuration page appears, select Install the native mode

default configuration and click Next.
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25. Skip the Error and Usage Reporting page and click Next

26. Click Next until you reach the Ready to Install page of the wizard.

27. Click Install and wait for the installation to complete. If you have not installed PowerShell and

receive an error about PowerShell, click OK to continue.

28. If you experienced any failures while running the wizard, the Complete with failures page

appears.
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If you receive this page, click on the link near the top of the page under Summary log file has

been saved to the following location and save the log in a location where you can retrieve it.

If you later have any network issues, you can provide this log file to the Nuance support team.

29. After the installation is complete, to verify that all SQL Server database services are running

before you begin to install the DM360 Network Edition servers, select Start > Administrative

Tools > Services and check the Services window.

Ensuring all required ports are open
Be sure that port 1433 is open on the database server that houses the NMS SQL Database.
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Installing the Nuance Management
Server and Console

This procedure covers installing all components of the Nuance Management Server (NMS), including

the server, the console, and the database.

Creating an account to run all services
Note:

Before you carry out this procedure, be sure you have created a Windows administrator account to

run this server and all other servers under (name it something like NMSapps). That server should

meet the following requirements:

n Is in the organization's domain.

n Never expires.

n Has a password that never expires (does not have to be changed at regular intervals).

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

n Has full read/write access rights to the Profile Optimizer Server and all Profile Optimizer Speech

Nodes server(s) within the same network.

n Has full read/write/modify permissions to access the directory housing the master user profiles.

During the installation, the wizard prompts you to enter the name and password of this user

account.

Be sure you have the organization identifier Nuance assigned you, delivered to you via email, in a

readily accessible file on a stick or on the Windows Server itself.

Also be sure you have the name or IP address of the machine where the Profile Optimizer is either

installed or to be later installed, because you supply that information to the NMS Server during the

installation so that it later knows how to communicate with the Profile Optimizer.
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Installing the NMS—Server, Console, and Database
You are now ready to install all of the components of Nuance Management Console. You install them

on the same machine using a single installation wizard. (After the installation is complete, you

then use the console to configure the server.)

Caution:

If you do not want to store the NMS Server's data files in SQL Server's default location, you can

let the installer create the database, its transaction log, and its dump device in the default location,

then move the database and its files to the location you would prefer.

FOR ADVANCED INSTALLERS ONLY:

If you are installing the database in any location other than the SQL default, you can create the

NuanceMC.mdf database, the NuanceMC_log.LDF transaction log, and the Nuan-

ceMCDump.bak dump device in SQL Server before installing the NMS Server; otherwise, the

NMS Server installation ends up placing these files in the SQL default location.

1. Install .Microsoft .NET Framework 4.0 client or full version.

2. The Nuance Management Console software is code signed by Nuance to allow Nuance Support

access to the client computer's resources. However, to ensure Nuance has access, if your hos-

pital or medical facility's network requires a security policy on the computer where you install

the client, you should set up that security policy to allow any code signed by Nuance to run on

the machine with full trust credentials.

3. Before you begin the installation, you might want to turn off the Windows Server Firewall. If

you prefer not to turn it off, you later need to open Port 8731 (the step is included at the end

of this process) to ensure communication between the NMS Server and Nuance Management Con-

sole.

This step applies whether you are installing the NMS Server on the same machine as the SQL

Server or on a separate/possibly remote machine. If you are planning to store data files in the

default location that SQL uses, skip to step 4. If you instead plan to store data files in another

location, you can move the database and its associated files after you let the installer create

them for you.

(Alternatively, you can create the NuanceMC.mdf database, the NuanceMC_log.LDF

transaction log, and the NuanceMCDump.bak device inside SQL Server first and specify

where you want these files to reside, but Nuance recommends that you be an advanced user to

create your own database.)

4. Insert the Nuance Management Server Software and Documentation DVD in the DVD reader of your

server. Browse the DVD until you find the Nuance Management Server and Console

Installation.exe file and double click it to launch the installation process.

5. Initially, you wait for a moment while the InstallShield wizard uncompresses the software; then

the  Nuance Management Server & Console Installation wizard displays to walk you

through the installation process.
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6. Click Next to see the License Agreement page and accept the terms of the license agreement;

then click Next to proceed to the Customer Information page of the wizard.

7. In the Customer Information page of the wizard, enter your name (or the name of an appro-

priate contact person) and your organization name in the User Name and Company Name

text boxes and click Next to proceed to the Choose Destination Location dialog box.
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8. The Choose Destination Location page of the wizard presents the location where it installs

the NMS Server by default. If you want to change where the wizard installs the server,

click Browse... and browse to a location you prefer.

9. Click Next to proceed to the Database Server page.

10. In the Database server that you are installing to text box, enter the machine name or

IP address of the physical server where you have installed the SQL Database Server software.

The wizard automatically creates the database and its backup directory in default locations on

that server.
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Under Connect using, you see from two ways for the server to access the database—using a

Windows login and password to authorize access, as indicated by Windows authentication or

an SQL Server login and password, as indicated by SQL Server authentication.

You should choose the same type of authentication for access to the database that you chose

when you installed the SQL Server.

Nuance recommendsWindows authentication. If you choose this type of authentication, the

Login ID and Password text boxes become unavailable, as they are not required.

If you choose SQL Server authentication using the Login ID and password below, you

then enter the database system administrator login name and password that you set up in SQL

Server earlier into the Login ID and Password text boxes provided.

Click Next to continue.
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11. In the Organization ID page of the wizard, enter the unique ID that Nuance has assigned you.

You should receive this ID on a slip of paper inserted with your Dragon Medical 360 | Network

Edition software package. Carefully enter the ID into the ID text box here. You do not have to

write it down or keep track of it on paper after you enter it here, as you will later be able to find

the ID any time you need it through the Nuance Management Console. Click Next to continue.
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12. In the Service logon page, the wizard asks you for the user account that the NMS Server service

is going to run under. You should enter the Windows user name and password of the account

you created at the start of this procedure for all services to run under (such as NMSapps).

If the wizard determines that the user account you enter is not an administrator account or does

not have rights to start the NMS Service or is inadequate in any other way, the wizard fails to let

you proceed and stays on this page until you enter an acceptable account or click Cancel. If

this situation arises, you should enter the local administrator or local system account and pass-

word in this page. If you need to enter such an alternative account here, you later need to

change the account that the service is running under as described in Changing the account running

NMS Server under Changing the account running NMS Server on page 99.

13. Click Next to continue.

14. In the Profile Optimizer Server page of the wizard, you enter the machine name or IP address

of the physical server where the Profile Optimizer Server is (or will be) installed. The NMS Server

needs to know this information to communicate with and pass data between itself and the

Profile Optimizer. Often you are installing the Profile Optimizer Server on the same machine as

the DM360 Network Edition server databases, as shown above. Click Next to continue.

15. In the Ready to Install the Program page of the wizard, you can click Back to return to any

of the previous dialogs or, if you are ready, click the Install button to launch the actual instal-

lation.

16. When the installation is complete, click Finish to close the wizard.
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17. If you installed the NMS Server and Nuance Management Console with the Windows Server 2008

Firewall turned on during the installation, you must now open Port 8731 so that the Nuance Man-

agement Console can communicate with the NMS Server.

18. As part of the process of installing the NMS Server, the installer:

n Creates the actual NMS SQL Database, a transaction log file, and a dump device on the

SQL Server that you installed earlier. When you look in SQL Server, you see:

l Database, namedNuanceMC.mdf

l Transaction log namedNuanceMC_log.LDF

l Dump device namedNuanceMCDump.bak.

n Installs the service that the NMS Server uses, the Nuance Management Service.

After the installation completes, the NMS Server automatically starts.

You are now ready to install the Profile Optimizer Server.

Anti-virus recommendations and
requirements

Nuance recommends anti-virus software on all Dragon Medical 360 | Network Editionservers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

After you have installed the servers, be sure to exclude from the anti-virus scan any files found in

the folders indicated below or with the extensions listed below.

63



Dragon Medical 360 | Network Edition Installation Guide

On NMS Servers, Profile Optimizer Server, SQL Database Server:

n Nuance folder and all sub-folders

n Files with these extensions: 

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV
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Configuring the network traffic switch
to ping NMS Servers for load
balancing

If you have a large network with multiple NMS Servers, you can include a network traffic switch in

your network to balance the load on the NMS Servers. The network traffic switch can be an F5 or

similar switch.

To configure the network traffic switch to send a message to the NMS Server to see if the server is

operational, you would have the network traffic switch send the following message in the

URL line of the browser:

http://<NMS-Server-Name>:8051/Nuance.NMS.Services/
__NMSServiceStatus/Rest/Status

The NMS Server delivers the following XML-formatted response to the network traffic switch:

<ServiceStatusResponse xmlns=
"http://schemas.datacontract.org/2004/07/Nuance.NAS.Connector.
DictationTranscription" xmlns:i="http://www.w3.org/2001/
XMLSchema-instance">
__<Status>Running</Status>
__<ServerDateTimeUTC>2010-12-13T20:50:13.0969590Z
____</ServerDateTimeUTC>
__<InterfaceType>basicHttpTransport</InterfaceType>
</ServiceStatusResponse>

If the NMS Server is down, the switch receives an error. If the network traffic switch makes this

call and the NMS Server sends anything other than the expected response, the switch can tag that

server as down and reroute the traffic accordingly.

Ensuring clients can contact an NMS Server with
a load balancing traffic switch in the network
When you install clients using a push installation, if you have a load balancing traffic switch man-

aging multiple NMS Servers on your network, you should set NAS_ADDRESS to the address of

the traffic switch, rather than the address of any particularNMS Server.

Note: If the user already entered a value for this option, your value will overwrite that.

When providers first log in to Dragon Medical Client 2.1, when they click the Advanced button,

instead of entering the IP address or name of an NMS Server, they should enter the IP address or

name of the traffic switch appliance in the Address text box of the Server Location dialog

box.

If your workstations have desktop shortcuts for Dragon Medical Client, those shortcuts should also

point to the traffic switch's address, rather than the address of any particularNMS Server.
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Accessing Nuance Management Console when load
balancing traffic switch chooses among multiple
NMS Servers on your network
When you have multiple NMS Servers and a load balancing traffic switch in your network, you

should be sure that when you open the Nuance Management Console, you substitute the name or

address of the switch for the name or address of the NMS Server. For instance, for a load balancing

switch namedNMS_Switch at IP address 10.1.1.2, here are two possible URLs you would use to

run the console:

http://NMS_Switch/nmc/client.xbap

or

http://10.1.1.2/nmc/client.xbap

Verifying all necessary ports are open
In NMS 5.0, the NMS supports NMS server deployments on standard ports (443/80). The NMS

examines the standard ports to see if they are available. If they are not, it defaults back to the nor-

mal custom ports (8051 and 8731).

Be sure that all of the following ports are open on the NMS Server:

n 8731

n 8051

n 443 if using SSL to connect to the NMS web server

n 1433 on both the NMS Server and the database server where the NMS SQL Database resides

n 808 for communication with the Profile Optimizer

Test access to NMS ports from a site client machine
In NMS 3.1 and newer, you can test the ability of a client machine to communicate with the NMS

(cloud or on-premise).

You access a web page where you can test access to all ports required for connecting to the NMS,

including:

n Port 8051 (http): To query the deployment type for the Nuance Management Console, Dragon

Medical 360 | Network Edition, the Profile Optimizer, Dragon Medical 360 | Mobile Medical

Recorder, and Dragon Medical 360 Recorder.

n Port 8731 (http/s): To determine SOAP access to web services for Nuance Management

Console and Dragon Medical 360 | Network Edition.

n Port 8010 (http/s): ? To determine Representational State Transfer (REST) access to web

services for PowerScribe 360 | Mobile, 360 | SpeechAnywhere Services, Dragon Medical 360

| Mobile Medical Recorder, and Dragon Medical 360 Recorder.
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Steps for determining access to NMS ports

The web page tests the connection between a client machine and a server (the one in the URL

when they access the web page).

If access to a port is available, the Accessibility column contains "Yes". Otherwise, the column

contains"No" and may contain other information useful for troubleshooting.

n If the NMS is installed on-premise, the server URL is

http://<yourlocalservername>/nmc/portscan.html.

n If the NMS is in the cloud, the server URL is http://nms.nuancehdp.com/nmc/portscan.html.

1. Open a supported web browser and navigate to http://nms-dev.n-

uancehce.com/nmc/portscan.html.

2. Select the check box beside the product(s) to test:

l Nuance Management Console: Tests access to port 8051 and port 8731.

l Dragon Medical 360 | Network Edition: Tests access to port 8010.

l Dragon Medical 360 | Recorders: Tests access to port 8051 and port 8010.

l Dragon Medical 360 | Direct:
l Tests access to port 8010.

l If the NMS Server URL used to access the web page contains “nms.n-

uancehdp.com”, this indicates that we are accessing the production instance

of the NMS. The web page tests the response of the following URL:

https://nsa.nuancehdp.com/SpeechAnywhereServices/IsAlive

l If the NMS Server URL used to access the page contains “nuancehce.com”,

this indicates that we are accessing a QA/HCE instance of the NMS. The

web page tests the response of the following URL: https://nsa-qa.n-

uancehce.com/SpeechAnywhereServices/IsAlive

l If the NMS server URL used to access the page does not contain “nms.n-

uancehdp.com” or “nuancehce.com”, the installation process displays an edit

box where you can enter the full Dragon Medical 360 | Direct URL for the

web page to test.

3. Press Test. The web page displays the test results for each of the products you selected. If a

port cannot be accessed, the web page displays the host, port number, and the related protocol.

The web page also displays details about the error to help you troubleshoot the issue.
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Chapter 3: Installing Profile
Optimizer components

To install the Profile Optimizer components of the Dragon Medical 360 | Network Edition net-

work, you carry out the procedures in these sections:

Prerequisites for Installing Profile Optimizer components 70

Installing Profile Optimizer Server prerequisite software 71

Installing prerequisite software for speech nodes 73

Installing the Profile Optimizer Server and speech nodes 76

Revising or Repairing the Profile Optimizer Installation 85

Installing Profile Optimizer Speech Nodes on independent or virtual machines 86

Anti-virus recommendations and requirements 91

Open ports on the Profile Optimizer Server 91
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Prerequisites for Installing Profile
Optimizer components

Before you actually install the Profile Optimizer, you should gather the information and install some

additional prerequisite software, as indicated in this section. This section details the information

you need about configuration settings you will set during the installation process.

Creating account to run all services
Note:

Before you carry out this procedure, be sure you have a Windows administrator account to run all

servers under. It should be the same one you are running the NMS Server under (named something

like NMSapps). For details about the requirements for this account, refer to Prerequisites for install-

ing the Nuance Management Server and Console on page 42.

During the installation, the wizard prompts you to enter the name of this user account and the

password to it. You must set up this account with Log on as Service rights so that it can start

Profile Optimizer and Speech Node services when the installation is complete.

For more information on how to set rights to start a service, refer to Installing Profile Optimizer

Speech Nodes on independent or virtual machines on page 86.

Gathering information you need
Before you begin, you need to have the following information:

n Name or Address of Installation Machine You need the name or address of the machine

where you intend to install the Profile Optimizer Server. If your network uses dynamic addresses,

you should use the computer name to identify it, just in case the dynamic address changes in

the future.

n Location of Master User Profiles folder If you are planning to put the user profiles directory

on the same machine with the Profile Optimizer installation, you should know that in advance.

n Name of Machine where Profile Optimizer Database Server resides and name of folder

for Database Files Profile Optimizer requires access to the Profile Optimizer Database (possibly

on the same machine) through its physical server's name. You will need to provide the database

server name during the installation.

n Create a folder to contain the database files for the Profile Optimizer Database and create it on the

machine where the Profile Optimizer Database is installed. Be sure you know where this folder is

located, as you will need to provide the full path to it during the installation. You create this

folder on a disk of the machine, not inside SQL Server's Object Explorer
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Installing software to support Profile
Optimizer Speech Nodes installation
You install two extra packages on machines where you are planning to install Profile Optimizer

Speech Nodes:

Windows Installer 3.1 If you are installing a Speech Node on a machine with any supported oper-

ating system other than Windows Server 2008, the installer requires that the machine have Win-

dows Installer 3.1 or greater on it. (Windows Server 2008 automatically installs a later version of

Windows Installer.) For information on operating systems that support Speech Nodes refer to Dragon

Medical Enterprise Planning and Deployment Guide.

Dragon Medical SDK Client You must install the latest version of the Dragon Medical SDK

Client software on workstations where you plan to install Speech Nodes. This software is included

on the Nuance Management Server Software and Documentation DVD.

Installing Profile Optimizer Server
prerequisite software

Before you install the Profile Optimizer components, you must install the Windows Server and

other prerequisite software. Some of this software is required for both the NMS Server and the Pro-

file Optimizer Server.

Before you install the Profile Optimizer Server, you must install all of the following (if you have not

already installed them):

n Windows Server 2008, 2008 R2, 2003 SP2, or 2003 R2 if the server software is not already

installed.

n SQL Server 2008, using the Nuance Management Server MS SQL 2008 DVD included in the

Dragon Medical 360 | Network Edition software package (does not have to be on the same physical

server as the Profile Optimizer).

n Any Windows updates available.

n .NET Framework 4.0 and 3.5 SP1. This software is readily available on the web at the link

provided.

Note that you need most of the same prerequisite software for both NMS Server and Profile Opti-

mizer Server. It is not unusual to install both servers on the same physical server.

You need to install additional prerequisite software for Speech Nodes. For more information and

instructions on additional packages you must install for Speech Nodes, refer to the next major sec-

tion, Installing prerequisite software for speech nodes on page 73.
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Installing Windows Server and .NET Framework
Follow these steps:

1. If you have not already done so, install one of these versions of Windows Server: 2008, 2008

R2, 2003 SP2, or 2003 R2. For instructions on installing Windows Server 2008 or 2008 R2,

refer to Installing SQL Server 2008 on page 48.

2. After you install the server software, you should download any Windows updates to be sure you

have all updates available. Then, once you have all updates available, turn off automatic updates.

3. If you have not already done so, install SQL Server 2008 following the instructions provided in

this manual. You must have the database software installed before you install Profile Optimize.

4. Install .NET Framework 4.0. If you do not have this version of .NET Framework already

installed, visit the link provided and download/install it from there. Allow approximately

1 hour to install it. http://ww-

w.microsoft.com/downloads/en/confirmation.aspx?FamilyID=9cfb2d51-5ff4-4491-b0e5-

b386f32c0992&displaylang=en

5. Install .NET Framework 4.0 Extended. You must be sure you have the Extended version of

Microsoft .NET Framework 4.0 installed (.NET Framework 4.0 Client Profile version is not

supported). If you do not have the correct version of .NET Framework already installed, visit

the link below and download/install dotNetFx40_Full_setup.exe from there:

http://www.microsoft.com/downloads/en/confirmation.aspx?FamilyID=9cfb2d51-5ff4-

4491-b0e5-b386f32c0992&displaylang=en

6. Once you have saved the dotNetFx40_Full_setup.exe file, double click on the file to initiate

the .NET Framework installation.

7. When the .NET Framework installation is complete, you should retrieve and install any updates

available for the program.

For information and instructions on additional packages you must install for Speech Nodes only,

refer to the next major section, Installing prerequisite software for speech nodes on page 73.

If you are installing only the Profile Optimizer Server right now, you can proceed to Installing the Pro-

file Optimizer Server and speech nodes on page 76.
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Installing prerequisite software for
speech nodes

On machines where you are installing Profile Optimizer Speed Nodes, you must install all the same

software you installed for the Profile Optimizer Server, except that:

n You have the option of installing a Speech Node on a workstation rather than a server.

n You are required to install additional software packages—an installer and an SDK.

Operating Systems and related software for Speech Nodes

n You can install a Speech Node on a Windows Operating System. See System Requirements for Dragon

Medical 360 | Network Edition on page 7. For more information on operating systems that

support Speech Nodes, refer to the Planning and Deployment Guide.

Windows Server 2008 R2: On all machines where Speech Nodes will run on Windows Server

2008 R2 (with or without Service Pack 1), download and apply the following patch:

http://hotfixv4.microsoft.com/Windows%207/Windows%20Server2008%20R2%20SP1/

sp2/Fix392120/7600/free/445413_intl_x64_zip.exe

Please see the following Microsoft Support articles for information about why this hot fix is

necessary for reliable operation of a Speech Node on Windows Server 2008 R2:

http://support.microsoft.com/kb/2687753

http://support.microsoft.com/kb/2624677

http://support.microsoft.com/kb/2584874

n Any Windows updates available.

n .NET Framework. See System Requirements for Dragon Medical 360 | Network Edition on page 7.

Additional software packages for Speech Nodes Only

Additional packages that you need to install on Speech Nodes only are:

n Windows Installer 3.1 or greater, only if you are installing the Speech Node on any operating

system other than Windows Server 2008.

n The current version of Dragon Medical SDK Client Edition, required for every Profile Optimizer

Speech Node.

More information on each additional package is in the corresponding section below.

Installing Windows Installer 3.1 or higher for
Speech Nodes not on Windows Server 2008
Every machine where you use install a Profile Optimizer Speech Node, Windows Installer 3.1 or

greater must be on the machine. See the Microsoft website for the Windows Installer software,

and for instructions on installing Windows Installer.

Caution:
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If you are installing on a Windows Server 2008 machine, you installed the Windows Installer

when you installed the operating system, so you can skip this section.

To install Windows Installer 3.1:

1. Proceed to the web site at:

http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-

4A38-B838-DE776FD4138C&displaylang=en

2. Scroll down the web page until you find a heading that says Files in This Download and a list

of files below it (see illustration):

3. Click the third Download button for the executable to download the file for the software.

4. When you are prompted to save or run the file, click Run and follow the wizard instructions

Microsoft provides.

Installing Dragon Medical SDK Client Edition
You can find the Dragon Medical SDK Client software on the Nuance Management Server Software and

Documentation DVD. You must install this software on every machine or virtual machine where

you plan to install a Profile Optimizer Speech Node. To install the software:

1. In the Dragon Medical SDK Client directory of the Nuance Management Server Software and Doc-

umentation DVD, find the installation file and double click it. The installation file name follows

this naming convention:

Dragon SDK Client Edition<VersionNumber>.msi

For example, to install the Dragon Medical SDK Client version 12, you would click on the fol-

lowing file:

Dragon SDK Client Edition12.msi

2. Click Next and, when choosing the type of installation, be sure to select Typical/

Complete.

3. Click Next until you reach the installation page of the wizard.

74

http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&amp;displaylang=en


Chapter 3: Installing Profile Optimizer components

4. Click Install.

5. When the installation is complete, click Finish.

When you have finished installing this required software, you are ready to install the Profile

Optimizer Server and Speech Nodes. 
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Installing the Profile Optimizer Server
and speech nodes

This section of the installation covers installing the Profile Optimizer Server with or without a Speech

Node on the same machine. If you have already installed the Profile Optimizer Server and want to

install one or more Speech Nodes on another machine, see Installing Profile Optimizer Speech Nodes on

independent or virtual machines on page 86

Caution:

When you are installing the Profile Optimizer Server, since you are also installing the Profile

Optimizer Database, regardless of whether you install both the server and database on the same phys-

ical server, you should:

n Be sure to install SQL Server on the machine where the database will reside before installing the

Profile Optimizer Server.

n After the database software is installed, go to a drive (such as C:) on the machine where you

have installed SQL Server and create a folder for the database files, such as ProfOpt_DB. Note

the full path to this folder is C:\ProfOpt_DB. You later enter this path during the installation,

so the Profile Optimizer Server knows where to find the files.

n If you are upgrading to DM360 Network Edition Service Pack 3, you should uninstall the

Profile Optimizer Service before the upgrade. Existing database and log files are not modified

during the upgrade. After you close the Speech Node software, make sure the

Nuance.ConversionServer.ClientApp.exe is not running. If you see the

Nuance.ConversionServer.ClientApp.exe process in the Windows Task Manager, close it. See

Revising or Repairing Profile Optimizer Installation in the DM360 Network Edition Installation

Guide for information about how to uninstall and reinstall the Profile Optimizer software.

After you have installed all other prerequisite software and SQL Server, regardless of whether or

not you plan to install any Speech Nodes on the same machine, you install the Profile Optimizer Server

as follows:

1. Before you install or upgrade the Profile Optimizer Server, you will need an Organization

Token. That token is used during the Profile Optimizer Server installation. The Organization

token is required for both NMS in the cloud or an on-premise NMS. If you are using (or

migrating to) NMS in the cloud, Nuance creates the Organization token for your organization

and provides it to you. If you are using an on premise NMS, you must create the Oragnization

Token yourself.

Complete the following steps to create an organization token:

n In the Management Console, go to Organization > Search.

n Enter your search criteria in the Search fields and click the magnifying glass button.

Your search results appear.

n Select the site that you want to create a token for, and in the Organizations area

click the Details icon. The Organization Details screen appears.
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n In the Organization Tokens tab, click Add to generate a new organization token.

The Token field is pre-filled. Optionally, enter a value in the Comment field.

Click Save.

n The new token appears in the Token table. Copy or make a note of this value; you

will need it to configure EHR Single Sign-On or install the Profile Optimizer.

2. Create a folder on the database server's hard drive to store the database files of the Profile Opti-

mizer. Make a note of the full path to this file, as you enter it later in this installation process.

3. Insert the Nuance Management Server Software and Documentation DVD in the DVD reader of your

server. Browse the DVD until you find the ProfileOptimizerServices.msi file and double

click on it to launch the installation. After you see the wizard start, click Next to proceed.

4. When the Profile Optimizer Services page of the wizard appears, choose the parts of the prod-

uct you want to install on the particular machine. To install both the Speech Node and the server,

you must install both at the same time by selecting both check boxes (as shown below), because

if you try to use the installer on the same machine after installing a single component, not select-

ing the check box for a component uninstalls that component. To install the Profile

Optimizer Server alone on a machine, select only the Install Profile Optimizer Server check

box, instead of both check boxes.
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If you are trying to install the Speech Node along with the server but the Install Profile

Optimizer Speech Node check box is grayed out, it is probably because you do not have the

required prerequisites installed, including Windows Installer 3.1 or greater and the Dragon Med-

ical SDK Client. If this situation arises, click Cancel and go back to the instructions in Installing

prerequisite software for speech nodes on page 73 then return to the beginning of this section and start

over.

If you do want to install the Speech Node on the same machine as the server, you can install only

a single non-virtualized node, because you are allowed to install only one Profile Optimizer Speech

Node on the same machine with the server.
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5. Click Next to proceed to the Service Account Configuration page of the wizard.

On this page, you enter the domain and user name of the account to run the services under.

Nuance recommends that you enter the account you created earlier to run all services under,

that it be the same account you are running the NMS Server under, and that you assign an appro-

priate name, such as NMSapps, to the account. After you enter the password, you need to

enter it again in Confirm Password.

If the domain, machine name, user account name, or password is not valid, the installer does

not let you proceed until the values you enter are valid.

Caution:

The account that the Profile Optimizer Server and Speech Nodes run under must have full rights to

access the master user profiles, including rights to modify files in the profiles directory.

5. After you click Next, the Profile Optimizer Folder Configuration page of the wizard

appears. Here you set the paths, shown in the next illustration, to the Profile Optimizer log files

and the task result files.

79



Dragon Medical 360 | Network Edition Installation Guide

l Folder to store Profile Optimizer Services log files—Full path to the file that should

contain the logs that all Profile Optimizer processes create. You can enter your own custom

path or click Browse to find the location you want. The default location is

C:\Program Data\Nuance\Profile Optimizer Services\Logs.

l Folder to store task result files—Full path to the output files that speech tasks create.

These files include Speech Node logs and Dragon logs that the NMS Server can retrieve (for

more information on logs, see the Nuance Management Server Administrator Guide. You can

enter your own custom path or click Browse to find the location you want. The default loca-

tion is C:\Program Data\Nuance\Profile Optimizer Services\Jobs\

6. When you have entered the information, click Next to proceed to the Server Configuration

page of the wizard. Here you enter information required for the Profile Optimizer Server to con-

nect to the NMS Server and the database server where the Profile Optimizer SQL Database resides

(usually the same physical server where the NMS SQL Database resides, but not always). Nuance

recommends that you use Windows Authentication to connect to the Profile Optimizer

SQL Database.

For on premise NMS installations, you need to create an Organization token (underOrgan-

ization Details).

80



Chapter 3: Installing Profile Optimizer components

l NMS Server Name. The name of the NMS server.

l NMS Customer Token. The token for your organization. If you are migrating to NMS in

the cloud, this is the token created for your organization in the cloud NMS. If you are not

migrating to NMS in the cloud, this is the organization token for your on-premise NMS. See

l SQL Server Name Enter the machine name of the physical server where you installed the

SQL Server database software.

l Use Windows Authentication check box. Check this box to use Windows Authentication.

To instead use SQL Server Authentication, you need to fill in the SQL system administrator

user name and password in the SQL User Name and SQL Password text boxes.
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7. When you have entered the account information, click Next to proceed to the Database Cre-

ation page of the wizard. Here, you see the name of the physical server that is the

database server in the SQL Server Name text box.

Below the database server name, in Folder path of SQL Server database files on database

server, enter the full path to the folder on the SQL Server machine that you created at the

beginning of these instructions or during the SQL Server installation. The purpose of this file is

to store the database files that host the database. (The full path must start with the disk name;

for example, C:\ProfOpt_DB.)

Note:

You create the database files folder for the Profile Optimizer database on the main disk drive of your

machine, not inside the SQL Server Manager Object Explorer tree structure. If you are installing

the database on the local machine, the installer creates this folder for you.

8. Click Next to proceed to the Ready to install Profile Optimizer Services page, where you

click Install to launch the installation.
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9. When the installation is complete, you receive the final page of the wizard. Click Finish to exit

the wizard.
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10. As a result of installing the Profile Optimizer Server, the installer:

n Creates the actual database in SQL Server.

n Installs the Profile Optimizer Server service of the Profile Optimizer Server.

n Installs the service of the Profile Optimizer Speech Node:

l Profile Optimizer Speech Node

You can now verify that the server installations were successful by proceeding to Starting servers

and logging in to the Nuance Management Console on page 93. The services should start automatically

after you complete the installation. However, even after the Profile Optimizer Server is running, it is

not fully operational until you have installed at least one Speech Node.

Either before or after you verify the services are running, if you have not yet installed any Speech

Nodes, to install one or more nodes on machines other than the Profile Optimizer Server machine,

you should proceed to the next section, Installing Profile Optimizer Speech Nodes on independent or vir-

tual machines on page 86
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Revising or Repairing the Profile
Optimizer Installation

If you have installed the Profile Optimizer Server and/or its Profile Optimizer Speech Nodes and want to

modify or repair that installation, you take only a few steps.

1. Halting Profile Optimizer Speech Nodes on page 85

2. Revising or repairing the Profile Optimizer or Speech Node installation on page 85

Note: If you are upgrading to DM360 Network Edition Service Pack 2, you should uninstall the

Profile Optimizer Service before the upgrade. Existing database and log files are not modified dur-

ing the upgrade. After you close the Speech Node software, make sure the Nuance.Co-

nversionServer.ClientApp.exe is not running. If you see the

Nuance.ConversionServer.ClientApp.exe process in the Windows Task Manager, close it.

Halting Profile Optimizer Speech Nodes
If you have one or more Profile Optimizer Speech Nodes running, you need to terminate their proc-

esses:

1. To terminate the processes, open the Windows Task Manager and click the Processes tab.

2. Find any processes namedNuance.ConversionServer.ClientApp. Highlight them and click

End Process.

Revising or repairing the Profile Optimizer or
Speech Node installation
After the Profile Optimizer Installer wizard starts up and you click Next, if you have already

installed any portion of Profile Optimizer, theModify, Repair or Remove installation page of the

wizard appears and you should selectModify, then click Next to proceed.
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Installing Profile Optimizer Speech
Nodes on independent or virtual
machines

Before you install any Speech Nodes, be sure to install the Profile Optimizer Server (see Installing the Pro-

file Optimizer Server and speech nodes on page 76.

In large Dragon Medical 360 | Network Edition configurations, you usually install multiple

Profile Optimizer Speech Nodes on their own independent machines or on virtual machines. Once you

have installed them on one or more separate machines, Profile Optimizer Speech Nodes automatically

find the Profile Optimizer Server and add themselves to the network as resources for the Profile Opti-

mizer. Because of this self-attaching feature of Profile Optimizer Speech Nodes, you can add more

nodes as your network requirements grow.

Installing Profile Optimizer Speech Nodes
To install Profile Optimizer Speech Nodes on their own machines or virtual machines:

1. Be sure that on the Speech Node machine you have all prerequisite software installed, including

the operating system and related packages, plus the installer and SDK required for Speech Nodes

only, as covered in Installing prerequisite software for speech nodes on page 73.

2. Insert the Nuance Management Server Software and Documentation DVD in your server's DVD

reader. Browse the DVD until you find the ProfileOptimizerServices.msi file and double

click on it to launch the installation.

3. After you see the wizard start, click Next to proceed.
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4. When the Custom Setup page of the wizard appears, select only Install Profile

Optimizer Speech Node.

If you attempt to install a Profile Optimizer Speech Node on an operating system other than Win-

dows Server 2008 without first installing the prerequisite Windows Installer 3.1 and Dragon Med-

ical SDK Client software, the Install Profile Optimizer Speech Node check box is grayed out

so that you cannot select it. If this situation arises, click Cancel and go back to the instructions

in Installing prerequisite software for speech nodes on page 73Installing prerequisite software for speech nodes

on page 73 then return to the beginning of this section and start over.

5. Click Next to proceed to the Service Account Configuration page of the wizard.
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On this page you enter the user name and password of the account that this Speech Node service

will be running under. The account should be the same account that the NMS Server and the Pro-

file Optimizer Server are running under (unless you chose to have the Local Service Account run

the Profile Optimizer), and should have an appropriate name, such as NMSapps.

If you are running the Profile Optimizer Server under the Local Service Account, you need to run

all associated Speech Nodes under that account as well.

6. After you enter the password, you need to enter it again in Confirm Password.

If the domain or machine name or the user account name or password are not valid, the installer

does not let you proceed until the values you enter are valid.

7. Click Next to proceed to the Profile Optimizer Folder Configuration page. Here you enter

the full path to the folder that you want to store Profile Optimizer service log files that the

Speech Node produces.
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In the Folder to store Profile Optimizer Services log files text box, you can enter your own

custom path or click Browse to find the location you want. The default location is operating

system dependent, so yours may not match the one shown here, which is on a Windows XP

SP3 machine.

For instance, the default location on a Windows 2008 Server would be:

C:\Program Data\Nuance\Profile Optimizer Services\Logs

And the default location on a Windows XP workstation is:

C:\Documents and Settings\All Users\Application Data\Nuance\Profile Optimizer Services\Logs

7. Click Next to proceed to the Speech Node Configuration page of the wizard. Here you enter

the name of the physical server where the Profile Optimizer Server for this Speech Node resides.
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In many cases, the Profile Optimizer Server resides on the same machine as the ProfileOptimizer

SQL Database, as is the case for the Walden organization shown throughout this chapter, where

the NMS Server is installed onWalden_NMS, and the Profile Optimizer and all databases are

installed on the Walden_DB machine (see above illustration).

8. Click Next to proceed to the Ready to install Profile Optimizer Services page of the wizard.

Here you click Install to launch the installation process and wait for it to complete.
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9. When the installation is complete and you receive the final page of the wizard, click Finish to

exit the wizard.

While installing a Profile Optimizer Speech Node, the process installs the Profile Optimizer Speech

Node service. This service should start automatically after you complete the installation.

You are now ready to verify that the Profile Optimizer Server and Speech Node services are running. Be

sure to follow the steps outlined in the next chapter, Starting servers and logging in to the Nuance Man-

agement Console on page 93. 

Anti-virus recommendations and
requirements

Nuance recommends anti-virus software on all Dragon Medical 360 | Network Editionservers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

After you have installed the servers, be sure to exclude from the anti-virus scan any files found in

the folders indicated below or with the extensions listed below.

On NMS Servers, Profile Optimizer Server, SQL Database Server:

n Nuance folder and all sub-folders

n Files with these extensions: 

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV

Open ports on the Profile Optimizer
Server

Although the installer opens the ports for you, you should verify that all of the following ports are

open on the Profile Optimizer Server:

n Profile Optimizer Server: 8001, 905. 

n Speech Node: 8000
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Installing Nuance software
certificates

Although you have installed the NMS Server software, you cannot log in to the NMS Server

through the Nuance Management Console until you install the Nuance Software Certificates.

Caution:

You must install these Nuance Software Certificates on every machine where you want to log in to the

Nuance Management Console.

These certificates are in the Nuance_Software_Certificates.msi file provided on the Nuance

Management Server Software and Documentation product DVD.

You must have Windows administrator privileges on the machine to install the certificates.

Installing Nuance Security Software Certificates
To install the Nuance Software Certificates:

1. If it is not already there, insert the Nuance Management Server Software and Documentation DVD into

your DVD reader.

2. Browse the DVD for the file namedNuance_Software_Certificates.msi.

3. Double click on the file and if you are prompted, click Save to download and save it, or Run to

run it without downloading it. If you save it, then find the file where you saved it and double

click on it.
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4. The Nuance Software Certificates InstallShield Wizard appears.

5. Click Next to continue to the Custom Setup page.

6. On the Custom Setup page, choose to download the feature or and all of its sub features on

the local hard drive. Then click Next to continue.

7. On the Ready to Install the Program page, click the Install button and give the installer time

to install the certificates.
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8. When the installation is complete, you should see the InstallShield Wizard Completed page

and can click Finish to close the wizard.

You are now ready to run the Nuance Management Console. For instructions, proceed to Logging in to

the Nuance Management Server through the Nuance Management Console on page 97.
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Logging in to the Nuance
Management Server through the
Nuance Management Console

Before you can log in to the NMS Server using the Nuance Management Console, you must be sure

you have installed the Nuance Software Certificates. If you have not installed them on the

machine, install them before you log in. Refer to Installing Nuance software certificates on page 94.

Caution:

If the time and date setting on a workstation machine you are trying to log in through is more than

5 minutes different from the time setting on the NMS Server, you will not be able to log in

through the Nuance Management Console on that workstation. If you have trouble logging in, syn-

chronize the clock settings on those machines.

Once you are sure the NMS Server is running, you should be able to log in to the Nuance Man-

agement Console. To verify you can log in:

1. Once the server is running, you use the IP address or name of the machine where the server

was installed to access the server and configure it.

2. Go to any workstation on the network and open a browser window.

3. In the URL line of the browser, enter http://<IP_address>/nmc/Client.xbap, entering your

server machine's IP address (but not the angle brackets). Then click the Go or similar button in

the browser. Or, if you know the server name, use its name instead of its

IPaddress: http://<servername>/nmc/Client.xbap

(The URL shown here is based on the location of the .xbap file if you installed the NMS Server

under the default directory.) Note that this URL changes if you have a load balancing switch

managing traffic to multiple NMS Servers (see the end of this section for details).

4. When the Nuance Management Console login screen appears, enter admin as the user

name and password as the password, then click Log on.

To change the standard login and password, refer to the Nuance Management Server Administrator

Guide
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5. The Home page appears. Here you see links to the various features of the NMS Server:

Note:

Be sure you change the standard login and password before you log out.

For how to the change the password and other information on configuring the Dragon Medical

360 | Network Edition network and the Nuance Management Server, refer to the Nuance Management

Server Administrator Guide or the Nuance Management Console Help.

Accessing Nuance Management Console when load
balancing traffic switch chooses among multiple
NMS Servers on your network
When you have multiple NMS Servers and a load balancing traffic switch in your network, you

should be sure that when you open the Nuance Management Console, you substitute the name or

address of the switch for the name or address of the NMS Server. For instance, for a load balancing

switch namedNMS_Switch at IP address 10.1.1.2, here are two possible URLs you would use to

run the console:

http://NMS_Switch/nmc/client.xbap

or

http://10.1.1.2/nmc/client.xbap
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Starting the Nuance Management
Server and Profile Optimizer Server

After the NMS and Profile Optimizer servers are installed, if the services do not start on their own,

be sure that the account the servers are running under has Windows administrator level privileges,

has rights to start a service, and that the same account is the one all entities are running on all

servers and (if Windows-based) file servers of the entire Dragon Medical 360 | Network Edition

network, including NMS Server, Profile Optimizer Server, all Speech Nodes and the machine hosting the

master user profiles directory.

Caution:

The account running the services for the NMS Server, Profile Optimizer Server, and Speech Nodes must

have full access rights on all those machines and on the machine that hosts the master user pro-

files.

Changing the account running NMS Server
If you had no trouble entering the user account the server should run under during the NMS

Server installation, skip to the next subsection, Starting NMS Server service on page 99.

If during the installation you were forced to change the account that the NMS Server runs under to

the local administrator or local system account, you need to change that account to the same one

that the other servers are running under (such as NMSapps):

1. Click Start > Control Panel and double click Administrative Tools, then double click Serv-

ices.

2. In the Services list, find the Nuance Management Service.

3. Right click on the service name and select Properties to open its

Nuance Management Service Properties dialog box.

4. Click the LogOn tab and in the This Account text box enter the domain and user name of the

account that all Dragon Medical 360 | Network Edition services should run under, separating them

with a backslash:

<DOMAIN>\<user name>

5. Enter the password in the Password and Confirm Password text boxes.

6. Click Apply to change the account and then click OK to close the dialog box.

7. Now you are ready to start any DM360 Network Edition  services that do not automatically

start.

Starting NMS Server service
After you are sure you have all the necessary privileges, to start NMS Server service:

1. Click Start > Control Panel and double click Administrative Tools, then double click Serv-

ices.

2. In the Services list, find the Nuance Management Service.
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3. To start the service, right click on the service name to open its Nuance Management Serv-

ice Properties dialog box.

4. If the Startup type is not set to Automatic select Automatic from the drop-down list.

5. Click the Start button in the lower third of the dialog box.

6. Click OK to close the dialog box.

7. If you have Profile Optimizer components installed on the same machine as the Nuance Management

Server, to verify that you can log in to the Nuance Management Console, proceed to Logging in to

the Nuance Management Server through the Nuance Management Console.

Starting Profile Optimizer services
After you are sure you have all the necessary privileges, to start the services of the Profile Optimizer

or for one or more Profile Optimizer Speech Nodes:

1. Click Start > Control Panel and double click Administrative Tools, then double click Serv-

ices.

2. In the Services list, find the Profile Optimizer Server service for the Profile Optimizer Server.

If a Speech Node is installed on the computer, the Services list displays the service for the Pro-

file Optimizer Speech Node.

3. Start each service manually by clicking on the Service name to open its <Service Name> Prop-

erties dialog box.

4. If the Startup type is not set to Automatic select Automatic from the drop-down list.

5. Click the Start button in the lower third of the dialog box.

6. Click OK to close the dialog box.

7. Additional privileges may be required to start the Profile Optimizer Speech Nodes. For more infor-

mation see Installing Profile Optimizer Speech Nodes on independent or virtual machines on page 86.

8. If you have not already done so, verify that you can start the Nuance Management Console (see Log-

ging in to the Nuance Management Server through the Nuance Management Console).

Starting Profile Optimizer Speech
Nodes

Running Profile Optimizer Speech Node service
Once you have installed Profile Optimizer Speech Nodes, to be sure the Speech Nodes are running and

to start them if they are not:

1. Click Start > Control panel and double click Administrative Tools to open the Admin-

istrative Tools dialog box.

2. Find and double click Services. The Services dialog box opens, displaying a list of services

installed on the machine.

3. Look in the Name column for the Profile Optimizer Speech Node service. Double click on

the service name to open its Properties dialog box.
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4. In the Startup type drop-down list, if the service is not already set to start automatically, select

Automatic.

5. Under Service status, click the Start button to the left.

6. After the Service status says Started, you can click OK and close the dialog box.

Giving yourself rights to start the service
If you cannot start the Profile Optimizer Speech Node, you might have only had privileges to install

the Speech Node; that means you might not have privileges to run the service that launches the

node.

If you have Log on as Service level privileges, then the SPARK Speech Node Manager serv-

ice should start immediately. If you do not have that privilege, you might receive the error shown

below:
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A quick way to correct this problem is to enter your credentials in the Service Control Manager

by taking these steps:

1. Click Start > Control panel and double click Administrative Tools to open the Admin-

istrative Tools dialog box.

2. Find and double click Services. The Services dialog box opens, displaying a list of services

installed on the machine.

3. Look in the Name column for the Profile Optimizer Speech Node service. Double click on

the service name to open its Properties dialog box.

4. Click the Log On tab, then to enter a network domain level user's login and password,

click This account and enter the domain and user name of the individual who should have
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access and enter it in the format of <DOMAIN>\<username> with a backslash between them.

The user must be a Windows administrator level user.

To allow a local machine user to have access, click This account and enter

<machineName>\<username> with a backslash between them or .\<username>, where .\ pre-

cedes the login name.

Next, you prepare to log in to the Nuance Management Console by first installing the Nuance cer-

tificates on the workstation you want to log in on. Proceed to Installing Nuance software certificates on

page 94.

Anti-virus recommendations and
requirements

Nuance recommends anti-virus software on all Dragon Medical 360 | Network Editionservers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

After you have installed the servers, be sure to exclude from the anti-virus scan any files found in

the folders indicated below or with the extensions listed below.

On NMS Servers, Profile Optimizer Server, SQL Database Server:

n Nuance folder and all sub-folders

n Files with these extensions: 

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV
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Choosing a master user profiles
location for a site

For each site on your Dragon Medical 360 | Network Edition network, you must determine where on

the network the master user profiles should be located. In fact, a site is, by definition, a facility

location or group of facility locations in your organization that use the same server location for

their user profiles. If all of your user profiles are stored in a single server location, your organ-

ization needs only one site.

All user profiles for a single site should be in their own subdirectory of the master user profiles

directory.

The NMS Server lets you store you master user profiles on a Windows server, a networked Win-

dows workstation (a server is not required), or a web server with or without SSL—this last option

allowing you to access your master user profiles over the Internet. (The machine storing the

master user profiles must be Windows-based.)

If you choose to use a networked Windows server or workstation, you should determine the path

to where the master user profiles will reside and be able to access it any of these ways:

n Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.

n UNC Paths—Connects to a shared network folder using the Universal Naming Convention

(UNC) to locate a user. The UNC is a way to identify a shared file on a computer or network

without having to know the storage device it is on. Format is:

\\<servername>\<sharename>\<path>\<filename>.

n HTTP (http:)—Connects to machine on the Internet or your local intranet running a web

server. Format is: http://<myserver.com>/<webdav>

n HTTP with SSL (https:)—Connects to machine on the Internet or your local intranet running a

secure socket layer (SSL) web server. Format is: https://<myserver.com>/<webdav>

The location(s) you select must be accessible to all computers where healthcare providers dictate.

Each location must have adequate storage space for the master user profiles.

Caution:

If the master user profiles directory is on a separate server or workstation, you must share the top

level master user profiles directory in Windows and give Everyone full read/write/modify con-

trol over the directory, so that the Dragon Medical Client can write to those directories when it

creates the master user profile for each healthcare provider.
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Caution:

Be sure that when you set up the master user profiles directory, you locate it either on a Windows

machine or on a device connected to a Windows machine with .NET Framework 4.0 installed on

it and that the machine is in the same Windows domain as your DM360 Network Edition servers.

If you choose to use server, choose one of the supported web servers.

Supported Web Servers

n Microsoft Internet Information Services (IIS) 6.0 on Windows Server 2003

n Microsoft Internet Information Services (IIS) 7.0 or 7.5 on Windows Server 2008

n Apache HTTP Server 2.0.54 and higher on Windows Server 2003

n Apache HTTP Server 2.2.16 and higher on Windows Server 2008

Information required for setting up Web Server

If you have chosen to store the master user profiles on a web server or secure web server, you

should determine the following information so that you can tell Dragon how to connect to the

HTTP server:

n The network location—You need to know the URL address of your HTTP server. 

n HTTP settings—For your http (or https) connection you need to know authentication,

firewall, and proxy server information.

n SSL settings—For your https connection you need to know Certificate store information, and

the type(s) of SSL protocols used.

n If you are using Open SSL, you need the locations of the cipher list, certificate authority file,

and certificate authority directory.
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Setting up a computer to host master
user profiles

Caution:

If you have proxy servers in your network, they must all point to the machine hosting the master

user profiles.

Any time after you have installed the NMS Server and started its service (even before you have the

Profile Optimizer Server installed or running), you can set up the machine that hosts your master user

profiles by taking these actions:

n Creating the master user profile directory on page 108

n Mapping the disk drive on the client workstation on page 108

n Setting up access to the master user profile directory on page 109

Creating the master user profile directory
On the machine that you selected to host the master user profiles for the Dragon Medical 360 | Net-

work Edition network:

Caution:

Be sure the machine is a Windows server or workstation with the .NET Framework installed ( see

System Requirements for Dragon Medical 360 | Network Edition on page 7 for the appropriate version)

and that the machine is in your Windows domain. If you are using a RAID array, be sure to attach

the device to a Windows machine meeting these requirements. The requirements that machine be

a Windows machine with specific software installed differ from roaming user storage requirements

for previous non-network editions of Dragon Medical.

1. Create a directory to store the profiles. You can have more than one directory for profiles, but

you should store all user profiles from providers at the same site in the same location.

2. Write down the machine name and full path to the directory.

Mapping the disk drive on the client workstation
On the workstations where you have the Dragon Medical Client 2.1 installed or in the Windows user

profiles of all providers who will later dictate:

If your workstations uses a mapped drive to access the master user profiles, map a drive letter to

the location where the master user profiles are located on every machine running the Dragon Med-

ical Client 2.1. This mapping must be the same on every workstation and every Windows user pro-

file.
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Setting up access to the master user profile
directory
Please see 'Setting general site settings for master user profiles' in the Nuance Management Server

Administrator Guide.
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Installing software for storing master
user profiles on a web server

Caution:

If you have never set up a web server or secure web server before, do not attempt to do so; these

instructions assume you have experience setting up a web server. Appropriate settings vary.

After you install the NMS Server and Nuance Management Console, if you choose to store your master

user profiles on a web server or secure web server, be sure you have the correct type of server,

download the required software, and make the correct selections while installing the web server.

Note:

Storing your master user profiles on a web server or secure web server is entirely

optional. You can choose to store them on a mapped drive, on any Dragon Medical 360

| Network Edition network physical server or workstation with adequate storage space,

or on their own Windows server or workstation within your network's domain with-

out using a web server at all.

To store the master user profiles on one of the web servers below, first be sure you have .NET

Framework 4.0 installed as well as the associated WebDAV software for the server. For more

information, visit the software provider's site (some links below are provided for reference):

n Microsoft Internet Information Services (IIS) Version 7.0 or 7.5 0 on Windows Server 2008:

l 32-bit Version: http://learn.iis.net/page.aspx/350/installing-and-configuring-webdav-on-

iis-7/webdav_x86_75.msi

l 64-bit Version: http://learn.iis.net/page.aspx/350/installing-and-configuring-webdav-on-

iis-7/webdav_x64_75.msi

n Microsoft Internet Information Services (IIS) Version 6.0 on Windows Server 2003: Refer to

Installing Microsoft Internet Information Services 6.0 web server on page 111.

n Apache Server 2.2.16 or higher on Windows Server 2008:

This server should run on Windows Server 2008 Core and also runs on Windows 7 or Vista.

For more information see:

l http://www.markwilson.co.uk/blog/2007/07/apache-http-server-on-windows-server-

2008-server-core.htm

l http://www.thesitewizard.com/apache/install-apache-on-vista.shtml

n Apache Server 2.0.54 or higher on Windows Server 2003.

For more information on installing Apache web server, see: http://www.apache.org/
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Installing Microsoft Internet
Information Services 6.0 web server

The following instructions assume you have experience setting up a web server.

You install a Microsoft Internet Information Services 6.0 web server on a Windows Server 2003

system. With that version of the operating system, you receive IIS 6.0 and the WebDAV module.

To install an IIS 6.0 web server, take these general steps:

n Install IIS 6.0 web server and its WebDAV module on the physical server.

n Customize the web server settings for Dragon Medical.

n Configure HTTP or SSL settings in the Nuance Management Console.

Installing IIS Server and WebDAV component on
physical server
To install IIS 6.0 and the WebDAV module in Windows Server 2003 or 2003 R2:

1. Log on to the server as a local Windows administrator user.

2. Go to your server desktop and click Start > Control Panel, then click Add or Remove Pro-

gram.

3. Once the Add or Remove Programs dialog box opens, look down along the left vertical bar

and click the Add or Remove Windows Components icon to start the Windows Com-

ponents Wizard.

4. When the wizard appears, check the check box for Application Server and highlight the selec-

tion and, when the Details... button becomes available, click the button to open the Appli-

cation Server dialog box.

Caution:

Do not uncheck any of the already checked boxes or the wizard will uninstall those components.

5. In the list, check the check box for Internet Information Services and highlight the selection,

then click the Details... button to open the Internet Information Services dialog box.

6. In the list, check the check box forWorld Wide Web Service and highlight the selection, then

click the Details... button to open the World Wide Web Service dialog box.

7. In the list, check the check box forWebDAV Publishing.

8. Click OK in each successive open dialog box until you return to the wizard; then click Next to

initiate the installation.
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9. When the Completing the Windows Components Wizard page of the wizard appears, to exit

the wizard, click Finish.

10. To ensure WebDAV is enabled or enable it if it is not, select Start > Programs > Admin-

istrative Tools > Internet Information Services (IIS) Manager and expand the IIS Explorer

in the left pane.

11. Select Web Service Extensions (below Web Sites) and, in the right pane of the IIS Manager

dialog box, select WebDAV, then click Allow to change its Status to Allowed (see next illus-
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tration).

Customizing web server settings for Dragon
Medical
Note:

Do not choose Digest authentication, as the Dragon Medical 360 | Network Edition network does

not support the option for an IIS web server housing the master user profiles.

Caution:

You should not give the right to log on locally to healthcare providers dictating with Dragon Med-

ical Client 2.1. Only administrator level users should have log on rights to the web server hosting

the master user profiles.

To customize the web server settings for the Dragon Medical Enterprise master user profiles:

1. Create a virtual directory for the web server. To create that virtual directory using Windows

Explorer:

i. Open Windows Explorer.

ii. Right-click the folder you want to be a virtual directory, and click Sharing and Security.

iii. Click the Web Sharing tab and then click Share this folder.

iv. In the Alias text box, type the name for the virtual directory, the select the permissions

under Access permissions and Application permissions.

v. Click OK in the Edit Alias dialog box, then OK again Properties dialog box.

2. To open the IIS Manager, select Start > Programs > Administrative Tools > Internet

Information Services (IIS) Manager.
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3. Add wildcard MIME mapping to the virtual directory. Dragon Medical Client 2.1 requires this

type of mapping. Take these steps in the IIS Manager:

i. Right click on the local computer name and select Properties from the drop-down menu.

ii. In the local computer Properties dialog box, click the MIME Types button.

iii. In theMIME Types dialog box, click the New... button.

iv. In the Extension text box, type an asterisk (*).

v. In theMIME type text box, type application/octet-stream.

vi. Click OK until you return to the Internet Information Services tab, where you click

Apply to apply the changes and OK to close the dialog box.

4. In the IIS Manager, expand the tree under the local computer by double-clicking on it; then

right-click the Default Web Site folder (or your individual Web server folder or the virtual

directory) and select Properties. You see several tabs where you enter information about the

web site. The tabs you fill out for your master user profiles web server are:

l Web Site
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l Virtual Directory orHome Directory

l Directory Security

Entering settings under Web Site tab

You should enter these settings under the Web Site tab:

1. Click the Web Site tab.

2. UnderWeb site identification, enter:
l Description: Optional. Master user profiles web server.

l IP address: Set to IP address of this machine.

l TCP port: Set to 80.

l SSL port: Set to 443 only if you are creating a secure (SSL) web server.

3. Under Connections, enter:
l Connection timeout: 120 seconds.

l HTTP Keep-Alives: Check the check box to enable them.

4. Under Enable logging, enter:
l Active log format: Select W3C Extended Log File Format from the drop-

down list.

l (Optional) Click the Properties... button to set up logging options.

5. Click Apply and proceed to either the Home Directory tab or the Virtual Directory tab.
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Entering settings under Virtual Directory or
Home Directory tab

You should enter these settings under the Virtual Directory orHome Directory tab:

4. The content for this resource should come from—Select A directory located on this

computer.

5. Local path—Enter the full path to the web site folder. If you use the default folder, the path is

C:\Inetpub\wwwroot.

6. Check off the following check boxes under the local path to indicate the kind of access to the

master user profiles you want to grant to the user accounts running the other services of the

Dragon Medical 360 | Network Edition network:
l Read

l Write

l Directory Browsing
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l Log visits

l Index this resource

7. Application name—You should see the name you gave to your virtual directory, in this case

MasterUserProfiles.

8. Execute permissions—Select Scripts and executables from the drop-down list. You need

the option of running executables on the master user profiles so that the acoustic and language

model optimization results can be integrated into the profiles. When you choose this selection,

the IIS Manager warns you that you could be exposing the site, so be sure your firewall and

other security precautions are adequate to protect the site from malicious attack.

To avoid giving permission to run scripts on the entire machine, be sure that you set the per-

missions to Scripts and executables only on the virtual directory, not on its parent directory.

9. Application pool—Select DefaultAppPool from the drop-down list.

10. Click Apply to apply the changes.

Entering settings under Directory Security tab 

Under the Directory Security tab, you select Basic authentication for the virtual directory you

created for your web server. You also view and verify certificate information that ensures the iden-

tity of the computer if you are installing the software on a remote computer, rather than locally.

Caution:

Basic authentication transmits user names and passwords across the network in an unencrypted

form. You must use your web server's encryption features to ensure the security of login infor-

mation.

To use Basic authentication to control access to your web server, you grant each Windows

administrator account that needs access the right to log on locally. (You can add each admin-

istrator to a group and then give the group access to the necessary files.)

Caution:

You should not give the right to log on locally to healthcare providers dictating with Dragon Med-

ical Client 2.1. Only administrator level users should have log on rights to the web server hosting

the master user profiles.
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1. To enable Basic Authentication:

i. In the Authentication and access control section, click the Edit... button.

ii. When the Authentication Methods dialog box pops up, check off Basic authentication.
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iii. When you are warned that this type of authentication passes unencrypted passwords over

the network, click Yes to proceed.

iv. Be sure that if you see a check mark in the check box for Enable anonymous access you

click it to remove the check mark. For security reasons, you should not allow anonymous

access.

v. Leave the Default domain text box empty to have the domain name be the name of the

machine itself when a party accessing this web server does not provide the domain name.

vi. Click OK to save the changes and return to the Directory Security tab. If you are setting

up a secure (SSL) web server, proceed to the next step. Otherwise, skip to step 5.

2. If you are setting up a secure (SSL) web server, for the web server to selectively allow only

Dragon Medical Client machines access to the master user profiles, you need to require that the

web server enable security certificates on any client that tries to access the web server. Take

these steps:

i. In the Secure communications section, click the View Certificate... button.

ii. When the Certificate dialog box pops up, under the General tab you should see Cer-

tificate Information indicating that this certificate's purpose is to ensure the identity of the

remote system seeking access.
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iii. Under the Certification Path tab, click the View Certificate button and again under the

General tab you should see root Certificate Information that ensures the validity of all

issuance and application policies.

3. If the View Certificate... button is not available, you can purchase an SSL certificates on the

web and install it. The button should then become available. For more information on pur-

chasing and installing an SSL certificate, you can visit http://www.rapidssl.com/index_ssl.htm

or a similar site.

4. For instructions on installing an SSL certificate, visit http://www-

.rapidssl.com/resources/install/chainedssl/MS_IIS5.html.

5. Click Apply to apply all changes in the Directory Security tab and then click OK to close the

dialog box.

Now that you have finished entering all of the settings for the web server, restart the World Wide

Web Publishing Service or wait for the process to recycle for the changes to take effect.

Caution:

You must share the top level master user profiles directory in Windows and give Everyone full

read/write/modify control over the directory, so that the Dragon Medical Client can write to those

directories when it creates the master user profile for each healthcare provider.

Configuring HTTP or SSL settings in Nuance
Management Console
Later, when you set up sites in the NMS Server, to set up access to the master user profiles, you

enter HTTP settings for interacting with a non-secure web site or SSL settings for interacting with

a secure web site. For details, refer to the related topics in the Nuance Management Console Help or

the Nuance Management Server Administrator Guide.

For specific HTTP settings that you should enter in the HTTP Settings tab in the Nuance Man-

agement Console for this type of web server, refer to Setting HTTP connection settings for web server on

page 123.

For specific SSL settings that you should enter in the SSL Settings tab in the Nuance Management

Console for this type of web server, refer to Setting SSL connection settings for secure web server on page

126.
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Installing SSL certificates for IIS 6.0
1. After you have downloaded an SSL certificate for IIS, the View Certificate... button becomes

available under the Directory Security tab.

2. Click the View Certificate... button to see the certificate and verify that it is valid. It should

look something like the one shown below.

Note:

All certificates should be valid, not expired, free of errors, and properly signed.

3. Keep the certificate open and click the Certification Path tab to display the path to the cer-

tificate that Dragon Medical Client 2.1 workstations will need to follow.

4. In the Certification Path tab, expand the path in the Certification path box. The Certificate

Status text box near the bottom of the dialog box should say This certificate is OK.(See the

next illustration.)
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5. Click the next View Certificate button and view the certificate for All Issuance and Appli-

cation Policies to be sure it was issued to the correct organization and is valid for the expected

time period.

6. Install the Root Certificate for All Issuance and Application Policies (see previous illus-

tration) on every Dragon Medical Client 2.1 workstation and install it to Trusted Root Cer-

tification Authorities.

Caution:

If you do not install the above certificate on every Dragon Medical Client 2.1 workstation, when the

workstation attempts to access a master user profile on the web server, the provider will receive

this error: This Certificate cannot be verified up to a trusted certification authority.

When you save the certificate, be sure to save it to <PC-name>/<Site-name> where the PC-name

matches the name of the computer and the Site-name matches the name of the site you created in

IIS Manager. Or you can save it to a name that matches the Active Directory host name.
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Setting HTTP connection settings for
web server

Caution:

If you have never set up a web server before, do not attempt to do so; these instructions assume

you have experience setting up a web server, and appropriate settings to use vary.

After you install your web server, you must set HTTP connection settings in the Nuance Man-

agement Console. For details on how to set up a site, refer to the Nuance Management Server Admin-

istrator Guide.

Note:

You set these HTTP Settings only to store master user profiles on a web server.

Making selections on HTTP Settings tab
The next table shows the settings you should select for each type of web server (not using SSL).
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Recommended HTTP settings for particular web servers

Web Server Type
& Version

Default
Values for
IIS 6.0,
7.0, or
7.5

Default
Values for
Apache
2.0.xx or
2.2.xx

Other Considerations
Based on Your Site Configuration

Authentication

Prompt for user
and password

Off Turn off to prevent prompt for a username/password
when Dragon Client accesses master user profiles.

Default user Empty Enter username for the account that the servers run
under, such asNMSapps.

Password Empty Enter password for the account that servers run under.

Authentication type Basic Basic or
Digest

For IIS, always choose Basic. For Apache, choose type you
set up on the web server.Basic authentication sends
transmits as plain text.Digest authentication transmits
passwords in encrypted form.

Firewall and Proxy Servers

Use proxy server Off Check (On) if you are connecting through a proxy server.

Type HTTP HTTP for web page transactions. Tunnel if you are using
tunneling software. Socks4 for SOCKS4 pro-
tocol/transparent client access across firewall. Socks5 for
SOCKS5 protocol/transparent access across firewall and
SOCKS5 server DNS lookup.

Server Empty Enter name of the proxy server.

Port Empty Enter number of port for proxy server or firewall.

User Empty Enter user name for logging in to proxy server or firewall.

Password Empty Enter password for logging in to proxy server or firewall.

Firewall data Empty Enter any special authentication string required.

Miscellaneous

Follow redirects Off Always or
Same
Scheme
Only

Never turn off. Handles redirects of incoming connections.

Keep connection alive Off Could be turned on even if turned off for the site. If on,
keeps the connection alive after current communication
ends, which can be useful if the connection setup process
involves multiple message transfers between the web
server and the client or server interacting with it. Should
be off if you have Follow Redirects set to anything other
than Never.

Lock timeout 120 seconds Never set this value to 0. Setting the value to 0 causes the
web server to choose a timeout which may be excessively
long, and can result in users being locked out of their user
profiles.
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Web Server Type
& Version

Default
Values for
IIS 6.0,
7.0, or
7.5

Default
Values for
Apache
2.0.xx or
2.2.xx

Other Considerations
Based on Your Site Configuration

Connection timeout 60 Must be 60.

Timeout of inactive Off Must be On.
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Setting SSL connection settings for
secure web server

Caution:

If you have never set up a secure web server before, do not attempt to do so; these instructions

assume you have experience setting up a secure web server. Appropriate settings vary. Be sure

that you install an SSL certificate that is trusted for directory on every workstation. You should

push install the SSL certificate as Trusted Root Certificate Author.

After you install your secure web server, you must set SSL connection settings in the Nuance Man-

agement Console. For details on how to set up a site, refer to the Nuance Management Server Admin-

istrator Guide .

Note:

You set these SSL Settings only to store your master user profiles on a secure web

server.

Settings on SSL Settings tab
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Recommended settings for SSL web servers
The table below shows the settings you should select for various versions of each type of secure

web server. In general, you have flexibility in selecting these settings and should select those

appropriate for your installation.

Recommended settings for particular secure web servers

Web Server Type &
Version

IIS 6.0,
7.0, or 7.5

Apache
2.0.xx or
2..xx

Other Considerations
Based on Your Site Configuration

Certificate store

CCCertificate store
type

User
Store

User
Store

CCCertificate store My My

CCCertificate store
password

Empty Empty

SSL Protocols

Use general SSL
protocols

On On Check all protocols your server might receive legit-
imate input from: TLS1, SSL3, SSL2, andPCT1.

Use Open SSL On On

CCCipher List String of ciphers if applicable. These options apply only if you are usingOpenSSL as
a Certificate Authority.

Refer to the Nuance Management Server
Administrator Guide for details.

CCCertificate
authority file

Name of file containing list of
certificate authorities to
trust.

CCCA directory Path to the directory where
certificate authority cer-
tificates reside.
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Assigning access to folders and
master user profiles across the
network

Caution:

To ensure that your Dragon Medical Clients can communicate with the master user profiles server

and the other servers, you must assign correct permissions to all appropriate directories and access

rights to particular keys in the registry, as indicated in the tables in Assigning access to servers, clients,

and master user profile locations on page 18. Do not skip this step, as it is important!

Turning off Automatic Updates
On each machine you plan to use in the network, be sure to turn off Windows Automatic

Updates. You should, instead, qualify each update Windows sends by installing it first on a single

test machine of the network and then updating other machines on the network only after you

determine that it clearly will not disrupt the network.

Once you are sure an update does not have any negative effects, you should install the update dur-

ing off-hours and, if required, reboot each machine during those hours to ensure that requests to

reboot do not disrupt the servers or workstations during peak hours of dictation.
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Preparing to upgrade non-network
edition Dragon Medical Clients

If you are planning to install the Dragon Medical 360 | Network Edition on a computer where Dragon

Medical Client 2.1 is already installed, you do not have to uninstall the non-Network Edition first.

However, Nuance recommends you uninstall Dragon Medical first if doing so would not disrupt the

operation of your medical facility.

Before you upgrade Dragon Medical non-network
edition
If you choose to uninstall the non-Network Edition of Dragon Medical, you should be sure to take

these steps first:

n Save and back up all user profiles.

n If you have any local users (not roaming) from Dragon Medical 10.x (non-Network Edition),

prepare to move them to DM360 Network Edition as explained inMigrating Non-Network Dragon

User Profiles to the Nuance Management Server on page 134

n Save any Dragon Medical 10.x roaming user profiles to a location where the NMS Server can

access them.

n Uninstall the previous edition of Dragon Medical (optional, but recommended).

n Install the new Dragon client on each client workstation.

Note:

The term roaming user profiles has been changed for DM360 Network Edition. Since all users

of the DM360 Network Edition server networks are roaming by definition (the master copy of

their profiles always resides on a central machine), the profiles stored on a central machine are

now calledmaster user profiles. When a provider dictates, the Dragon Medical Client 2.1 retrieves

a copy of the master user profile and that copy is called the local cache user profile.

When you upgrade previously existing roaming user profiles or local user profiles for use with

Dragon Medical 360 | Network Edition, these profiles all become master user profiles.

Overview of migrating local users from Dragon
Medical Practice Edition
If you have local users from Dragon Medical Practice Edition, to move them to Dragon Medical 360

| Network Edition, you take these general steps:

1. If any local users have multiple login names, combine all of their profiles under a single login

name.
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2. Export the local user profiles to a different location, so that the action you take does not affect

the user profiles of dictating providers. In Dragon Medical 360 | Network Edition, 2.1, you use

the Dragon client to export and import user profiles. For details, see the Dragon Help and the

Dragon user guide.

3. Enable the Roaming feature on the workstation and save the local users to the roaming user

location.

4. Export each roaming user profile to a location where the NMS Server can access it. In Dragon

Medical 360 | Network Edition, 2.1, you use the Dragon client to export and import user pro-

files. For details, see the Dragon Help and the Dragon user guide.

5. Create user accounts in NMS Server for the healthcare providers dictating with the local user pro-

files you are converting.

6. Associate the user accounts with the master user profiles for the corresponding healthcare pro-

fessionals.

For more details, refer toMigrating Non-Network Dragon User Profiles to the Nuance Management Server

on page 134.
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After you install the Dragon Medical client, perform
the following steps
After you install Dragon Medical 360 | Network Edition, on the new client:

1. Log in to the Dragon Medical Enterprise Client with the NMS Server user account login and pass-

word.

2. Re-import any custom words, commands, and vocabularies as instructed in the Dragon Help.
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Creating user accounts for healthcare
providers

When you are upgrading your roaming user profiles to Dragon Medical 360 | Network Edition, you

begin by creating a user account for each dictating healthcare provider.

Note:

More details about creating user accounts are available in the Nuance Management Server

Administrator Guide .

To create user accounts:

1. Log into the Nuance Management Console. For details, see Logging in to the Nuance Management Server

through the Nuance Management Console on page 97

2. On the Menu bar, click on the User Accounts ribbon.

3. When the User Accounts ribbon appears, click the Add User Account Add icon.

The User Account Details window opens.

4. Configure the options and settings on tabs in the User Account Details window:

l Details—Enter data in the shaded text boxes (required data) for now. Required information

includes the healthcare provider's first and last names and the login.

Caution:

If you are creating a user account to be managed in Active Directory, the login you enter must

match an existing login in Active Directory. If, additionally, you are setting up providers to log in

only once (called Active Directory Single Sign-On), the login you enter must match the user name

that the provider enters to log in to Windows and must also be a login in Active Directory.

l Address—Physical location information. None of this data is required right now.

l Group Memberships—If you have created no other groups, two groups exist when you

first run the product, NMC Administration and DM360 Network Edition. Add the dic-

tating user account to the DM360 Network Edition group.

l Messaging: —To configure email settings to enable the NMS to send messages to users

and administrators.

l DM360 Network Edition—To apply default settings for now, click the Use group rules

button. For more information, refer to Configuring user account Dragon settings in the Nuance

Management Server Administrator Guide.

l User Profile—Ignore these settings. The Dragon Medical Client 2.1 provides them.

3. Click Save to save the user account settings.

4. When you save the user account, the Nuance Management Console pops up a dialog box that asks

you if you want to grant a license to the user account now.
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You should click Yes.

5. When the next message asks you the type of license to assign, you can select either a Physician

Author orNon-Physician Author license. The number of licenses available shows in paren-

theses after the license type. If no licenses of a particular are available, that license type is

grayed out. If you need a license that is not available, contact your Nuance representative.

6. Repeat the above steps for each healthcare provider whose profile you plan to upgrade.

7. Depending on the type of user you are creating, return to either the Active Directory or Single

Sign-On instructions, or, proceed to Upgrading Dragon roaming user profiles.

Note:

For now, you can skip setting options and other information for the user accounts

that you want to associate with upgraded master user profiles. To later assign all

related user accounts the same option settings, you can:

n Create a group.

n Set all options for that group.

n Add the user accounts that should have those same option settings to the group.

For details on how to carry out these tasks, refer to the Nuance Management Server

Administrator Guide .

Migrating Non-Network Dragon User
Profiles to the Nuance Management
Server

If you want to migrate Dragon Medical (non-network) user profiles (stored only on Dragon Medical

Client 2.1 workstations) to DM360 Network Edition (where they become master user profiles on

the network), complete the following steps:

Before migrating Dragon local user profiles
Caution:

Nuance recommends that you protect your profile data by taking these precautions:
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n Migrating profiles can take a long time. Because of this, plan to convert the Dragon

Medical local user profiles at a time when healthcare providers are not using them to

dictate, such as at night or on a weekend. If there is no time when all your user

profiles are not in use (because healthcare providers dictate 24/7), you can convert

sets of local user profiles from particular workstations at appropriate times.

n Note that once you migrate these user profiles, if you continue using the profiles

stored on the workstations (instead of the versions on the NMS), any additions or

changes to those user profiles will not propagate to the copies on the NMS.

n Make sure that the Dragon workstations that contain profiles you want to convert

have .NET Framework Version 4 installed. You can find a copy of this

framework at:

Medical_Enterprise.rel_DVD\DNS12_
DVD1\ISSetupPrerequisites\dotNetFramework\dotNetFx40_
Full_x86_x64.exe

See Microsoft's documentation for more information on installing the .NET

framework.

Migration Paths
Nuance Communications supports migrating from the following products to DM360 Network Edi-

tion, version 2.1:

n Dragon Medical Enterprise Edition, version 10.1

n DM360 Network Edition, version 11

Overview of migrating local user profiles
To migrate DM360 Network Edition and Dragon Medical Enterprise Editionlocal user profiles to

DM360 Network Edition Version 2.1 user profiles, on each workstation with users to move to

DM360 Network Edition, you take these major steps:

1. Back up local user profiles by exporting them to a different location, so that the actions you

take do not affect the user profiles of dictating providers. See Migrating Non-Network Dragon User

Profiles to the Nuance Management Server on page 134

2. If any one healthcare provider has multiple user names for logging in, that provider has more

than one profile. For efficiency, you should combine multiple user profiles for the same pro-

vider, creating a single user profile for that person. See Migrating Non-Network Dragon User Profiles

to the Nuance Management Server on page 134 for more information.

3. If they aren't already there, export the profiles that you want to upgrade to the default location

for Dragon user profiles. See Migrating Non-Network Dragon User Profiles to the Nuance Management

Server on page 134 for more information.

4. On the Nuance Management Server (NMS), set the directory for the user profiles that you are

migrating. See Step 7: Create user accounts for the migrated profiles on the NMS on page 140 for more

information.

135



Dragon Medical 360 | Network Edition Installation Guide

5. Copy the directory containing the User Profile Export Tool to a location on the network that

can access all of the DM360 Network Edition and Dragon Medical Enterprise Edition work-

stations that you want to upgrade. See Step 5: Copy the User Profile Export Tool to a network location

on page 139 for more information.

6. Install and run the User Profile Export tool. See Step 6: Install and Run the User Profile Export Tool

on page 139

7. Create user accounts in NMS Server for the healthcare providers dictating with the local user pro-

files you are converting. See Step 7: Create user accounts for the migrated profiles on the NMS on page

140 for more information.

8. Associate the user accounts with the master user profiles for the corresponding healthcare pro-

fessionals. See Step 8: Associate the new user accounts with the profiles you migrated in Step 6 on page 140

for more information.

9. Upgrade the master user profiles. See Step 9: Upgrade the User Profiles on page 140

10. Install the Dragon Medical Enterprise Client on the workstation. See Step 10: Install/Upgrade the

Dragon Client on the workstations on page 140

11. Log in to the Dragon Medical Enterprise Client with the NMS Server user account login and pass-

word. See Step 11: Log in on page 140

Step 1: Back up local user profiles
Before you migrate your local user profiles, you should back them up to ensure that you'll still

have them if anything goes wrong. To do this, export the local user(s) from the workstation where

DM360 Network Edition or Dragon Medical Enterprise Editionis installed to a separate directory

on the same machine or to a shared location on the network:

1. Create a temporary location for the user profiles (for example, CpyLocProfiles).

2. Map a drive to the location for the user profiles (for example, Z:\CpyLocProfiles).

3. Start DM360 Network Edition or Dragon Medical Enterprise Edition.

4. On the DragonBar, select Profile > Manage user.

5. When theManage Users dialog box appears, select the name of the user profile you want to

make a copy of and then select Advanced > Export.

6. Browse the repository where you are storing the copies of local profiles (Z:\CpyLocProfiles)

and click OK.

7. Repeat the above steps for each user profile you want to copy.

Step 2: Combine multiple Dragon Medical profiles
for a single provider (DMEE only)
Any healthcare provider who has more than one user name, has more than one user profile. If you

have any such providers, you need to reduce their profiles to a single user profile for using with

Dragon Medical 360 | Network Edition. The single profile can have more than one vocabulary and

more than one audio input device (dictation source), so it is not any more restrictive than working

with multiple profiles.

To combine the multiple profiles, take these steps:
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Export custom words from extra profiles
1. In Dragon Medical Enterprise Edition, on the DragonBar, select Dragon > Manage Users.

2. In the list of user profile names, decide which profile you want to merge the others into for the

provider. If you are not sure which profile to select, you should find out the one that the pro-

vider most recently used and keep that profile. You can click the Properties button to find out

the date each profile was last saved.

3. Open one of the profiles you do not expect to keep. You see the vocabulary it uses.

4. Select Words > Export to export all custom words created with this profile. When the Export

Words dialog box opens, browse to the directory where you want to save the file and save the

words in a .txt file. You can name it whatever you would like—usually a name containing the

user name and the vocabulary helps identify the file. For example, you might name it Con-

radCardiology.txt.

Export commands from extra profiles
1. On the DragonBar, select Tools > Command Browser and open the Task Pane.

2. In the Task Pane, click Manage (underMode). You then see a list of command types appear

in the pane to the right.

3. Select all check boxes for all command types in the pane to the right.

4. In the Task Pane, click Export (under Manage).

5. When the Export Commands dialog box opens, browse to the directory where you want to

save the file and save the custom commands as a .dat file using the same root name as you used

for the .txt file of words. For example, you might name the file ConradCardiology.dat.

Export vocabularies from extra profiles
1. If the provider has multiple vocabularies, go to the DragonBar and select Dragon > Manage

Vocabularies.... Select the vocabulary in the list and click the Export button to the right.

2. When the Save As dialog box opens, save the vocabulary in a .Top file using the same root

name as you used for the words and commands. For example, you might name it Con-

radCardiology.Top.

Import commands into the profile you are retaining
1. Open the profile you are retaining and plan to upgrade to DM360 Network Edition.

2. On the DragonBar, select Tools > Command Browser.

3. Open the Task Pane and in the Task Pane click Manage (underMode).

4. In the Task Pane, click Import (underManage).

5. In the Import Commands dialog box, select the .dat file you saved earlier and click Open.

6. In the Import Commands dialog box, click Import.

7. If any of the commands would replace a command with the same name, you are prompted to

replace the existing command. Click No if you are uncertain whether or not to replace the com-

mand. Remember, the user profile you are keeping is the newest one, so probably has the new-

est command by the same name.
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Import vocabulary into the profile you are retaining
1. If it is not already open, open the profile you are retaining and plan to upgrade to DM360 Net-

work Edition.

2. On the DragonBar, select Dragon > Manage Vocabularies... .

3. In theManage Vocabularies dialog box, click New and in the New Vocabulary dialog box,

name the vocabulary anything you would like and choose a vocabulary to base it on from the

pull down list for Based on. Then click OK.

4. When the Vocabulary Optimizer dialog box appears, click Cancel. When the

Manage Vocabularies dialog box reappears, you see the additional vocabulary in the list.

Import words into the profile you are retaining
1. If it is not already open, open the profile you are retaining and plan to upgrade to DM360 Net-

work Edition.

2. On the DragonBar, select Words > Import.

3. When the Add Words from Word Lists Wizard appears, click Next.

4. Click Add File and when the Add File dialog box opens, select the file of words you exported

earlier and click Open.

5. Click  Next to advance the wizard until you reach the end.

6. Click Finish to complete the process and close the wizard.

Step 3: Export user profiles to the default user
profile directory
Your user profiles should be in Dragon's default user profile directory—if they are, you can skip

this step. If they aren't—if you have changed the location where the profiles are stored, for exam-

ple, or you are exporting roaming user profiles—complete the following steps to export them to

the default directory:

1. Start DM360 Network Edition or Dragon Medical Enterprise Edition.

2. In Dragon (non-Network Edition), on the DragonBar, select Dragon > Manage User.

3. When theManage Users dialog box appears, select the name of the user profile you want to

make a copy of and then select Advanced > Export.

4. Browse to the default location for Dragon user profiles.

If you are running Dragon on Windows XP, this is:

C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking<VersionNumber>\Users

where <VersionNumber> is the version number of your Dragon installation.

If you are running Dragon on Windows 7, this is:

C:\Program
Data\Nuance\NaturallySpeaking<VersionNumber>\Users

where <VersionNumber> is the version number of your Dragon installation.
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5. Click OK.

6. Repeat the preceding steps for each user profile you want to copy.

The 2.x versions of DM360 Network Edition will be the last versions of the product to support

Windows XP. DM360 Network Edition 2.1 continues to support Windows XP.

Step 4: Set Up a Directory for the User Profiles via
the Nuance Management Console
Set up the directory for the migrated profiles using the NMC by entering the path to your chosen

directory in the DMNE Version 2.0 (or higher) Speech Profile Location field of the Master

User Profile Directory Settings dialog.

See Configuring the location of user profiles on page 144 for instructions.

Step 5: Copy the User Profile Export Tool to a
network location
The DM360 Network Edition client installation DVD includes a profile export tool. You must

copy the directory containing the export tool to a location on your network where you can do a

push install via .msi to all the Dragon workstations containing profiles that you want to export.

1. Open the DM360 Network Edition Client installation DVD and locate the following direc-

tory:

DNS12_DVD1/Dragon Profile Export

2. Copy the Dragon Profile Export directory to a location on the network where you can run an

.msi install to all Dragon workstations containing profiles that you want to export.

Step 6: Install and Run the User Profile Export Tool
1. Use the following command to install the User Profile Export Tool:

msiexec.exe /i DgnProfileExport.msi NETWORKLOCATION=<location> [NET-
WORKCREDENTIALS=PROMPT] /qn

Parameter Description

NETWORKLOCATION
(Required)

A path—either a UNC path or a path to a mapped drive—to
the network location of the DM360 Network EditionVersion 2.1
User Profiles.

See the Configuring the location of user profiles section of the
DM360 Network Edition Administrator's Guide for more infor-
mation.

NETWORKCREDENTIALS
(Required)

Set this value to PROMPT. This insures that if a network connection
isn't established prior to the running the User Profile Export Tool,
the tool prompts for Windows user credentials and establishes a net-
work connection before your profiles are exported.
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MSI command line example
msiexec.exe /i "DgnProfileExport.msi" NET-
WORKLOCATION=\\myserver\DragonUsers\Exported NET-
WORKCREDENTIALS=PROMPT /qn

2. Reboot the Dragon Medical Client 2.1 workstation where the tool is installed. The User Pro-

file Export Tool is invoked on reboot.

The exported profiles appear in the specified user profile directory with the following naming

convention:

username.workstation

For example, a profile with username John_Doe on the DoeWorkstation will be

named:

John_Doe.DoeWorkstation

Step 7: Create user accounts for the migrated
profiles on the NMS
Log on to the Nuance Management Console (NMC) and create user accounts in NMS Server for

the healthcare providers who dictate with the local user profiles you are migrating. For more infor-

mation on creating users, refer to Creating user accounts for healthcare providers on page 133.

Step 8: Associate the new user accounts with the
profiles you migrated in Step 6
Associate the user accounts with the master user profiles for the corresponding healthcare pro-

fessionals. For more information, see Associating new user accounts with upgraded user profiles on page

148.

Step 9: Upgrade the User Profiles
Upgrade your user profiles to the latest version by following the instructions in Upgrading a user pro-

file to DM360 Network Edition Version 2.1 on page 146.

Step 10: Install/Upgrade the Dragon Client on the
workstations
Install/Upgrade the Dragon Medical Client 2.1 on the workstation. For more information, see

Installing Dragon and documentation through the Nuance Management Console on page 156.

Step 11: Log in
Log in to the Dragon Medical Client 2.1 with the NMS  user account login and password. For

more information, see Logging in to the Nuance Management Server through the Nuance Management Con-

sole on page 97
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Upgrading User Profiles from DM360
Network Edition Version 10.x to
Version 2.0 or Higher

After you have upgraded the Nuance Management Server (NMS), you must upgrade your DM360

Network Edition Version 10.5 user profiles to DM360 Network Edition 2.1 or higher.

Before upgrading Dragon user profiles
Caution:

Nuance recommends that you plan to upgrade the Dragon Medical user profiles at a time when

healthcare providers are not using them to dictate, such as at night or on a weekend. If there is no

time when all your user profiles are not in use (because healthcare providers dictate 24/7), you

can convert sets of local user profiles from particular workstations at appropriate times.

Note:

n If you are upgrading from a version of DM360 Network Edition that is not Service Pack 3 or

higher, you must first upgrade to Service Pack 3. See the DM360 Network Edition SP 3

Installation Guide for more information.

n Nuance recommends upgrading user profiles on multi-core machines for better throughput.

Profiles upgraded on machines with a number of cores that is different than the number of

cores on the speech nodes that run the profiles generates a warning message about recognition

accuracy. For example, if you upgrade your profiles on a dual core machine but run them on a

single core speech node, the warning message appears when the profile is opened.

To prevent the warning message from appearing, use machines with the same number of cores

to upgrade speech profiles and for the speech nodes. For example, if you upgrade the profiles

on a dual core machine, run those profiles on dual core speech nodes.

Complete the following tasks before you upgrade your user profiles:

n Configure the Master User Profile directory for the DM360 Network Edition Version 2.0 (and

higher) user profiles by entering the path to your chosen directory in the DMNE Version 2.0

(or higher) Speech Profile Location field of the Master User Profile Directory Settings

dialog.

See Configuring the location of user profiles on page 144 for instructions.

n Share the Master User Profile directory and grant the Nuance service account (for instance

nmsapps) at least Modify permissions to the folder structure. This share should mirror the
same access permissions as the DM 360 | Network Edition 10.x Master Profile directory share.

n For each speech node, set the user profile directory for DMENE 2.0 and higher to the same
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location as your Master User Profile Directory.

See Configuring the location of user profiles on page 144 for instructions.

Upgrade the User Profiles
Complete the following steps to upgrade your DM360 Network Edition user profiles:

1. Log in to the Nuance Management Console.

2. Go to the site that contains the user profiles that you want to upgrade and click the DM 360

Network Edition tab. The DM360 Network Edition settings interface appears.

3. Click the + icon next toMaster user profile to expand the Master user profile options:

4. Click the Initiate Speech Profile Upgrade to DMNE Version 2.0 button. A dialog appears

asking if you want to upgrade speech profiles to DM360 Network Edition Version 2.0. Click

YES to start the upgrade.

You can monitor conversion's progress on the Profile Optimizer Status tab of the Nuance Man-

agement Console, under Utilities > Profile Optimizer > Profile Optimizer Status.

5. When the profile upgrade is complete, the NMC sends a confirmation message to the Admin-

istrator.

6. Install/Upgrade the Dragon Medical Client 2.1 on the workstation. For more information, see

Installing Dragon and documentation through the Nuance Management Console on page 156.
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7. Log in to the Dragon Medical Client 2.1 with a DM 360 Network Edition user name and pass-

wordLogging in to the Nuance Management Server through the Nuance Management Console on page 97
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Configuring the location of user
profiles

NMS 3.1 supports multiple versions of user profiles:

n Dragon Medical 360 | Network Edition 10.x

n Dragon Medical 360 | Network Edition, version 2.0 or higher

Each version has its own user profile location.

When an end user logs into Dragon through the NMS server, the NMS sends the location of the

user's profile to Dragon. This allows Dragon to find and access the user profile.

Note: In NMS 4.1, the “New User Accounts will use DMNE Version 1.0 speech profiles” option

lets you set all new user accounts to use either:

n version 10 profiles: for a site that has not yet upgraded to DM360 Network Edition, version 2.0

or higher

n version 12 profiles: for a site that has upgraded to DM360 Network Edition, version 2.0 or

higher

For details, see New User Accounts will use DMNE Version 1.0 speech profiles.

An administrator can configure these locations in the Management Console.

Setting the location of profiles for Dragon
1. In the Management Console, in Sites group, selectManage organizations & sites.

2. On the Organizations screen, double-click a site.

3. Select the DM360 Network Edition tab.

4. Expand theMaster user profile section.

5. BesideMaster user profile directories, select Configure. Perform step 6 if the site uses

DM360 Network Edition SP3 or earlier. Perform step 7 if the site uses DM360 Network Edi-

tion, version 2.1.

6. In the General tab, in the DMNE Version 1.x Speech Profile Location field, enter the loca-

tion of the Dragon Medical 360 | Network Edition 10.x user profile. This is the user profile

that Dragon uses when an end-user logs into DM360 Network Edition SP3 or earlier through

the NMS.

7. In the DMNE Version 2.0 (or higher) Speech Profile Location field, enter the location of

the Dragon Medical 360 | Network Edition, version 2.1 user profile. This is the user profile

that Dragon uses when an end-user logs into DM360 Network Edition, version 2.1 through the

NMS.

Setting the location of profiles for the Profile
Optimizer
1. In the Management Console, select Utilities.

2. Search for and double-click a speech node.
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3. On the Speech Node Collection screen, in the DMNE v1.x (UNC) field, enter the UNC

path for the Speech Node Collection for the Dragon Medical 360 | Network Edition 10.1 user

profile.

4. In the DMNE v1.x (HTTP - WebDAV), enter the http(s) path for the speech node to access

the Master User Profiles directory for the Dragon Medical 360 | Network Edition 10.1 user pro-

file only if webDAV is used. Also include webDAV credentials.

5. In the DMNE v2.0 or higher (UNC) field, enter the UNC path for the Speech Node Col-

lection for the Dragon Medical 360 | Network Edition, version 2.1 user profile.

6. In the DMNE v2.0 or higher (HTTP - WebDAV) field, enter the http(s) path for the speech

node to access the Master User Profiles directory for the Dragon Medical 360 | Network Edi-

tion, version 2.1 user profile only if webDAV is used. Also include webDAV credentials.
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Upgrading a user profile to DM360
Network Edition Version 2.1

If you are upgrading from:

n Dragon Medical Enterprise Edition Version 10.1

n Dragon Medical Practice Edition Version 11

n DM360 Network Edition Version 10.5

to DM360 Network Edition, version 2.1, you must upgrade your user profiles.

Note:

If you are upgrading from a version of DM360 Network Edition that is not Service Pack 3 or

higher, you must first upgrade to Service Pack 3. See the DM360 Network Edition SP 3 Installation

Guide for more information.

Complete the following steps to upgrade your user profiles:

Before upgrading Dragon user profiles
Notes:

n Before you upgrade them, Nuance recommends you back-up your user profiles.

n Profile upgrades can take a long time. Because of this, Nuance recommends that you plan to

upgrade the user profiles at a time when healthcare providers are not using them to dictate, such

as at night or on a weekend. If there is no time when all your user profiles are not in use

(because healthcare providers dictate 24/7), you can upgrade multiple sets of user profiles at

appropriate times.

n Export your Dragon Medical Enterprise Edition and Dragon Medical Practice Edition profiles to

the NMC, as described in the Converting local user profiles to master user profiles section of the

Dragon Medical 360 | Network Edition Installation and Upgrade Guide.

n Nuance recommends upgrading user profiles on multi-core machines for better throughput.

Profiles upgraded on machines with a number of cores that is different than the number of

cores on the speech nodes that run the profiles generates a warning message about recognition

accuracy. For example, if you upgrade your profiles on a dual core machine but run them on a

single core speech node, the warning message appears when the profile is opened.

To prevent the warning message from appearing, use machines with the same number of cores

to upgrade speech profiles and for the speech nodes. For example, if you upgrade the profiles

on a dual core machine, run those profiles on dual core speech nodes.

1. Start the Management Console and log in.

2. Go to the site that contains the user profiles that you want to upgrade and click the DM 360

Network Edition tab. The DM360 Network Edition settings interface appears.

3. Click the + icon next toMaster user profile to expand the Master user profile options:
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4. Click the Initiate Speech Profile Upgrade to DMNE Version 2.0 button. A dialog appears

asking if you want to upgrade the speech profiles. Click OK to start the upgrade.

5. When the profile upgrade is complete, the NMC sends a confirmation message to the Admin-

istrator.

6. Associate the upgraded user profiles with user accounts, as described in Associating new user

accounts with existing user profiles on page 1.
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Associating new user accounts with
upgraded user profiles

If you have not already done so, you should upgrade any user profiles from Dragon Medical Ver-

sions as described elsewhere in this chapter. Then to allow healthcare providers to dictate with

their newly upgraded user profiles, you need to:

n In the Nuance Management Console, create a Dragon Medical Enterprise user account for each

healthcare provider (refer to sections on configuring groups and user accounts in the

Nuance Management Server Administrator Guide for details).

n Associate that user account with the corresponding master user profile.

Installing the Profile Association Tool
The Profile Association tool is only needed for US customers that are upgrading from Dragon

Medical US Enterprise Edition.

1. If you are running the user profile association tool for the first time, the Nuance Management

Console displays a dialog box that asks if you want to install the tool. Click Yes.

2. On the Profile Association Tool - InstallShield Wizard, click Next.

3. Click Install.

4. When you see the InstallShield Wizard Complete screen, click Finish.

Associating user accounts with upgraded Dragon
roaming user profiles
In Dragon Medical 360 | Network Edition, 2.1, the profile association tool is available as a sep-

arate tool from the Nuance Management Console. You can still access the tool from the Nuance

Management Console but it is installed and run locally.

The main functionality of the profile association tool has not changed.

However, there are some new features:

• The tool prompts you for the address of the server with the users you want to associate to pro-

files. The server can be an on-premise NMS server or a Cloud-based NMS server.

• You must provide your login credentials to connect to the server.

• The tool only displays the users that are part of your organization.

• The tool only displays information about: users that are a member of a group with the “Dragon

Author” role, and that have a Physician Author or Non-Physician Author license.

To run the user profile association tool, you must have the Dragon – Able to run DM360 Net-

work Edition tools rights.

1. Start the Nuance Management Console and log in.

2. On the menu bar, click Utilities> Tools.

3. Click Launch user profile association tool.
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4. Fill out the fields in the following dialog box:

l Login: The login id for the server with the users you will associate to profiles.

l Password: The password for the server with the users you will associate to profiles.

l Server: The address of the server that contains the users you will associate to profiles.

5. Click OK. The DM360 Network Edition - Profile Association Tool screen appears.

6. If you do not see the names or profiles you are looking for in the Users or Profiles lists, click

the Scan now button and wait for the lists to update.

7. Click the login for the user account in the Users list, then click the corresponding user profile

in the Profiles list, and click the Associate button to tie the profile to the user account. The

user account and the associated user profile appear in the Associations list in the lower portion

of the screen.

8. Repeat the above steps until you have associated all provider user accounts with profiles.

9. To undo the association, you can select a user account in the Associations list and click the

Remove Association button; the user account and profile return to the lists above, and you

can try again.

10. Click Finish and Save All Associations.

1. Repeat the above steps until all healthcare provider user accounts have been associated with

their profiles.

2. If you make a mistake, you can select a user account in the Associations list and click the

Remove button. The user account and user profile return to the two lists above and you can

associate them with a different user account or user profile.
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3. Click Finish to save changes you made in the User Profile Association tool.

4. To exit the tool without saving your changes, click Close without clicking Finish first.
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Overview of installing the Dragon
Medical Client

Caution:

The account that each Dragon Medical Client 2.1 workstation runs under must have full

read/write/modify access to the master user profiles directory so that Dragon can create and mod-

ify the master user profile for each healthcare provider.

When you install the client, you usually perform a typical Dragon installation.

However, if you want to set up Dragon so that the DragonBar always comes up in, for instance,

Floating mode on every single client workstation in your network, you can still set some options

in advance of the installation by using the Dragon Medical SDK Client, available on the Nuance Man-

agement Server Software and Documentation DVD. After you set the options, you can retrieve the nsde-

faults.ini file and pass it as an argument tomsiexec.exe (the MSI installer from Microsoft) on

the command line by following the instructions inMSI Installation of multiple clients with the same

default options on page 181.

Opening ports to access user profiles on web
server or secure web server
Caution:

It is critical that if they are not already open, you open the ports required for the Dragon Medical

Client 2.1 to access the master user profiles on a web server or secure web serve

To allow the Dragon Medical Client 2.1 to access master user profiles on a web server (http) that is

not SSL, open port 80.

To allow the Dragon Medical Client 2.1 to access master user profiles on a secure (SSL) server

(https), open port 443.

Approaches to installing the Dragon Medical Client
You can install the Dragon Medical Client 2.1 in any of these ways:

n Installing Dragon and documentation through the Nuance Management Console on page 156

n Installing Dragon manually outside of the Nuance Management Console on page 160

n Pushing the Dragon MSI installation to workstations on page 165

l Carrying out administrative installation of Dragon with .bat file on page 1

l Creating a custom installer for the client in Active Directory on page 174

n MSI Installation of multiple clients with the same default options on page 181
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Pushing the Dragon MSI installation
to workstations

An overview of the options for installing multiple Dragon Medical Client 2.1 workstations at once is

provided below.

The Dragon Medical 360 | Network Edition DVD includes a Microsoft Windows Installer (MSI)

file. You can use this MSI file to install Dragon from a server to client workstations across a net-

work or to install several client workstations at once using either an SMS or SCCM installation or

an ActiveDirectory Services installation.

Caution:Whenever you carry out an MSI installation of DM360 Network Edition, Nuance rec-

ommends that you uninstall any Dragon Medical software already on the machine before it proceeds

to install the new client software. You can do this via the MSI installer using the /x<Product.msi>

command, where <Product.msi> is the name of the .msi file of the version of DM360 Network Edi-

tion that you are uninstalling. For more information on command line options you can use to

install Dragon, refer to Understanding Dragon MSI command line options on page 168.

Note:

When you create an MSI installer for the Dragon Medical Client 2.1 included with the NMS Server,

you are not required to have the installer set any user or administrative options that you would

prefer to set in the Nuance Management Server later. However, if you would like to set the same

Dragon options on all workstations, you can pre-set them as outlined inMSI Installation of multiple

clients with the same default options on page 181.

DVD name MSI file name

Dragon Medical Enterprise Network Edition Client
Software DVD

Dragon NaturallySpeaking 12.msi

Nuance Management Server Software
and Documentation DVD

Dragon SDK Client Edition 12.msi
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The command line you use to install Dragon using the .MSI file is:

msiexec.exe /i "Dragon NaturallySpeaking 12.msi"

n General options for installing Dragon

n MSI options for installing Dragon features/advanced options

n Feature variables to set through the ADDLOCAL or ADVERTISE properties

Options for pushing MSI installation of Dragon to
one or more workstations on a network
You can use a server application to push an MSI installation of Dragon to client workstations with-

out having to install Dragon separately on each computer. The server administrator creates an

image of the Dragon installation program. The administrator then places the image on a server and

configures the server to automatically push the application to client workstations.

There are several server applications that you can use to push a Dragon installation. See

System Requirements for Dragon Medical 360 | Network Edition on page 7 for supported versions:

n Windows Server

n System Center Configuration Manager (SCCM)

n Active Directory Services

Support for the Windows System Center
Configuration Manager
You can use the System Center Configuration Manager (SCCM) to push an MSI installation of

Dragon Medical Client 2.1 across a network to multiple client workstations at once. SCCM provides

a mechanism for pushing the Dragon Medical Client 2.1 installation from a server to several client

workstations, using a Windows Installer (MSI) file to push the installation to workstations that

run a compatible Windows operating system. See System Requirements for Dragon Medical 360 | Net-

work Edition on page 7 for supported operating systems.

For information about Windows Installer technology, you can download the article Software Dis-

tribution in Configuration Manager, available at this link: http://technet.microsoft.com/en-us/li-

brary/bb632640.aspx

Support for the Windows System Management
Server
You can use the System Management Server (SMS) to push an MSI installation of Dragon Medical

Client 2.1 across a network to multiple client workstations at once. SMS provides a mechanisms

for pushing the Dragon Medical Client 2.1 installation from a server to several client workstations,

using a Windows Installer (MSI) file to push the installation to workstations that run a compatible

Windows operating system. See System Requirements for Dragon Medical 360 | Network Edition on

page 7
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For information about Windows Installer technology, you can download the article Scenarios and

Procedures for Systems Management Server 2003: Planning and Deployment available at this link:

http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-

9BC180713F7E&displaylang=en.

Support for Windows Server with Active Directory
Services
You can use Windows Active Directory Service to push an MSI installation of Dragon across a net-

work to multiple client workstations at once.

Active Directory Services is a feature of Windows Server. The Group Policy component of

Active Directory Services includes a Software Installation snap-in that lets an administrator create

a network installation. Administrators can use this feature to install Dragon Medical Client 2.1 to

workstation computers that run Windows XP or Windows Vista.

Dragon supports the Active Directory Services Assign to Computers installation option. This

option requires that you reboot the computer to complete a Dragon Medical Client 2.1 installation.

You can delay the installation of Dragon Medical Client 2.1 on a workstation that runs Windows XP

or Vista by enabling logon optimization for group policy. You can view a log entry for this type of

installation in the event log after the client computer reboots for the first time. The Dragon instal-

lation application then installs Dragon and reboots the computer for a second time. The installation

is a silent installation and does not display a GUI.

1. If necessary, create a custom MSI installation of Dragon Medical Client 2.1 to push to several

client workstations.

2. Verify that each computer meets the system requirements for Dragon Medical Client 2.1 instal-

lation. See System Requirements for Dragon Medical 360 | Network Edition on page 7 for more infor-

mation.

3. Push the custom MSI installation of Dragon to the client workstations.
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Installing Dragon and documentation
through the Nuance Management
Console

After you create your own MSI installer for Dragon Medical Client 2.1 and place that file on the

NMS Server, from any workstation on the network where you have installed the appropriate cer-

tificates, you can access the Nuance Management Console, then download the Dragon Medical Client 2.1

MSI installer through the console for installation on that workstation:

1. Be sure that the computer you are installing the Dragon client on meets the system requirements

for installing and running Dragon. See System Requirements for Dragon Medical 360 | Network Edition

on page 7.

2. Log in to the computer as a Windows administrator.

3. On the workstation where you are installing Dragon, be sure that you install the Nuance cer-

tificates (see Installing Nuance software certificates on page 94).

4. On the workstation where you are installing Dragon, open Internet Explorer and enter the

URL to access the Nuance Management Console (see Logging in to the Nuance Management Server

through the Nuance Management Console on page 97).

5. Once the client GUI displays its login dialog box, log in.

Setting the location and version of the Dragon
MSI installer
If this is the first time you have attempted to download the Dragon MSI installer from the

NMS Server, you must enter the location of the installer on the NMS server:

1. In the Nuance Management Console, click Organization Overview.

2. In the Organizations section of the ribbon, click Details.

3. On the Products tab, expand the DM360 Network Edition section.

4. In the Deployed Version field, select the version of the Dragon client that your organization is

using. The NMS downloads items that are specific to the version of the Dragon client that you

specify in the Deployed Version field.

5. In the Downloads section, underDownload locally, in Client installation URL, enter the

path to where the .msi installation file for the Dragon Medical Client is located on the NMS

Server. The NMS maps the Install DM360 Network Edition icon to location.

6. Click OK

1. In the Nuance Management Console, click the Nuance icon

and a menu drops down.

2. Select System settings from the menu.

3. In the System Settings dialog box, expand DM360 Network Edition.
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4. Set the Client installation URL to the full path to the location where you placed your custom

Dragon MSI installer, a file with an .msi extension, on the NMS Server machine. You need only

set this path the first time you are downloading the installation files through the Nuance Man-

agement Console.

5. Click Save to save the change and exit the System Settings dialog box.

Setting the local download location for
documentation
1. In the Nuance Management Console, click Organization Overview.

2. In the Organizations section of the ribbon, click Details.

3. On the Products tab, expand the DM360 Network Edition section.

4. In the Downloads section, underDownload locally, perform the following steps:

5. In the Admin manual URL field, enter the path where the Nuance Management Server Admin-

istrator Guide PDF file is located on the NMS Server. The default path to the guide is IIS-

ROOT\NMC\links.

6. In the Client user guide URL field, enter the path to where the Dragon Medical User Guide

PDF file is located on the NMS Server.

7. Click OK.

Downloading the Dragon MSI installer and
documentation to a workstation
After you have set the location of the Dragon MSI installer, you are ready to download the Dragon

MSI installer and documentation to a workstation:

1. In the Nuance Management Console, click the Utilities tab.

2. Click the DM360 Network Edition Install icon. The DM360 Network Edition Instal-

lations tab appears.
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3. To download the Dragon MSI installer to a workstation, check DM360 Network Edition

client installation.

4. To download the NMS Administrator guide to a workstation, check the DM360 Network Edi-

tion Install.

5. To download the Dragon user guide to a workstation, check DM360 Network Edition user

guide.

6. Beside the Download to text box, click on the magnifying glass and browse to the location

where you want the files downloaded.

7. Click the Download button. The NMS server immediately downloads the items you checked

to the workstation.

8. Proceed to the directory on the workstation where you downloaded the Dragon .msi instal-

lation file.

9. Double click on the .msi file to launch the Dragon client installation.

10. For details on proceeding through the Dragon Medical Client installation wizard, refer to the

DM360 Network Edition Installation Guide.

1. In the Nuance Management Console, click the Utilities tab.

2. Click the DM360 Network Edition Install icon.
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3. Click the checkboxes for the Client installation URL link and for any manuals you'd like to

install on the client.

4. Click on the magnifying glass in the Download to text box, browse to the path where you want

the files downloaded, and click the Download button. The server immediately downloads the

software to the workstation.

5. Proceed to the directory on the workstation where you downloaded the .msi installation

file.Installing Dragon manually outside of the Nuance Management Console on page 160

6. For details on proceeding through the Dragon Medical Client installation wizard, refer to Install-

ing Dragon manually outside of the Nuance Management Console on page 160.
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Installing Dragon manually outside of
the Nuance Management Console

Be sure your computer meets the system requirements for installing and running Dragon Medical.

For additional steps you might need to take if you are upgrading, see Preparing to upgrade non-network

edition Dragon Medical Clients on page 130.

1. Insert the installation DVD into the DVD drive of the computer. If the installation does not

start on its own, browse on the DVD for the setup.exe file and double click it.

2. If you are installing the client on Windows XP and have SP2 but not SP3, you can still install

Dragon Medical if you execute setup.exe from the command line using some options outlined in

Installing Dragon Medical Client using pre-defined options in nsdefaults.ini.

3. The InstallShield window might display and ask you to install software that Dragon Medical

requires on the computer. The software might include Microsoft .NET Framework .

4. If a message displays asking you to restart your computer, restart the workstation and follow the

instructions.

5. On the Welcome screen, click Next:

6. On the License Agreement screen, read the license agreement information. Select I accept

the terms in the license agreement and click Next.
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7. On the Customer Information screen, type your name, the name of your organization and

the serial number from Nuance, then click Next.

8. On the Setup Type screen, select Typical/Complete. Click Next.
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9. On the Ready to Install the Program page, click Install. The installation process begins to

copy files to your computer.

10. When the wizard displays the InstallShield Wizard Completed screen, click Finish.

Now, proceed to Associating Dragon with the Nuance Management Server to associate the Dragon client

with the NMS Server.

The 2.x versions of DM360 Network Edition will be the last versions of the product to support Windows

XP. DM360 Network Edition 2.1 continues to support Windows XP.
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Associating Dragon with the Nuance
Management Server or Call Forwarder

After you have completed installation of the Dragon Medical Client 2.1 on one or more work-

stations, you must be sure to open all required ports and then let the client know the name of the

particularNMS Server to communicate with.

Associating Dragon with an NMS Server or Call
Forwarder
Once the appropriate ports are open, when a healthcare provider logs in to the client, that pro-

vider indicates the particular machine where the server is running:

1. When the healthcare provider logs in to the Dragon Medical Client 2.1, first the splash screen dis-

plays.

2. When the Dragon Login dialog box appears, the provider should click the Options button:

3. When the Options dialog box appears, the provider must then enter the name of the machine

that houses the Nuance Management Server or Call Forwarder:

For information on using the check boxes in this dialog box, refer to the Dragon Medical Client

Help. If you have a network traffic switch managing multiple NMS Servers, see Ensuring clients

can contact an NMS Server with a load balancing traffic switch in the network at the end of this section for

more information on what to enter for the address.

4. The provider then logs in using the user account that anNMS Administrator has created in

the Nuance Management Server.
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5. If this is the very first time the provider has ever logged in to the Dragon Medical Client 2.1 (the

user has no previously existing profile of his or her voice), the New User Wizard appears. The

New User Wizard does not appear if the provider has a user profile you upgraded from an ear-

lier version of Dragon Medical.

6. The provider should click the check box indicating I have read and agree to the

License Agreement and proceed through the New User Wizard as instructed.

7. When the provider finishes completing every page of the wizard, the DragonBar then becomes

available, and the provider can begin dictating.

Ensuring clients can contact an NMS Server with
a load balancing traffic switch in the network
When you install clients using a push installation, if you have a load balancing traffic switch man-

aging multiple NMS Servers on your network, you should set NAS_ADDRESS to the address of

the traffic switch, rather than the address of any particularNMS Server.

Note: If the user already entered a value for this option, your value will overwrite that.

When providers first log in to Dragon Medical Client 2.1, when they click the Advanced button,

instead of entering the IP address or name of an NMS Server, they should enter the IP address or

name of the traffic switch appliance in the Address text box of the Server Location dialog

box.

If your workstations have desktop shortcuts for Dragon Medical Client, those shortcuts should also

point to the traffic switch's address, rather than the address of any particularNMS Server.

For more information on using the Dragon Medical Client 2.1, refer to the Dragon Help.
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Pushing the Dragon MSI installation
to workstations

An overview of the options for installing multiple Dragon Medical Client 2.1 workstations at once is

provided below.

The Dragon Medical 360 | Network Edition DVD includes a Microsoft Windows Installer (MSI)

file. You can use this MSI file to install Dragon from a server to client workstations across a net-

work or to install several client workstations at once using either an SMS or SCCM installation or

an ActiveDirectory Services installation.

Caution:Whenever you carry out an MSI installation of DM360 Network Edition, Nuance rec-

ommends that you uninstall any Dragon Medical software already on the machine before it proceeds

to install the new client software. You can do this via the MSI installer using the /x<Product.msi>

command, where <Product.msi> is the name of the .msi file of the version of DM360 Network Edi-

tion that you are uninstalling. For more information on command line options you can use to

install Dragon, refer to Understanding Dragon MSI command line options on page 168.

Note:

When you create an MSI installer for the Dragon Medical Client 2.1 included with the NMS Server,

you are not required to have the installer set any user or administrative options that you would

prefer to set in the Nuance Management Server later. However, if you would like to set the same

Dragon options on all workstations, you can pre-set them as outlined inMSI Installation of multiple

clients with the same default options on page 181.

DVD name MSI file name

Dragon Medical Enterprise Network Edition Client
Software DVD

Dragon NaturallySpeaking 12.msi

Nuance Management Server Software
and Documentation DVD

Dragon SDK Client Edition 12.msi
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The command line you use to install Dragon using the .MSI file is:

msiexec.exe /i "Dragon NaturallySpeaking 12.msi"

n General options for installing Dragon

n MSI options for installing Dragon features/advanced options

n Feature variables to set through the ADDLOCAL or ADVERTISE properties

Options for pushing MSI installation of Dragon to
one or more workstations on a network
You can use a server application to push an MSI installation of Dragon to client workstations with-

out having to install Dragon separately on each computer. The server administrator creates an

image of the Dragon installation program. The administrator then places the image on a server and

configures the server to automatically push the application to client workstations.

There are several server applications that you can use to push a Dragon installation. See

System Requirements for Dragon Medical 360 | Network Edition on page 7 for supported versions:

n Windows Server

n System Center Configuration Manager (SCCM)

n Active Directory Services

Support for the Windows System Center
Configuration Manager
You can use the System Center Configuration Manager (SCCM) to push an MSI installation of

Dragon Medical Client 2.1 across a network to multiple client workstations at once. SCCM provides

a mechanism for pushing the Dragon Medical Client 2.1 installation from a server to several client

workstations, using a Windows Installer (MSI) file to push the installation to workstations that

run a compatible Windows operating system. See System Requirements for Dragon Medical 360 | Net-

work Edition on page 7 for supported operating systems.

For information about Windows Installer technology, you can download the article Software Dis-

tribution in Configuration Manager, available at this link: http://technet.microsoft.com/en-us/li-

brary/bb632640.aspx

Support for the Windows System Management
Server
You can use the System Management Server (SMS) to push an MSI installation of Dragon Medical

Client 2.1 across a network to multiple client workstations at once. SMS provides a mechanisms

for pushing the Dragon Medical Client 2.1 installation from a server to several client workstations,

using a Windows Installer (MSI) file to push the installation to workstations that run a compatible

Windows operating system. See System Requirements for Dragon Medical 360 | Network Edition on

page 7
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For information about Windows Installer technology, you can download the article Scenarios and

Procedures for Systems Management Server 2003: Planning and Deployment available at this link:

http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-

9BC180713F7E&displaylang=en.

Support for Windows Server with Active Directory
Services
You can use Windows Active Directory Service to push an MSI installation of Dragon across a net-

work to multiple client workstations at once.

Active Directory Services is a feature of Windows Server. The Group Policy component of

Active Directory Services includes a Software Installation snap-in that lets an administrator create

a network installation. Administrators can use this feature to install Dragon Medical Client 2.1 to

workstation computers that run Windows XP or Windows Vista.

Dragon supports the Active Directory Services Assign to Computers installation option. This

option requires that you reboot the computer to complete a Dragon Medical Client 2.1 installation.

You can delay the installation of Dragon Medical Client 2.1 on a workstation that runs Windows XP

or Vista by enabling logon optimization for group policy. You can view a log entry for this type of

installation in the event log after the client computer reboots for the first time. The Dragon instal-

lation application then installs Dragon and reboots the computer for a second time. The installation

is a silent installation and does not display a GUI.

1. If necessary, create a custom MSI installation of Dragon Medical Client 2.1 to push to several

client workstations.

2. Verify that each computer meets the system requirements for Dragon Medical Client 2.1 instal-

lation. See System Requirements for Dragon Medical 360 | Network Edition on page 7 for more infor-

mation.

3. Push the custom MSI installation of Dragon to the client workstations.
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Understanding Dragon MSI command
line options

Modifying the admininstall.bat file
To make changes to the admininstall.bat file, you can use any of the following options.

Note: Be sure that the values that you pass in to the MSI are valid. Entering an invalid value can

cause the installer to crash.
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General options for installing Dragon

Options Description

SERIALNUMBER=abcde-
fgh-ijkl-mnop-qr

The serial number for the Dragon product. AllDragon installations require
that you provide a serial (license) number for the product. The Dragon
installation process checks for a serial number even if you run the process
from a command line.

NAS_ADDRESS="DNS|
<IP_address>"

Indicates the IP address of the NMS Server that the Dragon Medical Client
2.1 connects to when the healthcare provider logs on. If you set this option
during the installation, then the provider does not need to enter the server
machine name when logging in toDragon Medical Client 2.1 for the first
time. If you do not set this option during the installation, each provider
should click the Advanced button when logging in to the client for the first
time and enter either the IP address or the machine name (with no prefix
for instance, nowww or http://) in the Server Location text box.

If your network has multiple NMS Servers beingmanaged by a load bal-
ancing traffic switch in the network, you should set this option to the
address of the switch rather than the address of any particular NMS Server.

Note:If you define this option when installing an upgrade toDragon Med-
ical 360 | Network Edition, version 2.1, you will overwrite any value the
user already entered.

NAS_LDAP_SIGN_ON=0
(or 1 or 2)

Note: Before you enable LDAP, you must make additional configuration
changes in order for the feature to work. See the "Nuance Management
Server Administrator Guide" Configuring LDAP section for more infor-
mation.

Set the option to 0 to disable LDAP login.

Set the option to 1 to enable LDAP login for a single domain LDAP. In this
case, Dragon retrieves the domain name from the user's workstation.

Set the option to 2 to enable LDAP login for multiple domains. In this case,
the user must supply credentials in the "domain name\user name" format.

The default value is 0.

Be sure that the value you set here is the same as the type of LDAP that is
enabled in the Nuance Management Server. See the "Nuance Man-
agement Server Administrator Guide" Configuring LDAP section for more
information.

Note:If you define this option when installing an upgrade toDragon Med-
ical 360 | Network Edition, version 2.1, you will overwrite any value the
user already entered.

NAS_SINGLE_SIGN_
ON=0 (or 1)

Note: Before you enable EHR single sign on, you must make additional con-
figuration changes in order for the feature to work. See the "Nuance Man-
agement Server Administrator Guide" Implementing EHR Single Sign-On
section for more information.

Set the option to 0 to disable single sign on from an EHR.

Set the option to 1 to enable single sign on from an EHR.

The default value is 0.

Be sure that the value you set here —enabled or disabled—that is set in the
Nuance Management Console. See the "Nuance Management Server
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Administrator Guide" Implementing EHR Single Sign-On section for more
information.

Note:If you define this option when installing an upgrade toDragon Med-
ical 360 | Network Edition, version 2.1, you will overwrite any value the
user already entered.
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MSI options for installing Dragon features/advanced options

Options Description

ADDLOCAL=Feature1,Feature2,... or ADD-
LOCAL=ALL

Set the ADDLOCAL option to a comma delimited list of fea-
tures to install locally. To install all features locally (including
speech files), set the ADDLOCAL option toALL.

See General Options for Installing Dragon for a list of the fea-
tures that you can make available or install locally using the
ADDLOCAL option or the ADVERTISE option.

ADVERTISE=Feature1,Feature2,Feature3,... Set the ADVERTISE option to a comma delimited list of fea-
tures to make available but not install locally. To install all fea-
tures as advertised, set the ADVERTISE option toALL.

The ADVERTISE option overrides the ADDLOCAL option. The
best method for installing a particular set of features is to set
the ADDLOCAL option toALL and then set the ADVERTISE
option to the features you do not want to install locally.

See General Options for Installing Dragon for a list of the fea-
tures that you can make available or install locally using the
ADDLOCAL option or the ADVERTISE option.

REINSTALL=Feature1,Feature2,... (or ALL) Set the REINSTALL option to a comma delimited list of fea-
tures to reinstall. To reinstall all features, set the REINSTALL
option toALL.

If you set the REINSTALL option, you should also set the
REINSTALLMODE option to set the type of reinstall to per-
form. If you do not set the REINSTALLMODE option, the
installation process only reinstalls a file if it is an earlier ver-
sion of the file that is presently installed or if the a file is not
present on the system. By default, no registry entries are
rewritten.

Even if you set the REINSTALL option toALL, the instal-
lation process only reinstalls features that are already
installed. Thus, if you use the REINSTALL option for a prod-
uct that is not yet to installed, product installation does not
occur.

For more information, see: http://msdn.microsoft.com/en-
us/library/windows/desktop/aa371175

REINSTALLMODE={type of reinstallation to
perform}

Set the REINSTALLMODE option to a string that indicates
the type of reinstall to perform. Options are case-insensitive
and order-independent.

You should use this option when you use the REINSTALL
option. You can also use this option during an installation of
Dragon Medical Client 2.1, not just during a reinstallation.

Opt Purpose

p Only reinstall a file if the file is missing.

o Only reinstall a file if the file is missing or is an
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older version.older version.older version.

e Only reinstall a file if the file is missing or is an
equal or older version.

d Only reinstall a file if the file is missing or a dif-
ferent version is present.

c Only reinstall a file or files whose checksums are
missing or corrupt.

a Force a reinstall of all files, regardless of checksum
or version.

u Rewrite all required registry entries from the Reg-
istry Table that go under HKEY_CURRENT_USER
or HKEY_USERS.

m Rewrite all required registry entries from the Reg-
istry Table that go under HKEY_LOCAL_MACHINE
or HKEY_CLASSES_ROOT. Regardless of machine
or user assignment.

Rewrite all data from the following tables: Class,
Verb, PublishComponent, ProgID, MIME, Icon,
Extension, and AppID .

Reinstall all qualified components. When rein-
stalling an application, run the Reg-
isterTypeLibraries and InstallODBC actions.

s Reinstall all shortcuts and re-cache all icons, over-
writing existing shortcuts and icons.

v Run from the source package, re-cache the local
package. Does not apply to a new installation of a
product or feature.

REMOVEOLDPROD=1 Set the REMOVEOLDPROD option to remove an older version
of Dragon before installing the newer version. You should on
only use this option for major upgrades.

/x<Product.msi|ProductCode> Set the installation process to uninstall the current installed
version of Dragon. You must perform this action during an
upgrade. However, you should be familiar with the entire
upgrade procedure before you use this option.
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Feature variables to set through the ADDLOCAL or
ADVERTISE properties

Feature/Sub-feature Sub-feature

NatSpeak
Note: Required in ADDLOCAL;
if not included, installation fails

None

Samples (Sample Com-
mands files)

None

TTS (Text-to-Speech) TTSENU (US English Text-to-Speech)
TTSENG (British English Text-to-Speech)

Tutorial TutENX (English Tutorial)

Speech ENX (English)
/ENU (US English)

Dragon NaturallySpeaking
and Dragon Medical:Sub-fea-
tures for ENU (US English): 
ENULegal (US English Legal
Large)
ENUGeneral (US English General
Medium, US English Empty Dic-
tation, US English Commands
Only)
ENUGenSvc (US English Large
General)

Note: The ENU sub-feature includes
support for the following accents:

General: Use if your accent is not
covered by the another choice or
you are not sure which to select.

Australian accented English

British accented English

Indian accented English

Inland Northern US (Great Lakes
area): Covers Upstate New York
through the Chicago area.

SEAsian accented English: South
East Asian

Southern US: Covers most of the
Southern United States, including
Texas.

Spanish Accented English

Speech ENX (English)
/ENU (US English)
(continued)

Dragon Medical Only Sub-fea-
tures for ENU
(US English):
ENUCardiology
(US English Medical Large Car-
diology, Pediatric Cardiology)
ENUEmergency (US English
Emergency Medicine Large)
ENUGastroenterology (US Eng-
lish Medical Large Gas-
troenterology, Pediatric
Gastroenterology)
ENUGeneralPractice (US English
Large Family Medicine, Allergy
and Immunology, Dermatology,
Epidemiology, Geriatric, Hema-
tology, Infectious Disease, Inter-

ENUObGyn (US English Medical
Large ENT, Fetal Medicine, Mid-
wifery, Obstetrics and Gynecology,
Ophthalmology)
ENUOncology (US English Medical
Large Oncology, Radiation Therapy)
ENUOrthopaedic (US English Medical
Large Dentistry, Large Hand Sur-
gery, Neurosurgery, Orthopaedics,
Oral and Facial Surgery, Orthopaedic
Surgery, Plastic Surgery, Podiatry)
ENUPathology (US English Medical
Large Pathology)
ENUPediatrics (US English Medical
Large Pediatrics, Neonatal and Peri-
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nal Medicine, Medical Education
andWriting,
Nephrology, Nursing, Oste-
opathy, Pulmonary Disease, Rheu-
matology, Sleep Lab)
ENUMedical (US English General
Medical Large No Specialty)
ENUMentalHealth (US English
Large Medical Addiction Psy-
chiatry; Endocrinology, Diabetes,
andMetabolism; Psychiatry, Psy-
chology)
ENGNeurology (US English Anes-
thesiology, Neurology, Pain Med-
icine, Physical Medicine and
Rehabilitation, Vascular and Inter-
ventional Radiology)

natal Medicine, Pediatric Dentistry)
ENURadiology (US English Medical
Large Nuclear Medicine or
Radiology)
ENURehabilitation (Neurology, Phys-
ical Medicine, Rehabilitation and
Speech and Language Pathology)
ENUSurgery (US English Medical
Large Cardiac Surgery, Colon and
Rectal Surgery, Surgery, Thoracic
Surgery, Urology, Vascular Surgery)

Creating a custom installer for the
client in Active Directory

If you are installing Dragon on a network using Active Directory Services, you can create a cus-

tom installation program using a set of tools available from Microsoft.

n Download and install the tools

n Run the wizard

You are then ready to use the custom installer to install the Dragon Medical Client 2.1 from Active

Directory Services.

Installing the Microsoft Custom Installation Wizard
The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To

install the Custom Installation Wizard:

1. Download the Office Resource Kit Tools (OrkTools.exe) from: http://ww-

w.microsoft.com/office/orkarchive/xpddl.htm. The OrkTools.exe self-extracting executable

(EXE) file installs the core Office XP Resource Kit tools on your computer through a single

Setup program.

2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or

select Start > Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit

Tools.

After you install the tool, you use its Custom Installation Wizard to create your custom instal-

lation. For details on using the wizard, continue with the next subsection.

Modifying setup Properties for Custom Installation
The following explains how to modify setup properties for a custom installation of Dragon Medical

Client 2.1. This example shows how to add to the installer configuration one of the many MSI
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options you can set for installing Dragon Medical Client 2.1, the SERIALNUMBER property. (You

can add any options available to MSI on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs > Microsoft

Office Tools > Microsoft Office XP Resource Kit Tools, and then click Custom Instal-

lation Wizard. The Custom Installation Wizard screen displays:

2. Click Next.

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you want to

use to create a custom installation. The compiled .MSI file is located on your installation CD.

The file you should select is named Dragon Medical: Dragon NaturallySpeaking 12.msi.

4. Click Next.
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5. Click Yes when you see the following message:

6. On the Open the MST File page of the wizard, select Create a new MST file.

7. Click Next to continue.

8. On the Select MST File to Save page of the wizard, select a file name and path for the MST

file you are creating:

9. Click Next.

176



Chapter 7: Installing the Dragon Medical Client

10. On the Specify a Default Path and Organization page, select the default path for the instal-

lation. By default, Dragon Medical Client 2.1 installs in \Program Files\
Nuance\NaturallySpeaking12.

11. Click Next.

12. On the Remove Previous Versions page, keep the default selections and click Next. This

page applies only to Microsoft Office and does not affect the Dragon Medical Client 2.1 instal-

lation.

13. Click Next to keep all the defaults when you come to the Set Features Installation States

page, where you select particular components to install. The illustration here shows some of the

Medical vocabularies you might choose:

14. On the next several pages of the wizard, click Next on each, and proceed until you reach the

Modify Setup Properties page. All the pages in between apply only to Microsoft Office or do

not affect the Dragon Medical Client 2.1 installation.

Customize Default Application Settings page

Change Office User Settings page

Add/Remove Files page

Add/Remove Registry Entries page
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Add, Modify, or Remove Shortcuts page

Identify Additional Servers page

Specify Office Security Settings page

Add Installations and Run Programs page
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15. Use theModify Setup Properties page, shown below, to add, modify, and set the MSI options

of your custom installation.

16. Click the Add... button to display the Add/Modify Property Value dialog box, where you

modify the MSI installation options. In this example, we add and set the SERIALNUMBER

option.

17. In the following Add/Modify Property Value page, enter the new property name SERI-

ALNUMBER and a valid serial number, then click OK:
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18. Note that theModify Setup Properties page re-displays with the updated information. For

example:

19. Continue adding or modifying other MSI options that apply for your environment. Once you are

done, click Next.

20. On the Save Changes page, click Finish.

21. When the Custom Installation Wizard page appears, click Exit. This screen displays the loca-

tion ofWindows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a

Group Policy in Active Directory Services.

You are now ready to use the custom installer you created to install the product.
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MSI Installation of multiple clients
with the same default options

If would like to set the same default options for a several Dragon Medical Client 2.1 workstations,

you can pre-configure them using a natspeak option of the Dragon Medical SDK Client on the com-

mand line and then apply those settings by passing the .ini file the SDK creates to the MSI

installer on the command line.

You must take the actions outlined in the subsections that follow on a machine where you have

installed the Dragon Medical SDK Client. (It is required on every Profile Optimizer Speech Node.) If you

have not yet installed the SDK, refer to Installing Profile Optimizer Server prerequisite software on page

71

Setting Dragon options on the command line before
installing Dragon
After you install the Dragon Medical SDK Client on any Profile Optimizer Speech Node machine, you

can take advantage of a natspeak command line option available only in the SDK.

You use the Dragon Medical SDK Client natspeak command to pre-configure default settings for

one workstations, then later have those defaults automatically apply to multiple Dragon Medical

Clients you install using an MSI installation. When you use the natspeak command, you no longer

have to set these options on each individual Dragon Medical Client 2.1 workstation.

On any Profile Optimizer speech Node machine, take the following steps to set the options you want

to pre-set on multiple Dragon Medical Clients through an MSI installation:

1. Open a command prompt and locate the following directory, where <VersionNumber> is

the version number of the current version of the Dragon SDK client:

<drive>:\Program Files\Nuance\Dragon SDK Client Edi-
tion<VersionNumber>\Program

2. Enter the command line shown below, passing /SetDefaultOptions:

natspeak.exe /SetDefaultOptions

3. In a moment, the Options dialog box appears.

Here you set the options you'd like each client workstation to use.

You set the options under the several tabs you see. For instance, the next illustration shows the

View tab with displayMode for Dragon set to Floating and the Results Box set to anchor

itself to the application and hide after 5 seconds.
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4. For more information on setting the options in the tabs of the Options dialog box, refer to the

Dragon Medical Client Help.

5. When you have finished setting all of the options the way you want them, click OK to close the

dialog box. Dragon has saved the configuration you created with the natspeak.exe command in

the nsdefaults.ini file. You can find nsdefaults.ini in the following locations:

Windows XP:
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking12\

Newer versions of Windows:

C:\ProgramData\Nuance\NaturallySpeaking12\

6. Retrieve the nsdefaults.ini file and copy it to a directory where all workstations you plan to

install the Dragon Medical Client 2.1 on can access it.
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Installing Dragon Medical Client using pre-defined
options in nsdefaults.ini
You use the nsdefaults.ini file you created earlier in an MSI installation of Dragon Medical Client:

1. Go to the machine you plan to carry out the MSI installation from and copy the files from the

DVD to a location on your network that you can access all client workstations from.

2. Open a command prompt and switch to the directory on your machine where the setup.exe file

for Dragon Medical Client 2.1 is now located.

3. Enter the MSI installation command, passing it the options shown below:

msiexec /i "Dragon NaturallySpeaking 12.msi" SERIALNUMBER=#####-###-####-
####-## INSTALLDIR="C:\DragonMed" NAS_ADDRESS=10.45.133.91 DEFAULT-
SINI="C:\<full_path>\nsdefaults.ini" /Lwiemo+ "C:\logfile.log" /qn

You must put the name of the .msi file in quotation marks.

Set the INSTALLDIR to the full path where you want the files installed on the workstation.

Set the NAS_ADDRESS to the IP address or machine name of the NMS Server for this particular

Dragon Medical Client. If you have a load balancing traffic switch managing multiple NMS Servers,

set this option to the address of the switch rather than the address of a particularNMS Server.

Note: If the user already entered a value for this option, your value will overwrite that.

Set the DEFAULTSINI to the full path to the nsdefaults.ini file you created earlier.

You should include the /L option followed by the full path to an error log file, so that if some-

thing goes wrong during the installation, you receive messages about it. When you pass /L, you

also pass a series of sub-options to have the installation process log both errors and other types of

messages related to the process. (You can then send the log file to Nuance Technical Support

should any issues arise.)

The first time you carry out this installation, you should not pass the /qn option, so that if you

have neglected to provide information about a setting that does not have a default, you receive a

prompt asking for that information. Later, when you are sure this command line works, you can

add the /qn option.

When you generate the MSI command line, be sure to group the Dragon options together after the

/i option, then add the other MSI options at the end of the command line.

To run the installation to a server, you must pass the /a option tomsiexec rather than the /i

option.

Summary: Additional MSI options for use with
nsdefaults.ini file
Below is a summary of additional Dragon options you can use when you install Dragon Medical Client

2.1 from the command line usingmsiexec.exe.
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Additional MSI command line options for using nsdefaults.ini file

Option Function

DEFAULTSINI Set to the full path to the nsdefaults.ini file.

INSTALLDIR Set to the full path to where you want the Dragon Medical
Client 2.1 to be installed.

NAS_ADDRESS Set to the IP address or name of the NMS Servermachine. If
you have more than one NMS Server, be sure to give the cor-
rect server's address.

If you have a load balancing traffic switch managingmultiple
NMS Servers, set this option to the address of the switch rather
than the address of a particular NMS Server.

Note:If you define this option when installing an upgrade to
Dragon Medical 360 | Network Edition, version 2.1, you will
overwrite any value the user already entered.

/L "<logfilename>.log" Creates a log file where themsiexec installer logs any errors in
the installation. The log file's namemust be in quotation
marks.
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Starting Dragon Medical Clients from
Command Line

On any workstation where you installed the client, you can start the Dragon Medical Client from the

command line and login/connect to the NMS Server, as long as you know the login name and pass-

word of the user account on the server:

1. Select Start > Run... and enter cmd in the Run dialog box that pops up.

2. Switch directories to the following path:

<drive>:\Program Files\Nuance\NaturallySpeaking12\Program

3. Enter the command line shown below, passing either the -user option or the /user option fol-

lowed by the user name and password, in that order. The user name and password must be from

a user account created on the NMS Server:

natspeak.exe /user <username> <password>

4. The password is optional if a provider does not have a password, but Nuance recommends that

you assign all providers using Dragon Medical a password.

5. To log in using an Active Directory single sign-on user account (when the NMS Server has been

set up to run in Active Directory and the user accounts correspond to Windows user accounts),

once the provider has logged in to Windows, he or she can use the /trusted switch on the com-

mand line:

natspeak.exe /trusted

6. To log in using an EHR single sign-on user account use the /SSOUser switch on the com-

mand line.

If you are running the command on the same machine where Dragon is installed use:

natspeak.exe /SSOUser <username> <ClientID>

If you are running the command where Dragon is installed on a Citrix machine, use:

natspeakSSO.exe /SSOUser <username> <ClientID>

Where <username> is an EHR username, and <Client ID> is the token that you
created in Creating Organization Tokens on page 187.

The user account must be set up in the NMS Server, as described in Creating Single Sign-On user

accounts on page 187.

7. You can also use natspeak to install the client from the command line. To receive diagnostic

messages about the Dragon Medical Client installation process, you can use the diagnostic option

shown below:
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natspeak.exe /diagnose

When you use the /diagnose option, Dragon Medical sends any information about errors that

occur during the installation into the Dragon.log file.
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Creating Organization Tokens
Complete the following steps to create an organization token:

1. In the Nuance Management Console, go to Sites > Organization Overview.

2. Select the site that you want to create a token for, and in the Organizations area click the

Details icon. The Organization Details screen appears.

3. In the Organization Tokens tab, click Add to generate a new organization token. The

Token field is pre-filled. Optionally, enter a value in the Comment field. Click Save.

4. The new token appears in the Token table. Copy or make a note of this value; you will need it

to configure EHR Single Sign-On.

See Creating Single Sign-On user accounts for information on using the tokens to configure

EHR Single Sign-On.

Creating Single Sign-On user
accounts

Dragon Medical 360 | Network Edition supports two types of single sign-on accounts:

n Active Directory Single Sign-On, which allows users to log in using their Windows credentials.

n EHR Single Sign-On, which allows users to log in from their EHR.

The following sections describe how to configure both types of Single Sign-On accounts.

Note: For the most current information on how to configure Single Sign-On accounts, see the

https://isupport.nuance.com website.

Implementing Active Directory Single Sign-On
When you implement Active Directory Single Sign-On, you set up providers to automatically log

in when they have logged in to Windows. In this type of setup, providers avoid having to enter

their login and password multiple times.

Steps
n You must configure yourNMS Server to use Windows Active Directory Services. For more

information see Setting up the Nuance Management Server to run Active Directory Services in

the Dragon Medical 360 | Network Edition Administrators Guide.

n You must set up Windows Domain user names and user account login names that are identical.

For more information, see To configure Active Directory Single Sign-On in the Dragon Medical

360 | Network Edition Administrators Guide.

If the login credentials for an existing user account do not match the user’s Windows login, you

must delete the user account and create a new one. Make sure the login credentials for the new

account match the user's Windows login credentials. See the Enabling Active Directory Single
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Sign-On for Dragon users after you install DM360 Network Edition tech note, found at the

https://isupport.nuance.com website, for details.

Note: For DM360 Network Edition, if you upgrade your Active Directory Single Sign-On from a

pre-SP3 implementation to an SP3 or newer implementation, your Nuance Management Console

logins will change from being authenticated by the LDAP system to being authenticated by the

Nuance Management Console. This means that users must log in to the Nuance Management Con-

sole using their NMS credentials, not their LDAP credentials.

To configure Active Directory Single Sign-On

1. During the process of creating provider user accounts in the NMS Server, be sure to assign a

login name that matches the user name of the provider's Windows Domain login name.

In the Login field, enter the user name of the provider's Windows Domain login name. The

logins for DM360 Network Edition and Windows must be identical.

For example, if a provider's Windows Domain login name is one of the following:

• "Domain\John_Doe"

• "John_Doe@domain.example.com"

You enter "John_Doe" in the Login field.

For DM360 Network Edition, for each Dragon client, perform the steps in Enabling Dragon

client computers for Active Directory Single Sign-On.

Implementing EHR Single Sign-On
To implement EHR Single Sign-On, you create the log in and log out code for DM360 Network

Edition. You then configure your EHR to call that code; allowing providers to log in and out of

DM360 Network Edition from the EHR.

While the steps for configuring this in the EHR differ depending on which EHR your providers

use, the steps on the DM360 Network Edition side are the same regardless of the EHR.

Steps
n (Optional) Ensure that vSync is installed on both the Citrix client and server

n Enable EHR Single Sign-On

n Generate a Client ID

n (Optional) Map the User's EHR log in to their DM360 Network Edition log in credentials

n Write the log in/log out code

n Configure your EHR to call the log in/log out code

n For DM360 Network Edition, install the Dragon Clients with EHR Single Sign-On enabled

(Optional) Ensure that vSync is installed on the Citrix server

For DM360 Network Edition, if your EHR is running on Citrix, EHR Single Sign-On requires

that vSync be installed on the Citrix server and Citrix Support components be installed on the

client machine. Visit https://isupport.nuance.com and view "L-3431 - Using Dragon with Citrix

clients and servers Administrator Guide" for more information about vSync.
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Enable EHR Single Sign-On in the Nuance Management Console

Complete the following steps for each site that you want to use EHR Single Sign-on:

1. Open the site in the Nuance Management Console.

2. In the Organization tab, click Search.

3. Enter your search criteria in the search fields and click the magnifying glass button. The search

results appear.

3. In the Organizations screen, double-click an organization to select it. The Management screen

appears.

4. Select a site from the list of sites that displays under the folder icon on the left-hand side of the

screen. In the Sites tab, click Details.

4. In the Site screen, click the DM360 Network Edition tab.

5. Expand theMiscellaneous section.

6. Check the Enable SSO authentication checkbox to enable EHR Single Sign-on for the site.

7. Click Save to save your changes.

Generate a Client ID

Generate a client ID for each site that you want to use EHR Single Sign-on. For information

about how to generate a Client ID, see Creating Organization Tokens. Your log in script for

DM360 Network Edition will use this ID as a parameter .

(Optional) Map the EHR User Names to the log in credentials for
DM360 Network Edition

If your users' EHR usernames and user account usernames are the same, you can skip this step.

If your users' EHR usernames and user account usernames are not the same, complete the fol-

lowing steps:

1. Open the user you want to configure.

2. Go to User Account Details > Credentials > Token:

Go to User Account Details > Credentials > Token:

3. Click Add. The New Credential dialog box appears.

4. Enter the user's EHR user name in the Login field.

5. Click OK to save your changes.

Write commands for logging in and out of DM360 Network Edition

You use command line parameters to log in and out of DM360 Network Edition using EHR Sin-

gle Sign-on. You can integrate these commands with your EHR in a number of ways including:

n using a third party product

n using functionality that is built in to your EHR

n using an external scripting language.
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Logging into the local machine

If you are going to run the log in command on the same machine where DM360 Network

Editionare installed, use the following syntax to login a user:

<Path to the product executable>\<product exe file>/SSOUser <Username>
<Client ID>

where:

n <Path to the product executable> is the path to the directory that contains the product exe file.

n <product exe file> is the name of the exe file that launches the product.

l For DM360 Network Edition, the exe file is called natspeak.exe.

n <Username> is an EHR username.

n <Client ID> is the ID that you created. See Creating Organization Tokens.

For example:

C:\Program Files\Nuance\NaturallySpeaking12\Program\natspeak.exe
/SSOUser jdoe eacd17e4-f0fb-4a2b-9b20-03a80231e9a0

Logging out of the local machine

If you are going to run the log out command on the same machine where DM360 Network Edi-

tion are installed, use the following syntax to log out the currently loaded user:

<Path to the product executable>\<product exe file>/SSOUser <Username>
<Client ID>

where:

n <Path to the product executable> is the path to the directory that contains the product exe file.

n <product exe file> is the name of the exe file that launches the product.

l For DM360 Network Edition, the exe file is called natspeak.exe.

n <Username> is an EHR username.

n <Client ID> is the ID that you created. See Creating Organization Tokens.

For example:

C:\Program Files\Nuance\NaturallySpeaking12\Program\natspeak.exe /Lo-
gout

Logging in when running DM360 Network Edition on a Citrix server

Use the following command to log users into DM360 Network Edition:

<Path to the product SSO executable>\<product SSO exe file>/SSOUser <User-
name> <Customer Token>

where:

n <Path to the product SSO executable> is the path to the directory that contains the product

SSO exe file.

n <product SSO exe file> is the name of the SSO exe file for the product.

l For DM360 Network Edition, the exe file is called natspeakSSO.exe.
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n <Username> is an EHR username.

n <Customer Token> is the organization token that you created. For details, see Creating

Organization Tokens.

For example:

C:\Program Files\Nuance\EHR Synchronizer\Program\natspeakSSO.exe
/SSOUser jdoe eacd17e4-f0fb-4a2b-9b20-03a80231e9a0

Logging out when running DM360 Network Edition on a Citrix server

Use the following command to log out the currently loaded user:

<Path to the product SSO executable>\product SSO exe file> /Logout

where:

n <Path to the product SSO executable> is the path to the directory that contains the product

SSO exe file.

n <product SSO exe file> is the name of the SSO exe file for the product.

l For DM360 Network Edition, the exe file is called natspeakSSO.exe.

For example:

C:\Program Files\Nuance\EHR Synchronizer\Program\natspeakSSO.exe /Lo-
gout

Configure your EHR to call the log in/log out code

Follow the instructions provided in your EHR documentation to configure the EHR to call the

log in and log out code that you created in the Write Dragon log in/log out commands topic in the

Nuance Management Console Help.

Install the client software with EHR SSO Enabled

Use the MSI installer to install the DM360 Network Edition client software - with EHR Single

Sign-On enabled Set the MSI command line option to enable EHR Single Sign-On by passing in

NAS_SINGLE_SIGN_ON=1. See the Nuance Management Console Help for more information
about the MSI installer and MSI command line options.

Notes:

Be sure that EHR Single-Sign On is enabled or disabled in both the Nuance Management Console

and the client software for DM360 Network Edition. If these settings are out of synch—for exam-

ple, EHR Single Sign-On is enabled in the Nuance Management Console but not on the clients—

unpredictable log in behavior results.

When installing an upgrade for DM360 NE on a client machine, you can enter values in the com-

mand line for the Active Directory and EHR single sign-on settings. However, be aware that your

values will overwrite any the user already entered for these settings.
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Closing the Dragon Medical client
from a command line

In Dragon Medical 360 | Network Edition, version 2.1, on any workstation where Dragon is

installed, end-users can logout of Dragon and close the Dragon from the command line.

Closing Dragon from a command line is the same as closing Dragon from the Dragonbar menu and

closes all Dragon related processes.

This feature is useful for customers that use Dragon in a virtual environment as it allows admin-

istrators to close Dragon without using the Task Manager.

1. Select Start > Run... and enter cmd in the Run dialog box that pops up.

2. Switch directories to the following path:

<drive>:\Program Files\Nuance\NaturallySpeaking12\Program

3. To close Dragon without saving user profile changes, enter the command line shown below.

This command works even if the Automatically save user files on close option is enabled in

the Nuance Management Console.

natspeak.exe /ShutDown

4. To close Dragon and save user profile changes, enter the command line shown below. This com-

mand works even if the Automatically save user files on close option is enabled in the

Nuance Management Console.

natspeak.exe /SaveandShutDown

Notes:

n If Dragon is running and a user profile is not open, running natspeak.exe /ShutDown or

natspeak.exe /SaveandShutDown simply closes Dragon and all related processes.

n If Dragon is running and a user profile is open, running natspeak.exe /ShutDown closes Dragon

and all related processes and does not save user profile changes.

n If Dragon is running and a user profile is open, running natspeak.exe /SaveandShutDown closes

Dragon and all related processes and saves user profile changes.
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Summary: natspeak options in
Dragon Medical Client

You can run the Dragon Medical Client from the command line by running natspeak from the fol-

lowing location on the workstation:

C:\Program Files\Nuance\NaturallySpeaking12\Program\

natspeak switches
You can use the following options on the command line with natspeak to modify the way that

Dragon Medical Client 2.1 starts up.

Switch Function

/diagnose Runs the Dragon Medical Client in diagnostic mode. Outputs
information into theDragon.log file and exits.

The diagnostic information shown in the log includes file ver-
sion verifications. The diagnostic results endwith a line that
saysDiagnoses: Passed.

/trusted Automatically logs in to the Dragon Medical Client with the user
account of the logged in Windows user (also known as Active
Directory Single Sign-On). The user account must be set up in
Active Directory and have a corresponding user account in the
NMS Server.

/SSOUser Automatically logs in to the Dragon Medical Client with the user
account named. The switch expects you to supply the EHR user-
name and a Client ID. See Creating Customer Tokens in the
Administrator's Guide for more information.
The user account must be set up in the NMS Server as
described in Creating Single Sign-On user accounts on page
187

/user <username> <password> Automatically logs in to the Dragon Medical Client with the user
account named. The password is optional if the account does
not have a password. The user account must be set up in
the NMS Server.

Note that Nuance always recommends each user account have
a password.

natspeak command line options
Via the SDK installed on your speech node, you can use the following option on the command

line with natspeak to modify the Dragon Medical Client 2.1 options settings in the nsdefaults.ini

file before installing the client on multiple machines. See MSI Installation of multiple clients with the

same default options on page 181 for more information.

Switch Function

/SetDefaultOptions Opens the Dragon Medical Client 2.1'sOptions dialog box,
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Switch Function

where you can pre-set the options. When you apply the setting
changes and save them, Dragon saves the settings in the nsde-
faults.ini file.
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Ensuring Dragon Medical Client
anti-virus recommendations are met

Nuance recommends anti-virus software on all DM360 Network Editionservers and clients to pro-

tect the system from potential downtime due to viruses. However, on Dragon Medical Clients, be

sure to exclude from the anti-virus scan any files found in the folders indicated below or with the

extensions listed below (on Windows workstations):

n C:\ProgramData\Nuance\ folder and all sub-folders

n C:\<Windows user_ID>\AppData\Roaming folder and all sub-folders

n C:\Documents and Settings\All Users\Application Data\Nuance
folder and all sub-folders

n C:\Documents and Settings\Windows user_ID\Local Settings\Temp
folder

n Files with these extensions: BD, BIN, DAT, DVC, ENH, GSB, GRM, GRX, INI, LCK,

NWV, SIG, SVC, USR, VER, VOC, WAV, XML, LOG
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Assigning access to folders and
master user profiles across the
network

Caution:

To ensure that your Dragon Medical Clients can communicate with the master user profiles server

and the other servers, you must assign correct permissions to all appropriate directories and access

rights to particular keys in the registry, as indicated in the tables in Assigning access to servers, clients,

and master user profile locations on page 18. Do not skip this step, as it is important!

Turning off Automatic Updates
On each machine you plan to use in the network, be sure to turn off Windows Automatic

Updates. You should, instead, qualify each update Windows sends by installing it first on a single

test machine of the network and then updating other machines on the network only after you

determine that it clearly will not disrupt the network.

Once you are sure an update does not have any negative effects, you should install the update dur-

ing off-hours and, if required, reboot each machine during those hours to ensure that requests to

reboot do not disrupt the servers or workstations during peak hours of dictation.
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Upgrading an On-Premise Installation
Upgrading an on-premise installation of DM 360 | Network Edition involves some of the same

steps that you take to install. For upgrades from an on-premise installation to a cloud-based instal-

lation, see Nuance Management Server in the cloud on page 1.

The following list takes you through the on-premise upgrade steps:

Note: For upgrades to DM 360 | Network Edition version 2.x , your Dragon Client software

must be at SP3 or higher and your Nuance Management Server must be at 2.0 or higher.

Step One: Upgrade the Server-Side Components
Upgrade the following components in the order given:

If you are running the Profile Optimizer Server and Speech Nodes on
the same machine:
n Nuance Management Server (NMS)

n SDK Software on the Speech Nodes

n Profile Optimizer Server and Speech Nodes

If you are running the Profile Optimizer Server and Speech Nodes on
separate machines:
n Nuance Management Server (NMS)

n Profile Optimizer Server

n SDK Software on the Speech Nodes

n Profile Optimizer Software on the Speech Nodes

The current chapter, Upgrading to DM360 Network Edition or changing server and database installations,

includes instructions for upgrading all of the server-side components.

Step Two: Upgrade Your User Profiles (Upgrades
from DM 360 | Network Edition 10.x to 2.1 Only)
Upgrade your user profiles to 2.1 by following the steps in Upgrading User Profiles from DM360 Net-

work Edition Version 10.x to Version 2.0 or Higher on page 141.

Step Three: Upgrade Your Client Software
Follow the instructions in Installing the Dragon Medical Client on page 151

Note: If you do not want to upgrade all of the components in your system at once, you can

upgrade the NMS, upgrade some of the speech nodes to 2.1 while leaving others at 10.x, and

upgrade some of the clients to 2.1 while leaving others at 10.x. However, you'll need to upgrade

all of the components—the NMS, the speech nodes, and the clients—to the latest version to

access all of the latest DM 360 | Network Edition features.
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Step Four: (Optional) Migrate from the Data
Distribution Tool to Command Sets
As of DM360 Network Edition 2.1, the Command Sets feature replaces distributing custom com-

mands via the Data Distribution Tool (DDT). If you used DDT to distribute commands, migrate

to the Command Sets feature using the instructions inMigrating from Data Distribution Tool to Com-

mand Sets on page 204.

If you did not use DDT to distribute commands, you can skip this step.

Step Five: (Optional) Migrate from the Data
Distribution Tool to Word Sharing
As of DM360 Network Edition 2.1, the Word Sharing feature replaces distributing custom

words/auto-texts via the Data Distribution Tool (DDT). If you used DDT to distribute custom

words/auto-texts, migrate to the Word Sharing feature using the instructions inMigrating Custom

Words from Data Distribution Tool to Word Sharing on page 207.

If you did not use DDT to distribute custom words/auto-texts, you can skip this step.

Upgrading the Nuance Management
Server

Before you upgrade
Before you upgrade the Nuance Management Server (NMS), you must:

n Verify that .NET Framework 4.0 is installed on the server machine.

Upgrade the NMS
Complete the following steps to upgrade the NMS:

1. If you are logged in to it, log out of the Nuance Management Console.

2. Shut down the NMS Server by stopping its service: In the Control Panel, click Administrative

Tools, then open the Services window, find the Nuance Management Service, and stop the

service. If you are running more than one NMS, be sure to shut down the service on all servers.

3. Back up the NMS database, following the instructions in NMS SQL Server backup system on page

212.

4. To start the installation of the NMS Server:

l If you have the NMS server DVD: insert the DVD in your DVD reader.

l If you downloaded the NMS server software: find and double-click Nuance Management

Server and Console Installation.exe.

4. When the DMENuance Management Server and Console Installation InstallShield Wiz-

ard pops up telling you it is about to upgrade the server and asks you if you want to continue,
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click Yes.

5. Wait while the Preparing to Install... message displays and, when the first full page of the wiz-

ard appears, click Next.

6. The Setup Status page appears and displays a progress bar while the installer takes several

steps, starting with Computing space requirements, until the entire Service Pack is installed.

When you see the Update Complete page of the wizard, click Finish.

7. Verify that the Nuance Management service is running. For details, refer to Starting the Nuance

Management Server and Profile Optimizer Server on page 99.
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Upgrading the Profile Optimizer
Server, Speech Nodes, and Dragon
SDK

This chapter describes how to upgrade the Profile Optimizer Server, speech nodes, and the

Dragon SDK. It contains the following sections:

n Before you upgrade

n Step 1: Uninstall the old and install the new Dragon SDK client

n Step 2: Upgrade the Profile Optimizer Server (Installations with Profile Optimizer Speech

nodes on independent or virtual machines only.)

n Step 3: Install the new version of the Profile Optimizer Server and/or Speech Nodes

Before you upgrade
Before you upgrade the Profile Optimizer Server, you must:

n Verify that .NET Framework 4.0 is installed on the server machine.

Step 1: Uninstall the old and install the new Dragon
SDK Client
To uninstall the old version of Dragon SDK Client from any Speech Node machine, use the Windows

Control Panel:

1. Click Start > Control Panel and open Add/Remove Programs or Programs and Features,

depending on your version of Windows.

2. Find Dragon SDK Client in the list and click it to select it.

3. Click the Remove button to uninstall the Dragon SDK Client.

4. Install the new version of the Dragon SDK Client on any Profile Optimizer speech node

machine. Get the software from the product DVD and install it following the instructions in

Installing prerequisite software for speech nodes on page 73.

Step 2: Upgrade the Profile Optimizer Server
(Installations with Profile Optimizer Speech Nodes
on independent or virtual machines only.)
If you have an installation where the Profile Optimizer server runs on a separate machine from the

Profile Optimizer speech nodes, follow the instructions in Installing Profile Optimizer Server on

machine separate from Speech Nodes on page 1 to install the latest version of the Profile Optimizer

server.

If your installation has the Profile Optimizer and the Speech Nodes on the same machine, skip

this step and continue on to Step 3.
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Step 3: Install the new version of the Profile
Optimizer Server and/or the Speech Nodes
If you are running the Profile Optimizer Server and Speech Nodes on separate machines, install

the new version of the speech nodes as described in Installing Profile Optimizer Speech Nodes on inde-

pendent or virtual machines on page 86.

If you are running the Profile Optimizer server and speech nodes on the same machine, install the

new version of both the Profile Optimizer Server and theProfile Optimizer Speech Nodes by following

the instructions Installing the Profile Optimizer Server and speech nodes on page 76

Once the new software has been installed, to verify that the NMS Server, Profile Optimizer Server,

and Speech Nodes have started or to start them if they have not started, refer to Starting the Nuance

Management Server and Profile Optimizer Server on page 99.
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Migrating from Data Distribution Tool
to Command Sets

As of DM360 Network Edition 2.1, the Command Sets feature replaces distributing custom com-

mands via the Data Distribution Tool (DDT). This section discusses the factors that you will

need to consider before migrating, and tells you how to migrate to the Command Sets feature.

About Command Sets
Command Sets are a collection of related commands that are managed on and distributed from the

Nuance Management Server (NMS). Once a Command Set is created, the Administrator uses the

Nuance Management Console (NMC) to assign it to specific sites and groups, and can add, update,

or remove the Command Set from the NMS.

An Administrator generates a Command Set by:

n Exporting custom commands from the Dragon Client's Command Browser to a .dat or .xml file

(Nuance recommends using a .dat file whenever possible).

n Creating a Command Set in the NMC. This involves uploading the exported command file to

the NMS, where it becomes the basis of the Command Set.

See the DM 360| Administrator's Guide for details on how to create a Command Set.

When a user logs in to the Dragon Client, the most recent Command Set files are downloaded and

placed in her profile. The downloaded Command Set files are kept separate from custom com-

mands, allowing the Administrator to make changes to the Command Sets without affecting a

user's custom commands.

If the name and availability of a command within a Command Set exactly matches the name and

availability of a command in a user's MyCommands, the local version overrides the version of the

command in the Command Set, and the Command Set version will be inactive. You will have to

remove the local version of the command using the "Purge Identical MyCommands" feature in

order for the Command Set version to become active.

Choosing a Migration Strategy
There are multiple ways to migrate from DDT-distributed commands to Command Sets. The fol-

lowing section outlines the pros and cons of each strategy, allowing you to choose the best one

for your organization.

Creating Command Sets that Replicate Existing DDT-Distributed Com-
mands

You can migrate to distributing commands via Command Sets by creating new Command Sets that

exactly replicate your existing DDT-distributed commands.

The advantage of this strategy is that running the "Purge Identical MyCommands" feature is likely

to find and delete any custom commands created on the Dragon Client that are causing conflicts.
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However, to be sure that your new Command Sets contain all of the commands that your organ-

ization needs, you may need to wait until the Purge feature has been run for all of your users,

assess the new Command Sets, update them, and redeploy them.

If you choose this migration strategy, you'll use the following workflow to migrate:

1. Create Command Set files that replicate the existing commands that were distributed via DDT.

This can be as simple as using the existing .dat or .xml files that comprised your DDT com-

mands as the data files for your new Command Sets. See the Nuance Management Server

Administrator Guide for details on how to create a Command Set.

2. For each user that you want to migrate over to Command Sets, log in to the Dragon Client as

that user and run the "Purge Identical MyCommands" feature. This will delete any custom com-

mands that duplicate commands in your Command Sets. See the Nuance Management Server

Administrator Guide for details on how to run the "Purge Identical MyCommands" feature.

3. Save the user profile to save these changes.

4. Repeat steps 2 and 3 until all of the user profiles have been purged of identical commands.

5. Update and redeploy the Command Sets as needed.

Creating Command Sets that are Different from Existing DDT-Dis-
tributed Commands

You can also create Command Sets that don't exactly replicate your existing DDT-distributed com-

mands. This migration strategy makes conflicts between old and new commands and between old

and new lists within those commands less likely, as you can name the commands and lists in your

new Command Sets specifically to reduce these sorts of problems.

However, this strategy also means that running the "Purge Identical MyCommands" feature may

not find all identical commands, and you may have to delete those duplicates manually.

If you choose this strategy, you'll use the following workflow to migrate:

1. Create new Command Sets with new command and list names, chosen to prevent current and

future conflicts. See the Nuance Management Server Administrator Guide for naming guide-

lines.

Assign those Command Sets to the appropriate sites and groups. See the Nuance Management

Server Administrator Guide for instructions on how to create new command sets and assign

them to sites and groups.

2. Temporarily deploy Command Set versions of the DDT commands, but prefix the Command

Sets with a low-sorting and easily identifiable name, such as ‘zzzTEMP_<DDTCom-
mandSetName>, where <DDTCommandSetName> is the name of the original DDT .dat
or .xml file. This allows any new Command Set commands that conflict to be loaded first and be

active.

3. For each user in the affected sites and groups, log in to the Dragon Client as that user and run

the "Purge Identical MyCommands" feature. This will delete any custom commands that dupli-

cate commands in your Command Sets. See the Nuance Management Server Administrator

Guide for details on how to run the "Purge Identical MyCommands" feature.

4. Save the user profile to save these changes. 

5. Repeat steps 3 and 4 until all of the user profiles have been purged of identical commands.
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6. Once the ‘Purge’ process is complete across the user profiles, delete the temporary Command

Set files from the NMS. This results in the these files being removed from the Command Set

files on the Dragon Clients. See the Nuance Management Server Administrator Guide for

instructions on how to delete Command Sets.

7. Review the existing MyCommands and delete any that are no longer relevant.
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Migrating Custom Words from Data
Distribution Tool to Word Sharing

In DM 360 | Network Edition version 2.1 and newer, the Word Sharing feature replaces using

the Data Distribution Tool (DDT) to share custom words across your organization.

Take the following steps to migrate from distributing custom words via DDT to distributing them

via the Word Sharing feature:

n Import the custom words that you used to distribute via DDT to the Nuance Management

Server (NMS). See the Working with Text and Graphics auto-texts and custom words chapter of the

Nuance Management Server Administrator Guide for instructions.

n When users log into the client for the first time after a large number of words have been added

or deleted from the NMS, the vocabulary may take a bit longer than usual to load, as the

custom words download from the server are added and deleted from the users' vocabulary.

Users must save their profiles after this to avoid the vocabulary loading slowly in the future.
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Revising or Repairing the Profile
Optimizer Installation

If you have installed the Profile Optimizer Server and/or its Profile Optimizer Speech Nodes and want to

modify or repair that installation, you take only a few steps.

1. Halting Profile Optimizer Speech Nodes on page 209

2. Revising or repairing the Profile Optimizer or Speech Node installation on page 209

Note: If you are upgrading to DM360 Network Edition Service Pack 2, you should uninstall the

Profile Optimizer Service before the upgrade. Existing database and log files are not modified dur-

ing the upgrade. After you close the Speech Node software, make sure the Nuance.Co-

nversionServer.ClientApp.exe is not running. If you see the

Nuance.ConversionServer.ClientApp.exe process in the Windows Task Manager, close it.

Halting Profile Optimizer Speech Nodes
If you have one or more Profile Optimizer Speech Nodes running, you need to terminate their proc-

esses:

1. To terminate the processes, open the Windows Task Manager and click the Processes tab.

2. Find any processes namedNuance.ConversionServer.ClientApp. Highlight them and click

End Process.

Revising or repairing the Profile Optimizer or
Speech Node installation
After the Profile Optimizer Installer wizard starts up and you click Next, if you have already

installed any portion of Profile Optimizer, theModify, Repair or Remove installation page of the

wizard appears and you should selectModify, then click Next to proceed.
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NMS SQL Server backup system
When you look in the SQL Server explorer, to find the NMS SQL Database database, look for a

database namedNuanceMC by default. If you name the database differently during the instal-

lation process, NMS Server retrieves the database name from SQL Server and uses its name as the

root for the backup files.

During the installation process, the NMS Server creates the backup folder in the location you indi-

cate or, by default, in the C:\NMSDBBACKUP folder.

The NMS Server automatically backs up the data you have entered into it on sites, users, groups,

and other objects into the backup folder. It also backs up all Windows communication foundation

service logs that it creates.

(For more information on logs that the clients and servers create, refer to Servers and Dragon client

logs on page 216.)

Scheduled NMS transaction log and database
backups
The NMS Server schedules these backups:

n Transaction log backups—Scheduled hourly

n Differential database backups—Scheduled daily

n Full database backups—Scheduled weekly

The NMS Server stores up to one month of backups on its hard disk.

To retain more than one month of backups, you must copy the data before the month is over.

Disabling scheduled backups of the NMS database
You can set an option to turn off scheduled backups of the NMS database. This is useful for sites

that want to manage their own backups of the NMS database. When you set the option, the sched-

uled backups still run but do not do anything. To disable scheduled backups of the NMS database:

1. In the Nuance Management Console, in System Settings, check Disable scheduled NMS

database backups.
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2. Click Save.

File names of database backups
Each time it carries out a full database backup, the NMS Server takes the following steps:

1. Deletes database files older than 1 month.

2. Renames the NuanceMCDump.BAK file currently in the folder to

NuanceMCDump_YY_MM_DD_hh_mm_ss.BAK, using the current date- and timestamp.

3. Generates a new database backup and names it NuanceMCDump.BAK.
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Profile Optimizer SQL Server backup
system

When you look in the SQL Server explorer, to find the Profile Optimizer SQL Database database,

look for a database namedNuancePODB.

At the beginning of the installation process, you create the Profile Optimizer Server database files

folder and place it on the hard drive of the SQL Server. This file does not require a particular

name, because you tell the server the name of the file later in the installation process. You might

name it something that helps identify it, like ProfOpt_DB. The Profile Optimizer Server auto-

matically backs up the data that it generates into this database files folder.

Note:

The server does not automatically back up Dragon log files and Speech Node service log files that it

creates.

(For more information on logs that the network clients and servers create, refer to Servers and

Dragon client logs on page 216.)

Automatic Profile Optimizer transaction log and
database backups
The Profile Optimizer Server generates these backups after the Profile Optimizer Server Service

starts:

n Differential database backups—Created when the services first start up, then generated daily

n Transaction log backups—Generated hourly as long as the Profile Optimizer Server Service

is running

n Full database backups—Generated after the Profile Optimizer Server Service has run for a

full week, then every time the service has been running a full week since the last full backup

The Profile Optimizer Server stores up to one month of backups on the database server hard disk.

To retain more than one month of backups, you must copy the data before the month is over.

File names of database backups
Each time it carries out a full database backup, the Profile Optimizer Server takes the following steps:

1. Deletes database files older than 1 month.

2. Renames the NuancePODBDump.BAK file currently in the database files folder to

NuancePODBDump _YY_MM_DD_hh_mm_ss.BAK, using the current date- and timestamp.

3. Generates a new database backup and names it NuancePODBDump.BAK.
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Master user profiles backups
The master user profiles file structure follows a particular pattern. Understand this structure can

help you better plan to back up the master user profiles.

Caution:

Nuance recommends that you back up all master user profiles weekly. You should retain these

backups for several weeks in case you need them.

Each DM360 Network Edition master user profile is stored in its own subdirectory of the Master

User Profiles Server (or directory on the NMS Server, Profile Optimizer Server, or database server) as

shown below:

\\<ServerName>\<ProfilesDir>\<NMS_userLoginName>\last known good\
profile1

The first profile for the provider is under profile1. If the provider has more than one profile, the

next is under profile2.

If a profile becomes corrupted, you receive a notification about it in theMessages box on the

NMS Server; the NMS Server moves the profile to the following location:

\\<ServerName>\<ProfilesDir>\<NMS_userLoginName>\BAD\profile1

The next time the provider starts to dictate, the Dragon Medical Client 2.1 automatically creates a

new profile for that provider.

The corrupted profile remains on the Master User Profiles Server until you remove it. When you

have any corrupted profiles, you should contact Nuance, as these profiles are not automatically

uploaded to the Nuance data collection site. Avoid removing these profiles until Nuance sub-

sequently notifies you that it has retrieved the profiles for analysis.

Removing a master user profile folder
for a deleted user account

In Dragon Medical 360 | Network Edition, 2.1, you use the Dragon client to export and import

user profiles. For details, see the Dragon Help and the Dragon user guide.

Before you delete a user account, you should be sure to export the user profile for the account

first. Exporting the user profile saves the information accrued about that particular provider's

voice and speech patterns. Should you ever need that user profile again, you can then import the

exported user profile to bring the provider back up to speed more quickly.

For details on how to export a user profile and delete its associated user account, refer to the

Dragon Help or the Dragon user guide.
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Servers and Dragon client logs
Note:

The servers regularly purge all of these logs and do not automatically back them up, so you might

want to back them up to another location if you want to save them for longer periods.

Dragon and Profile Optimizer Speech Node logs
The Profile Optimizer Speech Node generates two log files for each ACO/LMO task it carries out:

n Dragon log files—Dragon Medical SDK Client creates dragon.log and dgnsetup.log. In Service

Pack 4, you cannot view Dragon log files from the Nuance Management Console.

n Speech Node service log file—Profile Optimizer services write these files

The Profile Optimizer Server stores these files for 30 days. After 30 days, the Profile Optimizer purges

old log files. If you would like to preserve them, you can back them up.

Viewing Speech Node service logs

You can view the Dragon log files and Speech Node service log files in the Nuance Management Console.

Note: Viewing node and task status when upgrading the PO Server to the cloud

Prior to NMS 3.0, the NMS sent requests to the PO server to get task and node information. In

NMS 3.0 and newer, with NMS in the cloud, a path from NMS to the PO server no longer exists.

Instead, the NMS hosts an interface that allows the PO server to send task and node information

to NMS in the cloud for storage. The NMS uses its locally accessible tasks and nodes storage to

satisfy queries from the Nuance Management Console.

Prior to NMS 3.0 , the PO server sent updates to the NMS server every time the state of a task

changes. In NMS 3.0 and newer, the PO server sends updates to the NMS in the cloud every 60

seconds (by default) for tasks on a scheduled basis.

When you upgrade the PO Server to NMS 3.0 and newer, the on-premise PO server starts migrat-

ing node and task tables to NMS in the cloud. The PO server first sends its newest data to NMS

in the cloud. The server then sends older or historical data to the cloud.

During the upgrade, there may be a small period of time when data is not available in the Nuance

Management Console for node groups or task status.

Upload Speech Node service logs

You must upload the logs before you can view them in the Nuance Management Console.

1. In the Nuance Management Console, click Utilities.

2. In the Profile Optimizer section, click Status.

3. Right-click a speech node and select Request logs.

4. Enter start and end dates for the logs.
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5. Click OK. The request is sent to the Profile Optimizer Server. The server processes the request

and uploads the logs to the Nuance Management Server. It may take a few minutes for the logs

to appear in the Nuance Management Console.

6. To view the logs, under Utilities, click Server Logs.

View Speech Node service logs

You can view the Dragon log files and Speech Node service log files in the Nuance Management Con-

sole.

To view the Speech Node service log file by taking these steps:

1. On the Menu bar, click the Utilities tab.

2. Click the Profile Optimizer > Tasks icon.

3. In the Search Criteria section, enter information into the fields.

4. Click the magnifying glass.

5. In the Profile Optimizer Tasks screen, double click on the task of the Speech Node whose log

you would like to view. For details, see Viewing status of scheduled and automatic opti-

mizations. The Profile Optimizer Task Log opens and displays a history of the actions the

Speech Node has taken.

Viewing Dragon logs

To view the Dragon log files, see the Viewing Dragon log files section in the Nuance Management Server

Administrator Guide.

You can also find the Dragon logs in the file system. Note that the location of the files depends on

the operating system. Paths on Windows Server 2008 and on Windows XP are shown below.

In Service Pack 4, you cannot view Dragon log files from the Nuance Management Console.

Location of Dragon logs on Windows Server 2008:

C:\Users\Administrator\AppData\Local\Temp\dgnsetup.log
C:\Users\Administrator\AppData\Roaming\Nuance\Dragon SDK Client
___Edition10\dragon.log

Location of Dragon logs on Windows XP:*

C:\Documents and Settings\<user_account_login>\Local Settings\Temp\
dgnsetup.log
C:\Documents and Settings\<user_account_login>\Application Data\Nuance\
___NaturallySpeaking12\Dragon.log

The 2.x versions of DM360 Network Edition will be the last versions of the product to support

Windows XP. DM360 Network Edition 2.1 continues to support Windows XP.

NMS Server logs
The NMS Server generates Windows communication foundation service log files for each

individual user account.
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Finding NMS service logs

You can find the Windows communication foundation service logs on the NMS Server under a sep-

arate path for each user account:

On Windows Server 2008:

C:\ProgramData\NMS\Logs\NMS Server\

On Windows Server 2003:

C:\Documents and Settings\All Users\Application Data\NMS\Logs\NMS Server

The service log files are namedNMS Server_0000.svclog toNMS Server_9999.svclog.

The NMS Server keeps the last 10 MB of files generated, or about 50 files, for the entire system.

When it creates new files that exceed those numbers, the server purges the older files.

Viewing NMS service logs

You can view the NMS Server service log files in the Microsoft Service Trace Viewer utility by

double clicking on the log file. (The utility is available in .NET Framework.) Or you can open the

Service Trace Viewer by double clicking its executable, available at:

C:\Program Files\Nuance\NMS Server\SvcTraceViewer.exe

If you run the Service Trace Viewer from its executable, when first you select File > Open, you

must browse to the location of the log files. The next time, the viewer remembers the path.

If you call Technical Support, you might be asked to provide one or more of the logs mentioned

in this section to help Nuance engineers work on any issues with your network.
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View log files for a variety of products
and product components

Please see 'View log files for a variety of products and product components' in the Nuance Man-

agement Server Administrator Guide.
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Nuance Management Console logs
The Nuance Management Console stores user session data in a Nuance Management Console log

file. The log file includes data that could be useful for troubleshooting Nuance Management Con-

sole exceptions or issues.

If an administrator performs an action that causes a Nuance Management Console error or crash,

the next time the Nuance Management Console starts, it sends the Nuance Management Console

Log file to the NMC server. Technical support can then analyze the log file. An administrator can

also manually upload the Nuance Management Console log file to the NMS.

An Nuance Management Console log file is kept until it becomes larger than 10 MB in size. At

that time, the Nuance Management Console discards the log file and creates a new one. The

Nuance Management Console also creates a new log file after it uploads the current one to the

NMS.

Upload the Nuance Management Console log file to
the NMS
1. In the Nuance Management Console, click the Nuance icon (top left of the screen).

2. Select Upload NMC Log File.
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Moving NMS Server SQL database
To move the NMS SQL Database, you first move it to the new location, then test the new data-

base to be sure it is operational. Finally, you remove the database from the original location.

Moving the database to a new location
To move the NMS SQL Database, take these steps:

1. Back up the NMS SQL Database and then close all network connections.

2. Remove the NMS SQL Database from the existing server. This step exports a copy of the data-

base but does not remove it from the original server. For more details, see the SQL Server

dump/export documentation from Microsoft.

3. Install the SQL Server software on the new physical server.

4. Restore the database on the new server. For more details, see the SQL Server restore doc-

umentation from Microsoft.

5. Uninstall the NMS Server following the steps inMoving NMS Server SQL database on page 222.

The old database remains intact.

6. Reopen all network connections.

7. Reinstall the NMS Server to its original location, being sure to give the new location of the data-

base when you are prompted for it during the installation process.

8. Once you are sure that the new database is operational, remove the old database from the orig-

inal server (see steps below).

Removing the old database from the original
location
To remove the old NMS SQL Database, take these steps:

1. Close all network connections on the original database server.

2. Click Start > Programs and look for SQL Server Management Studio.

3. When theMicrosoft SQL Server Management Studio dialog box appears, expand Data-

bases in the Object Explorer (to the left) and find the database namedNuanceMC. That is

yourNMS Server database.

4. Right click onNuanceMC and select Delete from the drop-down menu.
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Moving the Profile Optimizer Server
database

To move the Profile Optimizer Database, you first move it to the new location, then test the new

database to be sure it is operational. Finally, you remove the database from the original location.

Moving the database to a new location
To move the Profile Optimizer Database, take these steps:

1. Back up the Profile Optimizer Database and then close all network connections.

2. Remove the Profile Optimizer Database from the existing server. This step exports a copy of the

database but does not remove it from the original server. For more details, see the SQL Server

dump/export documentation from Microsoft.

3. Install the SQL Server software on the new physical server.

4. Restore the database on the new server. For more details, see the SQL Server restore doc-

umentation from Microsoft.

5. Reopen all network connections.

6. Uninstall the Profile Optimizer Server following the steps inMoving NMS Server SQL database on

page 222. The old database remains intact.

7. Reinstall the Profile Optimizer Server to its original location, being sure to give the new location of

the database when you are prompted for it during the installation process.

8. Once you are sure that the new database is operational, remove the old database from the orig-

inal server (see steps below).

Removing the old database from the original
location
To remove the Profile Optimizer Database, take these steps:

1. Close all network connections.

2. Click Start > Programs and look for SQL Server Management Studio.

3. When theMicrosoft SQL Server Management Studio dialog box appears, expand Data-

bases in the Object Explorer (to the left) and find the database namedNuancePODB. That is

your Profile Optimizer database.

4. Right click onNuancePODB and select Delete from the drop-down menu (see illustration

below).
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Setting up the Nuance Management
Server to run Active Directory
Services

You can use ActiveDirectory Services to manage your DM360 Network Edition network. Ideally,

you should decide to use Active Directory Services before you install the DM360 Network Edi-

tion network. Enabling Active Directory Services requires specific steps during the DM360 Net-

work Edition installation process. However, you can enable Active Directory Services before or

after you have installed the DM360 Network Edition network.

Enabling Active Directory Services
1. Install SQL Server 2008.

2. Creating Nuance Management Console Administrator Account in NMS Server for

Active Directory Administrator: After you install the NMS Server:

l Install the Nuance Certificates on any workstation where you want to log in through the

Nuance Management Console. (Refer to the Dragon Medical 360 | Network Edition

Installation Guide.)

l Log in to NMS Server using the admin login Nuance provides.

l Prepare to create user accounts by changing the name of the organization/site Nuance pro-

vides to match your organization and site.

l Create aNuance Management Console Administrator user account for the

Active Directory administrator.

l If you would like, create all other user accounts now; or you can create user accounts later.

l Create Active Directory Single Sign-On User Accounts: If you want to set providers up

to log in only once, you can set up Active Directory Single Sign-On user accounts (they are

optional); see Creating Single Sign-On user accounts on page 187. You need to create these

accounts before you can associate a user account with an already existing upgraded master

user profile.

3. Set the Active Directory connection string.

4. Continue to configure the NMS Server as Active Directory Administrator

l Follow instructions in Nuance Management Server Administrator Guide.

Creating an NMC Administrator account for Active
Directory
To create the NMC Administrator account for the Active Directory administrator:

1. Install the NMS Server following the instructions in this manual.

2. Log in to the NMS Server through the Nuance Management Console.

3. To prepare to set up user accounts required for Active Directory in NMS Server, you need to

first:
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l Change the name of the default organization to your organization's name. See details on mod-

ifying the organization information in the Nuance Management Server Administrator Guide under

Accessing and adding to your organization data.

l Change the name of the default site in that organization to your site's name. See details on

how to create a site in the Nuance Management Server Administrator Guide under Configuring sites

in DM360 Network Edition

4. Create anNMC Administrator user account for the Active Directory administrator to use

when logging in to the NMS Server. Make sure the login you assign in NMS Server matches an

existing login in Active Directory.

5. Assign anNMC Administrator license to the new account for the Active Directory admin-

istrator.

6. You can create other user accounts at this time, but if you are not ready to create them, you can

create them later, as long as every NMS Server user account login you assign matches an existing

login in Active Directory.

7. Proceed to the next subsection.

Set the Active Directory Connection String
Complete the following steps to add an Active Directory connection string:

1. Click the Organization Details icon for the site that you want to configure, then click the

Domains tab:

2. Click Sites > Organization > Details icon for the site that you want to configure, then

click the Domains tab:
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3. Click Add. The Domain dialog box appears.

4. Enter the domain name in the Name field, and the Active Directory connection string for

that domain in the Active directory connection strings: field:

5. Click Save to save your changes.

6. Repeat steps 2-4 for every domain that you want to set up.

Once Active Directory is on, the NMS Server sends all authentication requests to the server you specified

in the connection string value. You can then take actions to set up and manage your network using

Active Directory Services. For information on using Active Directory Services, refer to the documentation

Microsoft provides.
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Restarting the Nuance Management Service
1. Restart the NMS Server by restarting the service: In the Control Panel, double click Admin-

istrative Tools. Then double click Services. In the Services window, find the

Nuance Management Service and restart it.

2. Log in to the NMS Server using the new NMC administrator user account you created for the

Active Directory administrator.

3. Revoke the NMC administrator license of the original admin user account that Nuance pro-

vided, since that account does not work within Active Directory. You might want to grant that

license to another user account.

4. If you would like dictating healthcare providers to be able to log in to Windows and then auto-

matically be logged in to the Dragon Medical Client on the same workstation without having to

enter separate login credentials for Dragon, see Creating Single Sign-On user accounts on page 187.

5. To continue to configure the NMS Server as Active Directory administrator account by fol-

lowing the remaining instructions in this book.

Creating an NMS user account for
Active Directory

When you are planning to work in Active Directory, one of the steps you take is to create an

NMS Administrator account for the Active Directory administrator.

Note:

More details about creating user accounts are available in the Nuance Management Server

Administrator Guide.

To create anNMC Administrator account for the Active Directory administrator:

1. Log in to the server through the Nuance Management Console. For details, see Logging in to the

Nuance Management Server through the Nuance Management Console on page 97.

2. On the Menu bar, click on the User Accounts ribbon.

3. When the User Accounts ribbon appears, click the Add User AccountAdd icon.

The User Account Details window opens.
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4. Configure the settings in the tabs in the User Account Details window:
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l Details—Enter data in the shaded text boxes, as that data is required. You can fill in the

others later. Required information includes the Active Directory administrator's first and

last names and the login.

Caution:

The login you enter must match a login that exists in Active Directory.

l Address—Physical location information. None of this data is required right now. You can

fill it in later.
l Group Memberships—If you have created no other groups, two groups

exist when you first run the product, NMC Administration and DM360

Network Edition. Add the Active Directory administrator to the

NMC Administration group.

l Messaging: To configure email settings to enable the NMS to send messages to users and

administrators.

l DM360 Network Edition—To apply default settings for now, click the Use group rules

button. For more information, refer to Configuring user account DM360 Network Edition in the

Nuance Management Server Administrator Guide.

l User Profile—Ignore these settings. The Dragon Medical Client 2.1 provides them.

5. Click Save to save the user account settings.

6. When you save the user account, the Nuance Management Console displays a dialog box that asks

you if you want to assign a license to the user account now.

You should click Yes.

7. When the next message asks you the type of license to assign, you select an

NMC Administrator license. The number of licenses available shows in parentheses after the

license type. If no licenses of a particular type are available, that type of license is grayed out. If

no administrator license are available, contact your Nuance representative.

8. Return to the Active Directory configuration instructions under Setting up the Nuance Management

Server to run Active Directory Services on page 226.

Note:

For now, you can skip setting options and other information for the user accounts

that you want to associate with upgraded master user profiles. To later assign all

related user accounts the same option settings, you can:
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n Create a group and set all options for that group.

n Add the user accounts that should have the same options to the group.

For details on how to carry out these tasks, refer to the Nuance Management

Server Administrator Guide.
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Chapter 14: Managing the
Nuance Management Server

This chapter presents information about managing multiple NMS Servers and configuring network traf-
fic switch to ping NMS Servers for load balancing:

Managing multiple Nuance Management Servers 234

Using and configuring the FileStore location for multiple NMS servers 235

Use a network traffic switch to balance the load on the Nuance Management Server 236
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Managing multiple Nuance
Management Servers

In a large network, you might choose to have multiple NMS Servers, one for every 1,000 dictating

healthcare providers.

For some illustrations of larger DM360 Network Edition Networks and guidelines on when to deploy

such a structure, refer to the DM360 Network Edition Planning and Deployment Guide.

On a large network, you should include a network traffic switch to help route server requests to

the appropriate NMS Server. More details on configuring the network traffic switch to work with

NMS Servers are provided in Use a network traffic switch to balance the load on the Nuance Management

Server on page 236.
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Using and configuring the FileStore
location for multiple NMS servers

The NMS FileStore is a common location for files that need to be shared between the

nodes/servers of the NMS system. If only one node/server is used, you can use the default File-

Store location (which is the local system). If more than one node/server is used, you must create

a common location for the nodes/servers to use as a FileShare.

You must configure each NMS node to use this common location. It is recommended that you

not use one of the NMS nodes as the common location. If the server were to fail, the other nodes

will not be able to access the FileShare location.

In DM360 Network Edition, the NMS System uses the FileStore to store temporary files that

upload and download to the Management Console. For example, log files from various client appli-

cations.

Space requirements for the FileStore will depend on your system configuration.

You use the Nuance.NAS.Server.exe.config file to configure the FileStore location. There is a key

in the "appSettings" section called FileStorePath that controls the location of the NMS FileStore.

Look for the following line:

<add key="FileStorePath" value="" />

A empty string (“”) means to use the default. The default location is

%ALLUSERSPROFILE%\NMS\FileStore

where %ALLUSERSPROFILE% is an environmental variable.

The value of the environmental variable depends on the operating system. The following is a list

of default locations for the environmental variable %ALLUSERSPROFILE% based on Operating

Systems:

n Windows 2008: C:\ProgramData

n Windows 7: C:\ProgramData

n Windows Vista: C:\ProgramData

n Windows XP*: C:\Documents and Settings\All Users\Application Data

The NMS Server creates an Upload, Download, and Completed folder in the FileStorePath loca-

tion.

For example. in Windows 2008, if “” is used in the configuration file, the NMS Server uses
c:\ProgramData\NMS\FileStore as the location of the FileStore. If
“D:\NMS\FileStore” is used, the NMS Server uses D:\NMS\FileStore as the FileStore
location.

To change the FileStorePath:

1. Determine where you want to put the FileStorePath.

2. Shutdown the NMS Service. You can’t move an existing FileStorePath while the service is run-

ning.
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3. Create the FileStorePatch folder that you chose in step 1.

4. Copy the current ClientLogs, Completed, Download, and Upload folders to the folder you

created in step 3.

5. Delete the current FileStore folder.

6. Modify the FileStorePath key value to use the folder you picked in step 1.

7. Save the FileStorePath key value.

8. Restart the NMS Service.

The 2.x versions of DM360 Network Edition will be the last versions of the product to support

Windows XP. DM360 Network Edition 2.1 continues to support Windows XP.

Use a network traffic switch to
balance the load on the Nuance
Management Server

If you have a large network with multiple NMS Servers, you can include a network traffic switch in

your network to balance the load on the NMS Servers. The network traffic switch can be an F5 or

similar switch.

To configure the network traffic switch to send a message to the NMS Server to see if the server is

operational, you would have the network traffic switch send the following message in the

URL line of the browser:

http://<NMS-Server-Name>:8051/Nuance.NMS.Services/
__NMSServiceStatus/Rest/Status

The NMS Server delivers the following XML-formatted response to the network traffic switch:

<ServiceStatusResponse xmlns=
"http://schemas.datacontract.org/2004/07/Nuance.NAS.Connector.
DictationTranscription" xmlns:i="http://www.w3.org/2001/
XMLSchema-instance">
__<Status>Running</Status>
__<ServerDateTimeUTC>2010-12-13T20:50:13.0969590Z
____</ServerDateTimeUTC>
__<InterfaceType>basicHttpTransport</InterfaceType>
</ServiceStatusResponse>

If the NMS Server is down, the switch receives an error. If the network traffic switch makes this

call and the NMS Server sends anything other than the expected response, the switch can tag that

server as down and reroute the traffic accordingly.
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This chapter discusses NMS in the cloud; how it works, how it differs from hosting an on-premise
NMS, and how to upgrade to NMS in the cloud.
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Overview of NMS in the cloud
Starting with the Nuance Management Server (NMS) 3.1, you can optionally upgrade to the

Nuance Management Server in the cloud. If you purchase and install the NMS upgrade and

migrate your system to the cloud, data objects are stored in the Nuance Management Server

(NMS) in the cloud (in the Nuance data center) instead of an on-premise NMS. These objects

include the following profile customizations:

n User account

n Text and Graphics/auto-texts

n Custom words

n Custom Command Sets

Storing objects in NMS in the cloud allows organizations that have more than one Nuance prod-

uct to share data across multiple Nuance applications. For example, if an administrator at an organ-

ization creates an auto-text in the Management Console, that organization's users can see and use

that object with Dragon Medical 360 | Network Edition, Dragon Medical 360 | Direct as well as

any application that uses Speech Anywhere Services.
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Note:Migrating to Nuance in the cloud is optional and only required if you plan on sharing pro-

file customizations with Nuance cloud based products.

What will be different when you migrate to NMS in
the cloud?
This section describes what you can expect when moving or upgrading to the NMS in the cloud

configuration.

Note: Text and Graphics and DragonTemplates are supported. Text and Graphics with Lists are

not supported.

n NMS is hosted in the Nuance Data Center instead of being hosted in your organization.

n The cloud NMS stores all the Dragon user settings.

n Management - Your administrators access the cloud Management Console to configure and

manage users. This provides the administrators with one place where they can view and manage

all product licenses for NMS supported products.
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n Shared content (profile sharing) with other Nuance Healthcare products. Text and

Graphics/auto-texts and custom words can be shared between DM360 Network Edition and

Dragon Medical 360 | Direct 1.4, and, SpeechAnywhere Services powered third party

applications like Cerner PowerChart Touch™ and EPIC Haiku/Canto.

n Single and centralized cloud management of products.

n You no longer need to install and maintain the NMS database and the SQL database. You still

need to install the Profile Optimizer Server and speech nodes on-premise. When you upgrade

the Profile Optimizer to NMS in the cloud, the server is configured to communicate directly

with the NMS cloud server.

n Management of cloud Text and Graphics/auto-texts using the cloud Management Console.

n Management of Dragon and NMS settings that was previously accomplished using the on-

premise Management Console is now done using the cloud/hosted Management Console.

n User profiles are enhanced with customizations; auto-texts and custom words that are defined at

the Site or Group level.

n Importing, exporting, and deletion of user profiles is not available in the cloud NMS. These

features have been moved to the Dragon client for Dragon Medical 360 | Network Edition.

n After you upgrade to NMS in the cloud, the on-premise NMS is uninstalled.

n The Profile Optimizer and its speech nodes are still hosted in your organization.

n All calls between the PO Server and the cloud NMS are one way - from the PO Server to the

cloud NMS.

n Calls from the PO Server to the cloud NMS use service to service token security. The PO

Server installs with an organization token for an organization and passes this token as a

credential to the NMS. There is no need to configure the PO Server with a login or password to

make service to service calls to the cloud NMS. The NMS uses the token to limit the

information it returns to the PO Server for an organization.

n An administrator can back up and restore a user account from the User Accounts screen.

n In some cases, you may need to install and configure an NMS “call forwarder” when on-premise

LDAP or Active Directory support is required.

n For Text and Graphics/auto-texts, the Meta Data tab is visible if you log in to Management

Console with the Dragon Medical 360 | Direct license. The tab is not visible if you only log in

with the DM360 Network Edition license.

n Speech node collections are defined at the organization level.

n NMS download packages are distributed to individual organizations instead of to everyone on

the system.

n You can add comments to organization tokens

n The Organization Tokens tab ( a client ID for each site that you want to use EHR Single

Sign-on) and Credentials tab are visible to all administrators.

Upgrading and moving data to the cloud
When you upgrade to NMS in the cloud, you use the Cloud migration tool to move the data from

an on-premise NMS server to the NMS server in the cloud.

After you migrate the data, you can uninstall the NMS server from your site.
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If you are using LDAP integration, a local call forwarder must be installed on-premise. The call for-

warder maintains your local LDAP integration while forwarding all other NMS calls to NMS in the

cloud..

For details and steps, see Upgrade to NMS in the cloud.

Managing user logins
User logins in the cloud must be unique. If an on-premise NMS user’s login is being used by a

user in another organization in the cloud NMS, this is a user login conflict that needs to be

resolved before the on-premise user can be migrated to the cloud NMS. Two users cannot have

the same login id in the cloud NMS.

For example, if you are upgrading "Bob" to NMS in the cloud, and user login "Bob" already exists

in the cloud NMS, this is a naming conflict. For more details, see Move data from an existing on-

premise NMS server to the cloud NMS server.

Organizations using LDAP/AD

If you are using LDAP or Active Directory to authenticate users, there should be no conflicts

when moving to the cloud. The NMS uses a “domain” along with the login which maps to a

unique organization.

1. Install and configure the NMS call forwarder.

2. Minor configuration of the NMS call forwarder is required which basically consists of setting a

domain name and the LDAP address where non-trusted LDAP/AD functionality is required.

For details, see Install the NMS Call Forwarder.

Organizations using NMS native credentials

If you are using NMS native logins to authenticate users, when you move to the cloud, the NMS

native logins may conflict with existing user accounts. For example, if your organization has a user

login called “bob” and a user login called “bob” is already in use in the cloud system, you must

change the user login before you can move that user account to NMS in the cloud.

The call forwarder is not required.

Upgrading from Dragon Enterprise Edition to
DM360 Network Edition using the Profile
Association Tool
The Profile Association tool is only required for US customers that are upgrading from Dragon

Medical US Enterprise Edition.

The following applies to organizations that migrate from Dragon Enterprise Edition to NMS in the

cloud and use an on-premise NMS server.

The profile association tool that currently resides in the Management Console will no longer

reside in the Management Console. Instead, administrators can run a separately installable tool that

contains the exact same functionality. The new tool:
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n Requires access to the profile store

n Communicates with the NMS server in the cloud

The workflow for using the profile association tool is the same as before. If you are running a pre-

NMS version of the Dragon client:

n Nuance sets up an Organization for your organization in the cloud NMS server .

n Your administrator uses the cloud Management Console to create user accounts in the cloud

NMS server

n Your administrator runs the standalone Profile Association Tool to:
n Search the local user profile store for available user profiles that require user

accounts

n Search the cloud NMS server for user accounts that need user profiles

n Allows the administrator to map the user profiles to the user accounts.

Authentication
After you upgrade a user account or a Dragon client to Nuance Management Server (NMS) in the

cloud, users must log into the system using the Dragon client in connected mode. This action

authenticates the user with the NMS and allows them to later use Dragon in disconnected mode.

The user cannot use Dragon in disconnected mode until they first login to Dragon in connected

mode.

The following only applies to organizations that are using LDAP/AD for authentication. NMS

native credential users do not require the call forwarder.

Since the NMS is no longer on-premise, you must install and configure the “NMS call forwarder”

to query your LDAP/AD store and validate user credentials. You install the “NMS call forwarder”

at your site in place of the on-premise NMS server. On premise Dragon clients must be con-

figured to point to the call forwarder. The call forwarder tests the user credentials and sends

authentication requests to the cloud NMS to retrieve data.

Profile importing, exporting, and deleting
Since the NMS in the cloud does not have access to the profile store, this functionality is no

longer available in the Management Console. Instead, it is available and performed through the

Dragon Client.

If an administrative task requires the importing, exporting, or deletion of user profile(s), someone

must perform these actions on the Dragon workstations. For details, see the Dragon Help or the

Dragon user guide.
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Installing and Configuring NMS in the
Cloud

This section describes how to install and configure Dragon Medical 360 | Network Edition with

the Nuance Management Server (NMS) in the cloud.

If you already have Dragon Medical 360 | Network Edition installed with a locally-hosted NMS

and you want to upgrade to NMS in the cloud, see the Upgrade to NMS in the cloud section.

Overview of Installing and Configuring NMS in the
Cloud
You will complete the following steps to install and configure Dragon Medical 360 | Network Edi-

tion with the Nuance Management Server (NMS) in the cloud:

1. Before You Begin

2. Install the Profile Optimizer and Speech Nodes

3. Install the NMS Call Forwarder (Optional)

4. Install and Configure Dragon clients

Before You Begin
Before you begin, Nuance will send you a welcome email containing the information that you

need to install and configure NMS in the cloud, including:

n The URL for NMS in the cloud.

n Your Organization ID.

n Your administrator user name and password.

n An alphanumeric token that you will need to install the Profile Optimizer and, optionally, the

Call Forwarder.

Keep this information on hand; you will need it as you install and configure DM360 Network Edi-

tion with NMS in the cloud.

Install the Profile Optimizer and Speech Nodes
Have the token that Nuance created for your Organization at hand; you will need this when you

install the Profile Optimizer.

Install and configure the Profile Optimizer and one or more speech nodes, as described in the

"Installing Profile Optimizer components" chapter of the DM360 Network Edition Installation

Guide.

Install the NMS Call Forwarder (Optional)
If you want to use LDAP or Active Directory Single Sign On for your authentication, you must

install the NMS Call Forwarder on a server that is accessible to both the cloud NMS and your
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Dragon Clients. If you want to use Dragon's native authentication, you can skip this step.

The cloud NMS cannot test LDAP credentials inside your organization. The NMS forwarder fills

this gap by testing LDAP credentials. If they pass verification, the forwarder sends the credentials

to NMS in the cloud for processing. All requests from DM360 Network Edition go through the

call forwarder.

The NMS call forwarder is installed on premise. No SQL Server or configuration is required.

Installing the Call Forwarder

What you require before you begin:

n The organization token created in your cloud organization, and used to install the Profile

Optimizer. You need to enter it during the Call Forwarder installation.

After you have your organization token, complete the following steps to install the Call For-

warder:

1. Find the NMSCallForwarder.EXE file, which ships with the NMS software, and run it on

the machine where you are installing the Call Forwarder. The Install Shield Wizard opens.

Click Next to continue:

2. Set the location where the Call Forwarder will be installed, then click Next to continue:
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3. The Service Logon Options dialog appears. If your network requires a domain account for

authentication tests, select the Other Accounts radio button and specify the domain, other-

wise accept the default: Local System Account.

If you specify a domain account, you can reinstall the Profile Optimizer at a later time to

change this value, or to use the local system account.

Click Next to continue:
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4. Enter the organization token in the NMS Customer Token field and click Next to con-

tinue:

5. Click Install to install the Call Forwarder:
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Install and Configure Dragon Medical 360 |
Network Edition Clients
Follow the instructions in the "Installing the Dragon Medical Client" chapter of the DM360 Net-

work Edition Installation Guide to install the latest Dragon Medical clients and configure them to

use either NMS in the cloud or the Call Forwarder.
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Upgrade to NMS in the cloud
To move your on-premise Dragon Medical 360 | Network Edition to the Nuance cloud, you

must perform an upgrade and migration process. This process is described below.

Preconditions

n You have an on-premise NMS installation of Dragon Medical 360 | Network Edition.

n The NMS server is version 2.0.XXX or greater (should be 2.0.535, but earlier versions may be

compatible).

n The cloud NMS server is version NMS 3.0 or greater.

n Dragon client Dragon Medical version 10.1 Service Pack 3 or higher.

Note:

If you are upgrading from a version of DM360 Network Edition that is not Service Pack 3 or

higher, you must first upgrade to Service Pack 3. See the DM360 Network Edition SP 3 Installation

Guide for more information.

Upgrading Dragon Medical 360 | Network Edition to NMS in the cloud involves the following

ordered steps:

1. Create an organization in the NMS cloud

2. Move data from the on-premise NMS server to the cloud NMS server

3. Upgrade the Profile Optimizer Server to the cloud

4. Install the NMS Call Forwarder (Optional)

5. Upgrade Dragon clients

6. Configure Dragon clients to communicate with NMS in the cloud

7. Configure Dragon clients to communicate with the new Call Fowarder server (Optional)

8. Uninstall the on-premise NMS server

Create an organization in the NMS cloud
A Nuance employee creates an Organization in the Nuance cloud NMS server for your organ-

ization.

What the Nuance employee requires before performing this task:
n The Organization Id of your on-premise NMS Organization - obtainable from Order

Management or the customer. The id is required to create licenses.

n The login and password you will use to manage your cloud NMS configuration. Unique logins

are required; something unique such as an email address can be used as a login.

The Nuance employee performs the following steps in the cloud Man-
agement Console

To perform the following steps, work with Nuance technical support or your Nuance sales con-

tact.
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1. Creates a new organization in the cloud NMS with the same Organization Id as the on-premise

NMS.

2. Use the login and password from the organization to create a user account in the new cloud

organization.

3. Assign the user account to the “NMC Administrators” group.

4. Modify the “NMC Administrators” group to include the following necessary rights:
n Product - Manage DM360 Network Edition

n Dragon – Able to run DM360 Network tools

5. Create and import a single NMC license for this new organization and assign it to the user

account created earlier.

6. On the Organization Details screen, in the Customer Tokens tab, create an organization

token for the new organization. The customer enters this organization token when they install

the Profile Optimizer and the Call Fowarder (if required).

Move data from the on-premise NMS server to the
cloud NMS server
In this stage, an administrator uses the cloud migration tool to move your data from the on-prem-

ise NMS server to the cloud NMS server.

What the administrator requires before performing this task:
n The URL of the cloud Management Console.

n Login and password of user account created for your organization in the cloud.

n On-premise NMS server coordinates:
n Server name

n Login and password to the cloud NMS that has an NMS license and appropriate

rights.

n On-premise NMS SQL server coordinates:
n Server name

n Login and password to the NMS SQL Server which provides full access to the NMS

database (NuanceMC): Either the “sa” login and password, or Windows

authentication which has full access to the NMS database.

n To be on a computer where:
n You have rights to install an application.

n The computer is on the same network with the Nuance Management Server.

n The computer is on the same network with the NMS SQL Server

n Ports 8051 and 8731 must be open for outbound traffic

n Your organization has already been created in the cloud NMS with an organization

ID that is the same as the organization ID for the organization on the on-premise

NMS.

n Your account has access rights to the Dragon user profile store(s).

Using the cloud NMC, perform the following steps:
1. Perform the steps in Migrate data from an existing on-premise NMS server to the cloud NMS

server.
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2. Once the migration is complete, the cloud migration tool informs you of any issues that need to

be resolved. A common issue is that there is a conflict between the on-premise login and a

cloud login for a user. You must change the user login for the user. The migration tool will give

you the opportunity to change the user name.

3. Once you change the login user name, you must inform the user of the name change or they will

not be able to log into DM360 Network Edition after the data migration.

After you upgrade a user account or a Dragon client to Nuance Management Server (NMS) in the

cloud, users must log into the system using the Dragon client in connected mode. This action

authenticates the user with the NMS and allows them to later use Dragon in disconnected mode.

The user cannot use Dragon in disconnected mode until they first login to Dragon in connected

mode.

Upgrade the Profile Optimizer Server to the cloud
What you require before you begin:

n The organization token created in your cloud Organization. The token is required during the

Profile Optimizer installation.

Upgrade by uninstalling (Add/Remove Programs) and re-installing the Profile Optimizer.

Note: Uninstalling does not remove the database. Upgrade all speech nodes. For details, see the

following sections in the DM360 Network Edition Installation guide:

1. Determining whether Speech Nodes are busy running optimizations

2. Halting Speech Nodes

3. Uninstalling Profile Optimizer Server and Speech Nodes

4. Uninstalling the old and installing the new Dragon SDK Client

5. Installing new version of Profile Optimizer Server and Speech Nodes

Install the NMS Call Forwarder (Optional)
If you want to use LDAP or Active Directory Single Sign On for your authentication, you must

install the NMS Call Forwarder on a server that is accessible to both the cloud NMS and your

Dragon Clients. If you want to use Dragon's native authentication, you can skip this step.

The cloud NMS cannot test LDAP credentials inside your organization. The NMS forwarder fills

this gap by testing LDAP credentials. If they pass verification, the forwarder sends the credentials

to NMS in the cloud for processing. All requests from DM360 Network Edition go through the

call forwarder.

The NMS call forwarder is installed on premise. No SQL Server or configuration is required.

Deciding where to Install the Call Forwarder

You install the Call Forwarder on a server that is accessible to both the NMS and to the Dragon

Clients. You can either re-purpose your existing NMS server for this or use another server.

If you install the Call Forwarder on your existing NMS server:

250



Chapter 15: Overview of NMS in the cloud

n Advantages: You will not need to change the Call Forwarder server address in all the Dragon

clients, because they are already configured to point to the NMS server.

n Disadvantages: Possibly using a server just for the call forwarder.

If you install Call Forwarder on a separate server:

n Advantages: You don’t need to use a whole server just for the call forwarder.

n Disadvantages: Dragon clients will need to be reconfigured to point to the new server as a

target.

Installing the Call Forwarder

What you require before you begin:

n The organization token created in your cloud organization, and used to install the Profile

Optimizer. You need to enter it during the Call Forwarder installation.

After you have your organization token, complete the following steps to install the Call For-

warder:

1. Find the NMSCallForwarder.EXE file, which ships with the NMS software, and run it on

the machine where you are installing the Call Forwarder. The Install Shield Wizard opens.

Click Next to continue:

2. Set the location where the Call Forwarder will be installed, then click Next to continue:
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3. The Service Logon Options dialog appears. If your network requires a domain account for

authentication tests, select the Other Accounts radio button and specify the domain, other-

wise accept the default: Local System Account.

If you specify a domain account, you can reinstall the Profile Optimizer at a later time to

change this value, or to use the local system account.

Click Next to continue:
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4. Enter the organization token in the NMS Customer Token field and click Next to con-

tinue:

5. Click Install to install the Call Forwarder:
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Upgrade Dragon clients
You can keep your Dragon clients at Dragon Medical version 10.1 Service Pack 3 and they will

still work with Dragon Medical 360 | Network Edition.

However, to utilize the newest features, enhancements, and fixes, you eventually must upgrade

the Dragon clients to Dragon Medical 360 | Network Edition.

1. Upgrade vSync on a Citrix server to Dragon Medical 360 | Network Edition without unin-

stalling the previous vSync software. You can upgrade vSync on a Citrix server without having

to upgrade all the Dragon clients in your network.

The vSync plug-in for Citrix Servers in Dragon Medical 360 | Network Edition is compatible

with the following versions of the Dragon client: Service Pack 3 and Service Pack 3.5. How-

ever, to utilize the newest features, enhancements, and fixes, you eventually must upgrade the

Dragon clients to Dragon Medical 360 | Network Edition.

Before you upgrade the Dragon client, you must upgrade vSync on your Citrix servers.

2. Upgrade the Dragon Client to Dragon Medical 360 | Network Edition without uninstalling the

previous Dragon Client software. See chapter 7 in the DM360 Network Edition Installation

Guide for more information.
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Configure Dragon clients to communicate with NMS
in the cloud
To perform these steps, your Dragon clients must be Dragon Medical version 10.1 Service Pack 3

or higher.

Change the Dragon Client configurations to point to the cloud NMS server instead of the local

NMS server.

1. Start the Dragon client.

2. On the Dragon Login window, click Options.

3. On the Options window, in the Address field, type the IP address or network name of the

Nuance Management Server in the cloud.

4. Click OK.

If issues are being experienced with a user profile, you can check the Delete my profile and

create new checkbox to have the system delete your user profile from the Nuance Management

Server and delete the local cache user profile from the client computer.

Configure Dragon clients to communicate with the
new Call Fowarder server
To perform these steps, your Dragon clients must be Service Pack 3 or higher.

If you installed the call forwarder, you must configure the Dragon Client to point to the new

server you installed the Call Fowarder on.

1. Start the Dragon client.

2. On the Dragon Login window, click Options.

3. On the Options window, in the Address field, type the IP address or network name of the

server that the call forwarder is installed on.

4. Click OK.

Uninstall the on-premise NMS server
Note: After you uninstall the on-premise NMS server, you cannot re-migrate users to the cloud.

Be sure that Dragon in the cloud is working, and that all of your users have been migrated before

uninstalling the on-premise NMS server.

Once you have confirmed you are able to use Dragon in the cloud, you can uninstall the on-prem-

ise NMS Server. Use Add/Remove Programs to uninstall Nuance Management Server.

1. Click Start > Control Panel and open Add/Remove Programs.

2. Find NMS Server in the list and click the Remove button.
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Setting the NMS download location
1. In the Management Console, in the Organizations section, click Organization Overview.

2. In the Organizations section of the ribbon, click Details.

3. On the Products tab, expand the DM360 Network Edition section.

4. In the Downloads section, select Download from cloud.

5. Click OK.
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Move data from an existing on-
premise NMS server to the cloud NMS
server

You use the cloud migration tool to move data from your on-site NMS server to the NMS server

in the cloud. This data includes:

l Organization data

l Sites data

l Groups data

l Users data

l Licenses (and assignments)

l All object settings

An administrator runs the tool as the last step in migrating data to the Cloud NMS.

After you upgrade a user account or a Dragon client to Nuance Management Server (NMS) in the

cloud, users must log into the system using the Dragon client in connected mode. This action

authenticates the user with the NMS and allows them to later use Dragon in disconnected mode.

The user cannot use Dragon in disconnected mode until they first login to Dragon in connected

mode.

Notes:

n If the NMC detects that the tool is not installed, you are prompted to install it.

n If the NMC detects that the tool is not current, you are prompted to update it.

n Once the tool installation or upgrade is complete, the NMS launches the tool

Preconditions for using the tool:

n Microsoft .NET 4.0 or higher on the client workstation where you will run the tool

n An existing on premise NMS configuration.

n An Organization in the NMS cloud, created by Nuance, with:

n The same Organization Id as the on-premise NMS server.

n A user credential that has the rights to add all the data to NMS in the cloud.

1. In the Management Console, click Utilities > Tools.

2. On the Tools screen, click Launch cloud migration tool.

3. You are prompted to install the tool. Click Yes and follow the steps in the wizard to install the

tool.
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4. On the On-Premise Server screen, enter the following information and click Next:

n Login ID: The login id for the on-premise NMS server.

n Password: The password for the on-premise NMS server.

n Server Name: The address of the on-premise NMS server.

5. On the On-Premise SQL Server screen, enter the following information and click Next.

Note, if you are running the Cloud Migration tool on the on-premise NMS, the tool auto-
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matically fills these fields:

n Server Name: The address of the on-premise SQL server.

n Authentication: The authentication method to use to login to the SQL server.

n Login: The login for the on-premise SQL server.

n Password: The password for the on-premise SQL server.

6. On the Cloud Server screen, enter the following information and click Next. Note, the Cloud

Migration tool will auto-populate the Login ID field and the Server Name field. You must pro-

vide the password information.
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n Login ID: The login id for the cloud NMS server.

n Password: The password for the cloud NMS server.

n Server Name: The address of the cloud NMS server. This is usually something in

the following format: nms.nuancehdp.com.

7. On the Confirmation screen, verify that the displayed information is correct and click

Migrate. The tool runs and moves data to NMS in the cloud

8. If there are conflicts between user Login IDs on the on-premise NMS and NMS in the cloud,

the Cloud Migration tool does the following:

n Opens a summary page that contains the user Login ID conflicts. The summary

page displays a list of all user Login IDs that are in conflict with the same login ID

in the cloud. Only on premise users are listed.

n If the user is a Management Console administrator, they must update their

NMS native login. All login resolutions should be done to the on premise user

account that is migrated to the cloud. The administrator uses the cloud migration

tool to change their NMS native user login.

n You can use UI buttons in the cloud migration tool to add either a prefix or suffix

to all login IDs in conflict.
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Logging existing and new users into
NMS in the cloud

When a user logs into the Dragon client, Dragon queries NMS to get the user login information

for the user. Dragon uses the login to find the user profile folder for the user.

In all versions of NMS, user logins must be unique. When moving a user from an on-premise

NMS (on-premise, private system) to NMS in the cloud (system shared with other Nuance cus-

tomers), the user's login may already exist in the cloud.

NMS introduces changes that make it easier to move users to NMS in the cloud. When you move

a user to NMS in the cloud, and the user login already exists in the cloud, that user login will have

to be changed as a part of the migration process. To avoid having to rename the user profile

folder, NMS provides Dragon with the user profile folder name (instead of the user login). Dragon

uses this information to find the profile folder for the user and log them into the system.

For a new user, the NMS generates a folder name using the format login_GUID and returns this

to Dragon. Dragon uses this value to create the profile folder for the new user. NMS only appends

the GUID to the profile folder name, not to the user profile.

For example, for a new user profile "bob", the NMS generates the folder name: “bob_

35B5CB9B-922B-47FB-AA20-AE2E515D9802”.

"bob' is the name of the profile and is stored in the folder “bob_ 35B5CB9B-922B-47FB-AA20-

AE2E515D9802”.

When the user logs into Dragon, NMS authenticates the user’s credentials and returns a unique

name for Dragon to use to create the user’s profile location.

After you upgrade a user account or a Dragon client to Nuance Management Server (NMS) in the

cloud, users must log into the system using the Dragon client in connected mode. This action

authenticates the user with the NMS and allows them to later use Dragon in disconnected mode.

The user cannot use Dragon in disconnected mode until they first login to Dragon in connected

mode.
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